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Introduction

Higher Versions of HCL ® Digital Experience and IBM® WebSphere Application Server
This guide is specifically written for 64-bit HCL ® Digital Experience v9.5 cumulative fix 17 or a later
CF and IBM® WebSphere Application Server v9.0.5. However, the same steps may apply on newer

versions of HCL ® Digital Experience v9.5 cumulative fixes and newer IBM ® WebSphere
Application Server v9.0.x fixpacks.

Windows/Unix Differences
This guide was written using Linux as the base operating system, however the steps/concepts listed
in this guide are independent of operating system.

The only significant difference is that for Windows, you must use the batch file commands instead of
the UNIX shell commands listed in this guide. For example:

UNIX: ./startServer.sh WebSphere Portal

Windows: startServer.bat WebSphere Portal

or

UNIX: ./ConfigEngine.sh cluster-node-config-cluster-setup

Windows: ConfigEngine.bat cluster-node-config-cluster-setup

Migration Considerations

This guide is targeted towards new installations of HCL ® Digital Experience v9.5. Many of the steps
in this guide are not required if you are migrating from a previous version of IBM ® WebSphere Portal
or an older HCL ® Digital Experience version. An Appendix is provided an outline of migration
considerations. If you are migrating from a previous version of IBM ® WebSphere Portal this guide

strongly recommends contacting HCL ® Support to discuss migration options prior to executing the
steps in this guide.



Cluster Concepts

Server — A Java Virtual Machine (JVM) that manages user applications (such as Digital Experience /
Portal and Web Content Management).

Node — A logical grouping of one or more application servers. A node does not necessarily mean
a single physical server.

Cell — A logical grouping of one more nodes.

Cluster — A logical grouping of one or more servers across one or more nodes. The servers are
managed together and participate in workload management. Servers in a cluster share resources,
such as applications. Multiple clusters can exist in a single cell, but a single cluster cannot exist
across multiple cells.

LDAP Server

Database
Server

Web
Server

Portal Portal
Node 01 Node 02

WebSphere Portal Cluster

Search Server

An HCL ® Digital Experience cluster (WebSphere Portal Cluster) with two horizontal nodes, each with
two cluster members.

NOTE: There is a Remote Search Server in this illustration. This is a separate WebSphere Application
server from the Portal Server.



Using this Guide

While there are numerous different ways to build a HCL ® Digital Experience cluster, this guide
describes the method widely considered the easiest: building a cluster with horizontal nodes and a
remote Deployment Manager.

This can be achieved by following the steps in these chapters:

Installing HCL ® Digital Experience v9.5 on the Primary Node

Configuring the Primary Node for a Remote Database

Installing and Configuring the Deployment Manager

Federating and Clustering the Primary Node

Configure the HCL ® Digital Experience cluster for Federated LDAP Security
Installing HCL ® Digital Experience cluster on an additional horizontal Node
Federating and Clustering an Additional Horizontal Node

Configuring the Cluster with an External Web Server

XN N WD =

Appendices are provided to guide you through additional concepts not covered in the main portion of
the guide. The appendices contain tasks, features, and configuration options the authors of this guide
have found useful for many administrators but not required in all environments. The main portion of

this guide is recommended for all HCL ® Digital Experience environments.

Before You Begin

This guide does NOT cover the following:

- Installing IBM® DB2
Creating multiple clusters in a single cell
Advanced Security configuration

Installing and Configuring IBM ® Directory Server

For more information on these and other topics, visit the HCL ® Digital Experience v9.5
Product Documentation:

https://help.hcltechsw.com/digital-experience/9.5/welcome/wp95 welcome.html?

To perform the tasks described in this document, you need basic HCL ® Digital Experience and

IBM® WebSphere Application Server knowledge and administration skills. Some steps might
require the assistance of another system administrator, such as the database administrator or LDAP
administrator.



Hostnames Used in This Guide

To avoid confusion, each instance of the hostnames has been replaced with a sample value that
corresponds to the server it belongs to, so it is easier to understand to which server the guide is
referring.

Sample Values:

Primary Portal Node - myprimaryportal.hcl.com
Secondary Portal Node — mysecondaryportal.hcl.com
Deployment Manager — mydmgr.hcl.com

Database Server — mydbserver.hcl.com
LDAP Server — myldapserver.hcl.com

IBM® HTTP Server — mywebserver.hcl.com

The following references to HCL ® Digital Experience and IBM® WebSphere Application
Server file paths will be used throughout the guide:

AppServerRoot - The root path of the AppServer directory, for example:
/opt/HCL/WebSphere/AppServer

PortalServer root - The root path of the PortalServer directory, for example:
/opt/HCL/WebSphere/PortalServer

wp_profile - The root path of the wp_profile directory, for example:
/opt/HCL/WebSphere/wp_profile

dmgr_profile - The root path of the dmgr profile directory, for example:
/opt/HCL/WebSphere/AppServer/profiles/dmgr01

httpRoot — The root path of the IBM® HTTP Server, for example:
/opt/HCL/HTTPServer

pluginRoot - The root path of the WebSphere Plugin directory, for example:

/opt/HCL/WebSphere/Plugins



The following references to relevant usernames and passwords will be used throughout the guide:
PortalAdminID - The Portal administrator user ID, set during HCL ® Digital Experience installation.

PortalAdminPswd - The Portal administrator password, set during HCL ® Digital Experience
installation.

ConfigWizardID — The Configuration Wizard administrator ID, set during HCL ® Digital
Experience installation.

ConfigWizardPswd — The Configuration Wizard administrator password, set during HCL ® Digital
Experience installation.

dmgrAdminID — The Deployment Manager administrator ID, set by HCL ® Digital Experience
scripting

dmgrAdminPswd — The Deployment Manager administrator password, set by HCL ® Digital
Experience scripting

WASAdminInLDAP — The WAS administrator ID stored in the LDAP. This is set during
the configuration of the Cluster for federated LDAP security.

WASPswdInLDAP — The WAS administrator password stored in the LDAP. This is set during
the configuration of the Cluster for federated LDAP security.

NOTE: If you plan to configure an LDAP to your cluster, ensure the user names you choose
for the PortalAdminld and dmgrAdminID values do NOT match any names in the LDAP.

Configuration Wizard Server Information

serverl — This is the name of the Configuration Wizard server. It should not be federated or added to
the cluster. If the Configuration Wizard is stopped (after initial Portal installation), it can be re-started
by navigating to:

AppServerRoot/profiles/cw_profile/bin
and running:

JstartServer.sh serverl



Chapter 1 — Installing HCL® Digital Experience v9.5
on the Primary Node

Chapter Overview

This chapter will demonstrate how to install HCL ® Digital Experience v9.5 on the primary node.
In this guide, the installation was completed with a graphical user interface (GUI) using the root
user with installation images on a local hard drive.

This chapter contains multiple sections each performing a specific action within the IBM ® Installation
Manager (IIM) tool. Ensure you complete each section as outlined before proceeding to the section.

Section 1 — Installing IBM ® Installation Manager

Section 2 — Installing HCL ® Portal (WebSphere Portal) v8.5 Binaries only

Section 3 — Upgrading HCL ® Portal (WebSphere Portal) v8.5 to Cumulative Fix (CF) 17 or a later
CF

Section 4 — Upgrading HCL ® Portal (WebSphere Portal) v8.5 CF17 or a later CF to HCL ® Portal
v9.5

Before installing HCL ® Portal, ensure you review the planning documentation:
https://help.hcltechsw.com/digital-experience/9.5/plan/plan_installation.html




Section 1 - Installing IBM ® Installation Manager

The IBM ® Installation Manager (IIM) is a tool that you can use to install and maintain your IBM ®
software packages. Wizards guide you through the steps that you must take to install, modify, update,
roll back, or uninstall your IBM ® and/or HCL ® products.

1. Open a terminal window and run: ping
myprimaryportal.ibm.com
where myprimaryportal.ibm.com is your fully qualified hostname.
2. In the same terminal window,
run: ping localhost

to verify that the localhost settings are properly configured on your server.

3. Linux/UNIX environments only: Ensure ulimit is set to 10240 or higher by running:
ulimit -n 10240
in the command line.
4. Unzip all .zip files provided with your HCL ® Digital Experience media into a single folder.
This folder will be referred to as the installationMediaRoot folder.

For this guide the following directory is used for the installationMediaRoot folder:
/opt/portalBinaries/SETUP/products

opt portalBinaries @ SETUP » Q|| iz

M launchpad products quickstart sample-
responsefiles

v /4
setup.sh setupb4.exe setupbd.ini WPS0.setup.id WPS0_Enable.
id



5. From the HCL ® Digital Experience v9.5 SETUP directory, navigate to:
SETUP/IIM/yourEnvironment

and run

J/install

where yourEnvironment is the folder that best describes the operating system of the environment in

which you are installing HCL ® Digital Experience. For this guide the following is used:

installationMediaRoot/SETUP/IIM/linux_x86 64

The following window will appear:

IBM Installation Manager o

Install Packages ZE

Select packages to install:

Installation Packages Status Vendor License Key 1
&% i 1BM® Installation Manager
Will be installed IBM No key requird

(W@, Version 1.8.5

6. Click Next.

7. Accept the license agreement and click Next.

The IPLA will automatically apply if Licensee elects to retain the Program after the Evaluation (or obtain additional copies of the P
for use after the Evaluation) by entering into a procurement agreement (e.g., the IBM International Passport Advantage or the IBI

Passport Advantage Express agreements).

) | accept the terms in the license agreement

_ I do not accept the terms in the license agreement

< Back Next > Install
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8. Choose a directory in which to install I[IM. This guide uses:
/opt/HCL/InstallationManager/eclipse

for Windows this guide recommends:
c:\HCL\InstallationManager\eclipse

NOTE: In Windows environments, the default location will be
C:\Program Files\HCL\InstallationManager. Spaces in the file path can cause problems later in
the installation/configuration of HCL ® Portal. This guide recommends creating a folder named

“HCL” at C:\HCL or a similar location into which IIM and HCL ® Portal can be installed.
9. Click Next.

10. On the Summary screen, click Install to begin the installation.

11. When the installation is complete, click Restart Installation Manager.

12. The following screen will appear:

IBM Installation Manager i o

File Help

IBM Installation Manager

— Install
Install software packages.

Update

Discover and install updates Ve Manage Licenses
and fixes to installed
software packages.

i Roll Back
Modify
™
?_7 Change installed software =
\ /J/ packages by adding or ‘ﬂ_.i Uninstall
= removing features and =
functions.

At the end of this section, you have successfully installed IBM ® Installation Manager 1.8.5.
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Section 2 - Installing HCL ® Portal (WebSphere Portal) 8.5 Binaries only

This section will cover the installation of HCL ® Portal 8.5. HCL® Portal 8.5 must be installed and
thereafter upgraded to HCL ® Portal 9.5. It is not possible to install HCL ® Portal 9.5 directly.

1. InIIM, click File > Preferences > Repositories
2. Click Add Repository, navigate to
installationMediaRoot/WP85 Enable/repository.config

and click OK.

3. Repeat step 2 for the following repositories:

installationMediaRoot/WP85 Server/repository.config
installationMediaRoot/W ASND90/repository.config
installationMediaRoot/JDK803/repository.config
installationMediaRoot/TFP159896/8.5.0.0-WP-Server-P159896.zip

@ Preferences @myprimaryportal.hcl.com X
type hiter text ] Repositories b v D v w
Repositories
e ooarinien
Appearance - -
Locatio Connectio )
Files for Rollback = o Bt bt Add Repository...
b B + [portalfiles/Portal9.5/SETUP/products/WP85_Serverjreposi; ‘.
elp s )
b ik |+ /por'talﬁles,fPovtaI9.5/SETUP{products:WPBS_Enablefrepo.f.l;'51 Edit Repository...
v Jportalfiles/Portal9.5/SETUP/products/WASND905/reposito’ %.
Passport Advantage ; ; Remoye Reposito
5 &% |+ jportalfiles/Portal9.5/SETUP/products/|DK80S/repository.cc % 8 Hap Iy
rtalfiles/Portal9.5/SETUP/products/IFPIS9896/8.5.0.0-Wi .
Updates G /o /P = /P s A Move Up

Test Connections

Service repositories are remote locations where updates or extensions to packages (including the
Installation Manager itself) are stored.

|»# Search service repositories during installation and updates.

Restore Defaults Apply

@ cancel oK

4. Ensure that all the repositories you just added are selected (i.e. there is a check mark in the
box next to them) and click Apply then OK.

12



5. Back on the IIM Home Screen, click Install.

IBM Installation Manager

File Help

IBM Installation Manager

Install

Install software packages.

Update

Discover and install updates
and fixes to installed
software packages.

Modify

Change installed software
packages by adding or
removing features and
functions.

13
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6. Check the boxes to install IBM WebSphere Application Server Network Deployment, IBM
WebSphere Portal Server, and IBM WebSphere Portal Enable (or the offering you are
installing, e.g. Extend, Express, etc.). IBM SDK, Java Technology Edition, Version § package
should not be selected as it is will be automatically installed with the IBM WebSphere
Application Server Network Deployment package.

’ L
) 12M Instaliation Manager @ myprimarypornal ickoom o [m] x
Install Packages i
Select packages to install:
B v
Installation Packages Status vendor License Key Type
= [+ [ 1BM WebSphers Application Server Network Deployme:
o lii; Version 9,0.5.0 will be installed IBM
= |« IBM SDK, Java Technology Edition, Version 8
(v 1¥ Veersion 8.0.5.35 will be installed  1BM
= | [l IBM WebSphere Portal Server
[+ 11}; Version 8.5.0.0 will be installed IBM
+ || 1BM SDK, Java Technology Edition, Version 8
|} version 8.0.5.35 IBM
% ™ 1BM WebSphere Partal Enable
y + I version 8.5.0.0 will be installed [:17]
__| show all versions Check for Other Versions, Fixes, and Extensions
Details
IBM WebSphere Portal Enable 8.5.0.0
IBM® WebSphere® Portal Enable helps increase efficiency and accuracy of website deployments. it places content creation
in the hands of content experts to create, maintain, and deliver online content while IT retains control, 1IBM WebSphers
Portal Enable delivers the nght information to the right audience It includes rich text editing tools, web content templates,
and personalization services to build nch websites. These websites can deliver highly targeted and dynamic content to
customers, business partners, and employees in more relevant ways, Mare info..
= Repository: /portalfiles/Portal9.5/SETUP/products/WP8S_Enable
@ < Back Next > nsta Cancel
Click Next.
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7. Select the iFix IFPI59896 and click Next

ﬂ |BM Installation Manager @myprimaryportal hl.oom

Install Packages

Salect the fixes to install. :ﬂ

Fixes Recommend  Vendor Status

5 @ 1M WebSphere Portal Server 8.5.0.0

gﬂ’ 8.5.0.0-WP-ServerIFPIS9896 8.5.0.20161201_1732

- Check for Other Fixes
Details '

IBM WebSphere Portal Server 8.5.0.0

IBM® WebSphere® Portal Server provides a single access point to web content and applications, while delivering
differentiated, personalized experiences for each user. WebSphere Portal supports workflows, content management,
simplified usability and administration, development tools and Web 2.0, open standards, secunty, and scalability. These
capabilities provide an exceptional web experience to help you become a social business. More info..

* Repository: [portalfiles/Portal9.5/SETUR/products/WPB5_Server

@ < Back Next = install Cancel
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8. Accept license agreement and click Next

@ IBM Installation Manager @myprimaryportal.hcl.com — O X

Install Packages =
Read the following license agreements carefully.

e N === T ae ==
Install | Licenses ) Location Features Summary

~ IBM WebSphere Application Server Network Deployment IMPORTANT: READ CAREFULLY I

Software License Agreement "
Two license agreements are presented below.

« |BM WebSphere Portal Enable
IBM WebSphere Portal Enable 1. IBM International License Agreement for Evaluation of
~ |BM WebSphere Portal Server Programs ; i
2. IBM International Program License Agreement

1BM WebSphere Portal Server
If Licensee is obtaining the Program for purposes of
productive use (other than evaluation, testing, trial "try or
buy.” or demonstration): By clicking on the "Accept”
button below, Licensee accepts the IBM International
Program License Agreement, without modification.

If Licensee is obtaining the Program for the purpose of
evaluation, testing, trial "try or buy,” or demonstration
(collectively, an "Evaluation”): By clicking on the "Accept”
button below, Licensee accepts both (i) the IBM
International License Agreement for Evaluation of
Programs (the "Evaluation License"), without
modification; and (ii) the IBM International Program
License Agreement (the "IPLA"), without modification.

The Evaluation License will apply during the term of
Licensee's Evaluation.

The IPLA will automatically apply if Licensee elects to
retain the Program after the Evaluation (or obtain
FIRE 51 1% SR BSREEEE SRS S ST SO CERINER SNSRI SRS

(e | accept the terms in the license agreements Print All...

I do not accept the terms in the license agreements

@ < Back Next > Cancel

16



9. Select a location for the IIM Shared Resources Directory. This guide uses:
/opt/HCL/WebSphere/IMShared

for Windows this guide recommends:
c:\HCL\WebSphere\IMShared

e IBM Installation Manager @myprimaryportal.hcl.com — O X
Install Packages —
Select a location for the shared resources directory. _—

=] = . T - =
nsta Licenses Location > Features Summary

When you install packages, files are stored in two locations:

1) The shared resources directory - resources that can be shared by multiple packages.
2) The installation directory - any resources that are unique to the package that you are installing.

)\

m Important: You can only select the shared resources directory the first time you install a package with the 1BM
Installation Manager. For best results select the drive with the most available space because it must have adequate
space for the shared resources of future packages.

shared Resources Directory: l jopt,!HCLlfWebSphereflMShared ] Browse...

Disk Space Information

Volume  Available Space
/ 23.06 GB

@ < Back Next > 1sta Cancel

Click Next.
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10. Click IBM WebSphere Application Server to set the WAS installation location. This
guide uses:

/opt/HCL/WebSphere/AppServer
for Windows this guide recommends:

C:\HCL\WebSphere\AppServer

Install Packages
The packages will be installed into the indicated package groups. Select the package group to change the instaliation directory.
Instail Licenses | Location \ Features Summarny

Package Group Name Installation Directory Architectur:

- 1BM Web5Sphere Application Server V9.0 JopHCEWebSphere/AppServer

([} IBM WebSphere Application Server Network Deployment
(& IBM SDK, Java Technology Edition, Version 8 8.0.5.35
= %, IBM WebSphere Portal Server V8.5 foptfBMMAWebS phere/PortalSenver 64-bit
= [l IBM WebSphere Portal Server 8.5.0.0
(¥ 8.5.0.0-WP-Senver-IFPISI856 8.5.0.20161201 1732 (

Package Group Name: [BM WebSphere Application Server V9.0

Instaliation Directory:  fopt/HCLWebSphere/AppServer Brc

Architecture Selection: (' 32-bit (=) 64-bit

Details Disk Space Information
Shared Resources Directory: fopt/HCUWebSphere/iMShared L Space

! 23.08 GB

Click Next.
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11. Click IBM WebSphere Portal Server V8.5 to set the Portal Server installation directory:

/opt/HCL/WebSphere/PortalServer
for Windows this guide recommends:

C:\HCL\WebSphere\PortalServer

| B IEM Installation Manager @myprimaryportal.hcl.com =
Install Packages

The packages will be installed into the indicated package groups. Select the package group to change the installation :ﬂ
directory.

Install Licenses | Location 9 Features Summary

Package Group Name

w» Ty, 1BM WebSphere Application Server V9.0
@ 18M WebSphere Application Server Network C
% 1BM SDK, Java Technology Edition, Version B £

. 1BM WebSphere Portal Server VB.5
= [l 1IBM WebSphere Portal Server 8.5.0.0

(Y 8.5.0.0-WP-Server-IFPI59896 8.5.0.201612(

Installation Directory

JoptHCLWebSphere/AppServer

Architecture [
64-bit

lopt/HCLWebSphere/PortalServer

Package Group Name: IBM WebSphere Portal Server V8.5

' Installation Directory: I joptHCliwebSphere/PortalServer Browse...
Architecture Selection: 32-bit (») 64-bit
Details Disk Space Information
Shared Resources Directory: foptiHCL/WebSphere/iMShared Volume Available Space
i/ 23.06 GB
@ ‘ﬂatk umb Install Cancel
Click Next.
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12. Select any additional language translations your environment requires. Only English was
selected for this guide. Click Next.

b;] 1BM Installation Manager (Skip Install, Recording..) @webserver.hcl.com =% X
Install Packages S
Select the translations to install. '

ense cal Features

i
Select the translations for the packages that will be installed to package group IBM WebSphere Application Server V9.0, IBM WebSphere Portal Server V8.5.

Translations Supported by All Packages

v

» Translations Supported by Only Some Packages

Select All | Clear All

@ < Back Next > Cancel
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13. View the features to install for both WebSphere Application Server and WebSphere Portal.
For this guide, the defaults were used.

NOTE: Do not de-select any WebSphere Application Server features.
Ensure you install a WebSphere Portal profile (selected by default).

B &M Installation Manager @myprimaryporal.hcl.com = - @ ]
Iinstall Packages
Select the features to install,
inatall Licenses Location | Features Summary

ME o
Features
B & 18M webSphere Application Server Network Deployment 9.0.5.0
«  E|BDeploy tool for pre-EJ8 3.0 modules
* |+l Stand-alone thin clients, resource adapters and embeddable containers
w4 Stand-alone thin clients and resource adapters
~  Embeddable EJB container
_ | sample applications
!f.il."-'u IBM SDK, java Technolegy Edition, Version 8 8.0.5.35
~ |+ ([ 1BM WebSphere Portal Server 8.5.0.0
«  Portal Server Profile
[wA Ty 18M WebSphers Portal Enable 8.5.0.0

_| Show dependencies Expand all  Collapse All  Restore Default
- Selacted by Installation Manager because of dependencies - o - -

Details

IBM WebSphere Application Server Network Deployment 9.0.5.0

1BM WebSphere Application Server Network Deployment provides an advanced, flaxible runtime environment for large.
scale and mission-crtical application deployments that offers nearcontinuous availability and Intelligent Management
capabilities for open environments. It offers a production-ready Java Platform, Enterprise Edition (Java EE] compliant
aoolication server for the deolovment of enteronse web services solutions for dvnamic e-business.

= Back Next > nutall Cancel

=)

Click Next.
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14. Set the Configuration Wizard (Config Wizard) username and password. You can set these
to any values you want to use for the Config Wizard credentials. “ConfigWizardID” is

used for this guide.
v o
ﬂ IBM Installation Manager @myprimaryportal hol.com = O *
Install Packages o
D click Next to continue.
install Licenses Location | Features ) Summary

= 1|} 1BM Websphere Portal ser Ceonfiguration for IBM WebSphere Portal Server 8.5.0.0

Enter the Administrator user ID and password for the Configuration Wizard.

© Enter the Administrato  connguration Wizard Credentials
This 1D is used only to log in to the Conhguration Wizard and can be different from the Portal =

Administrator uzer 1D

ConfigWizardiD

Administrator user passwoard

EEEREE

Confirm administrator user password

iitliill1

)
S —
@ < Back Next > instal Cancel
Click Next.
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15. Select Standard configuration mode. Set the hostname to match the fully qualified

hostname of your system. Set the node and cell names.

NOTE: If you have an existing Deployment Manager, choose a node name and cell name

different from the Deployment Manager node name and cell name.

16. Scroll down and set the Administrator user ID and password.

NOTE: These credentials will be stored in an internal repository and must be unique from

any existing user names in your LDAP. Otherwise, LDAP configuration in Chapter6 will fail.

) 18M Installation Manager @myprimaryportalhcl.com

Install Packages
(D click Next to continue.

- 1BM WebSphere Portal S5e¢ Configuration for IBM WebSphere Portal Server 8.5.0.0
@ Enter the Administrato Enter the Administrator user ID and password for the Portal Server.

4

# Enter the Administrato

Click Next.

Featuras "] Immary

myprimaryportal . hel.com

MNode name

Nodedl

ell namae

cellol

Admin Credentials for Portal Server

-'--irl'-'u- strator user 1D

PortalAdminiD

Administrator user passwort

Confirm administrator user password

< Back Next =
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17. Review your installation selections and click Install.

NOTE: The installation will take 30-60 minutes; don't be concerned if the Installation
Manager seems to be stuck on one task for several minutes.

a IBM Installation Manager @myprimaryportalhcl.com

Install Packages

Review the summary information. Eﬂ

Install Licenzes Location Features |E‘
Target Location
Shared Resources Directory: fopt/MHCLWebSphereiMShared
Packages
Packages

Installation Directory
- 1BM WebSphere Application Servar V9.0

foptHCLWebSphera/AppServer

» [} 1BM WebSphere Application Server Network Deployment !
% 18M SDK, java Technology Edition, Version 8 8.0.5.35
» Ty IBM WebSphere Portal Server VB.5
* [} IBM WebSphere Portal Server 8.5.0.0
I 1BM WebSphere Portal Enable 8.5.0.0

foptHCLWebSphere/PortalServer

Environment

Disk Space Information
English

Total Available Space
! 23.06 GB

Total Download Size:  2.74 GB

Total installation Size: 7.38 GB
+ Repository Information

@ <Back Next > Install Cancel
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18.  When the installation is finished, select the None option for “Which program do you want
to start?” and click Finish.

) 1BM Instaliation Manager @myprimaryportalhcl.com - (] x

Install Packages Ea

o The packages are installed. View Log Fle

1BM WebSphaere Portal Server VB.5 installation is complete,
You can now access your Portal at: httoomyprimaryportal.hel.com:10039/wops/portal

The following packages were installed: Which pregram do you want to start?

™ ' IBM WebSphere Application Server V9.0 = Start the Configuration Wizard from Portal FirstSteps
i 18M WebSphere Application Server Netwark Dej

% 18M SDK, Java Technology Edition, Version 8 8.0
= & IBM WebSphere Portal Server Va.5
' » ([l 18M WebSphere Portal Server 8.5.0.0 _ None
1Y 8.5.0.0-WP-Server-IFPIS9896 8.5.0.20161201
[ 1BM WebSphere Portal Enable 8.5.0.0

) Profile Management Tool to create a profile.

Profile Management Tool to create an application ser

Note: If the packages support rollback, the temporary directory contains rollback files for installed packages. You can
delete the files on the Files for rollback preference page.

|'_?i Eniﬁh

19. Verify that you can access your Portal in an internet browser by navigating to:
http://myprimaryportal.hcl.com:10039/wps/portal

At the end of this section, you have successfully installed HCL ® Portal v8.5 with IBM ®
WebSphere Application Server v9.0.5
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Section 3 — Upgrading HCL ® Portal (WebSphere Portal) v8.5 to Cumulative Fix
(CF) 17

HCL® Portal 8.5 now needs to be upgraded to Cumulative Fix 17 or a later CF to support the

installation of HCL ® Portal 9.5. You will need to stop the Portal Server and Configuration Wizard to
proceed with the upgrade.

1.  Open a terminal window and navigate to wp_profile/bin

2. Execute the following command:
JstopServer.sh WebSphere Portal -user PortalAdminID -password PortalAdminPswd

3. You will be prompted for a userID and password.
Enter your PortalAdminID for the userID and PortalAdminPswd for the password.

[root@myprimaryportal optl# cd /opt/HCL/WebSphere/wp profile/bin
[root@myprimaryportal bin]# ./stopServer.sh WebSphere Portal
ADMUO116I: Tool information is being logged in file
/opt/HCL/WebSphere/wp profile/logs/WebSphere Portal/stopServer.log
+ Starting tool with the wp profile profile
: Reading configuration for server: WebSphere Portal

L. Login at the Target Server@myprimaryportal.hcl... X
Enter login information for <default>

Realm/Cell Name

User Identity PortaladminiD

User Password  |*kibik

OK Cancel

4. Navigate to the AppServerRoot folder. Continue in the directory structure to the
/profiles/cw_profile/bin subdirectory. This guide uses the following directory for the full
path:

/opt/HCL/WebSphere/AppServer/cw_profile/bin

5. Execute the following command:
JstopServer.sh serverl -user ConfigWizardID -password ConfigWizardPswd
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6. You will be prompted for a userID and password. Enter your ConfigWizardID for the userID
and ConfigWizardPswd for the password.

[root@myprimaryportal /1# cd /opt/HCL/WebSphere/AppServer/profiles/cw profile/bin

[root@myprimaryportal bin]# ./stopServer.sh serverl

ADMUB116I: Tool information is being logged in file
/opt/HCL/WebSphere/AppServer/profiles/cw profile/logs/serverl/stopServer.log
Starting tool with the cw _profile profile
Reading configuration for server: serverl

.. Login at the Target Server@myprimaryportabhcl.... X
Enter login information for <default>

Realm/Cell Name

User Identity ConfigWizardID

User Password  |#eeoilel

0K Cancel

7. Return to IBM Installation Manager. Click File > Preferences > Repositories.
8.  Select each of the existing Repositories and Click Remove Repository.

9.  Click Add Repository, navigate to:
installationMediaRoot/SETUP/products/WP8500CF17_Server/repository.config

@ Preferences @myprimaryportal.hcl.com X

Repositories

Repositories:

Appearance

Files for Rollback Add Repository..

b Help
Edit Repository...
b Internet — R X

Passport Advantage Remoye Repository
Secure Storage

Updates
Test Connections
Service repositories are remote locations where updates or extensions to packages (including the
Installation Manager itself) are stored.
+ Search service repositories during installation and updates.
Restore Defaults Apply
@ Cancel oK
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Click OK twice.

10. In IBM Installation Manager, click the Update icon:

IBM Installation Manager

File Help

IBM Installation Manager

Install
Install software packages.

Update

and fixes to installed
software packages.

Modify

Change installed software
packages by adding or

removing features and
functions.

11. Select the IBM WebSphere Portal Server 8.5 package.

Discover and install updates “I:QJ Manage Licenses

Update Packages
Select a package group to find updates for

Pa I-,'.::.- Group MName Cir ectory

‘e, 1BM WebSphere Application Server V9.0 Topt/IBM WebSphere/AppServer

|

. IBM WebSphere Portal Server VB.5 foptiBMMWebhSphere PortalServe

Update all pa:icages with recommended updates and recommended fixes

12. Click Next to proceed with the Version 8.5.0.0 CF17 package.
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13.  Click Next to proceed beyond the Validation Results.

NOTE: HCL® highly recommends that you backup of your entire Portal architecture when installing
a cumulative fix on an established Portal system. As the system in this guide represents a brand new
system, a backup is not required at this time.

14.  Click the radio icon for “I accept the terms in the license agreement”. Click Next.

15. Click Next to Accept the terms of the licensing agreement.

16. Click Next to Install the IBM WebSphere Portal CF17 feature.

17. Click Update. This step will take approximately 20-30 minutes to execute.

@ IBM Installation Manager @myprimaryportal.hcl.com — O *

Update Packages pf_:j

o The packages are updated. View Log File

To complete the process, you must now update all existing Partal
profiles.

See the fix instructions for details:
The following update was installed:

IBM WebSphere Portal Server V8.5 files have been upgraded. I

Hliui.'i:'l" Installation Dir
v % IBM WebSphere Portal Server v8.5 Jopt/HCL/WebSphe
[l 1BM WebSphere Portal Server CF17 for v

Note: If the packages support rollback, the temporary directory
contains rollback files for installed packages. You can delete the
files on the Files for rollback preference page.

@ Finish

18. Click Finish.
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19.  Open a terminal window and navigate to wp_profile/PortalServer/bin

Execute the following command:
J/applyCF.sh -DWasPassword= PortalAdminPswd -DPortal AdminPwd=PortalAdminPswd

[root@yprimaryportal bin]# pwd
/opt/HCL/WebSphere/wp_profile/PortalServer/bin
[root@nyprimaryportal bin

orylnfo.bat
b
DPortalAdminPwd=PortalAdminPwd

20. Verify that you can access your Portal in an internet browser by navigating to:
http://myprimaryportal.hcl.com:10039/wps/portal

At the end of this section, you have successfully installed Cumulative Fix 17 for HCL ® Portal v8.5 on
IBM® WebSphere Application Server v9.0.5.

cleanup-config:

[echo] executing post-configuration tasks
BUILD SUCCESSFUL
isIseries currently set to:

update-registry-sync-property:
[echo] updated RegistrySynchronized in file wkplc.properties w

print-final-message:
Return code =
deleting temporary files

SUCCESS: Update to Cumulative Fix CF17 completed successfully.
portal bin]l#
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Section 4 — Upgrading HCL ® Portal (WebSphere Portal) v8.5 CF17 or a later CF
to HCL® Portal v9.5

In this final section HCL ® Portal 8.5 CF17 will be upgraded to HCL ® Portal Cumulative Fix 17. You
will need to stop the Portal Server and Configuration Wizard to proceed with the upgrade.

1.  Open a terminal window and navigate to wp_profile/bin
2. Execute the following command:
/stopServer.sh WebSphere Portal

3. You will be prompted for a userID and password. Enter your PortalAdminID for the userID and
PortalAdminPswd for the password.

[root@myprimaryportal optl]# cd /opt/HCL/WebSphere/wp profile/bin
[root@myprimaryportal bin]# ./stopServer.sh WebSphere Portal
ADMUO116I: Tool information is being logged in file

/opt/HCL/WebSphere/wp profile/logs/WebSphere Portal/stopServer
ADMUO128I: Starting tool with the wp profile profile
ADMU3100I: Reading configuration for server: WebSphere Portal

|=: Login at the Target Server@myprimaryportal.hcl... X
Enter login information for <default>

Realm/Cell Name

User Identity PortalAdminID

User Password Hololok oKk

OK Cancel

4. Navigate to the location you installed IBM ® WebSphere Application Server. Continue in the
directory structure to the /profiles/cw_profile/bin subdirectory. This guide uses the following
directory for the full path:

/opt/HCL/WebSphere/AppServer/cw_profile/bin

5. Execute the following command:
/stopServer.sh serverl
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6.  You will be prompted for a userID and password. Enter your ConfigWizardID for the userID
and ConfigWizardPswd for the password.

[root@myprimaryportal /]# cd /opt/HCL/WebSphere/AppServer/profi

[root@myprimaryportal bin]# ./stopServer.sh serverl

ADMUO116I: Tool information is being logged in file
/opt/HCL/WebSphere/AppServer/profiles/cw_profile/logs

ADMUO128I: Starting tool with the cw_profile profile

ADMU3100I: Reading configuration for server: serverl

|4 Login at the Target Server@myprimaryportal.hcl... X
Enter login information for <default>

Realm/Cell Name

User Identity ConfigWizardID

User Password i

OK Cancel

7. Return to IBM ® Installation Manager. Click File > Preferences > Repositories.
8.  Select each of the existing Repositories and Click Remove Repository.

9.  Click Add Repository, navigate to:
installationMediaRoot/SETUP/products/WP95_Portal/repository.config

Click OK.

10. Click Add Repository, navigate to:
installationMediaRoot/SETUP/products/WP95 Enable/repository.config

e Preferences @myprimaryportal.hcl.com X

Repositories

Repositories:

Appearance
Files for Rollback - Add Repositary..
o bl + [portalfiles/Portal9.5/SETUP/products/WP95_Server/freposi ‘g
elp - — St a— —
b Internet e N L RO '9a_Enabie/rep Edit Repository.

Passport Advantage Remoye Repository

Secure Storage
Updates Move Up

Test Connections

Service repositories are remote locations where updates or extensions to packages (including the
Installation Manager itself) are stored.

4 Search service repositories during installation and updates.

Restore Defaults Apply

@ Cancel OK
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Click OK twice.
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11. InIBM® Installation Manager, click the Install icon:

1BM Installation Manager o m %

Ele Help

IBM Installation Manager

Ca Install
/' Install software packages.

Update

Discover and install updates i f Manage Licenses
and fixes to installed
software packages.

Roll Back
Modify v
= Change installed software
JE packages by adding or ﬂ Uninstall

removing features and
functions.

12.  Check the boxes to install the HCL Portal Server and HCL Portal Enable (or the offering you are
installing, e.g. Extend, Express, etc.) packages.

@ I1BM Installation Manager @myprimaryportal hel.com = O >
Install Packages
Select packages to install:
Installation Packages Status Vendor
- ;_/" 1% HCL Portal Server
[+ [i*! Version 9.5.0.0 will be installed HCL
% & HCL Portal Enable
[+ version 9.5.0.0 will be installed  HCL
_| show all versions Check for Other Versions, Fi;
Details
HCL Portal Enable 9.5.0.0
HCL Portal Enable helps increase efficiency and accuracy of website deployments. It places cor
the hands of content experts to create, maintain, and deliver online content while IT retains coi
Enable delivers the right information to the right audience It includes rich text editing tools, we
templates, and personalization services to build rich websites. These websites can deliver higr
dynamic content to customers, business partners, and employees in more relevant ways. More
B T L ot L o o e L W PRy W T YT, Vo T o o
@ < Back Next > Insta Cancel

Click Next
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13.  Accept terms of licensing agreement. Click Next.

14. Select the option Use the existing package group and click on IBM WebSphere Portal v8.5.

@ I1BM Installation Manager @myprimaryportal.hcl.com — O x
Install Packages
A package group is a location that contains one or more packages. Extensions can be
installed into a common package group only and will share a common user interface.
Select an existing package group for the extensions.
Install Licenses Features summary
(®) Use the existing package group
Create a new package group
Package Group Name Installation Directory Architectu
“-. IBM WebSphere Portal Server V8.5 Jopt/HCL/WebSphere/PortalServer 64-bit
%, IBM wWebSphere Application Serve jopt/HCL/WebSphere/AppServer 64-bit
Package Group Name: IBM WebSphere Portal Server V8.5
Installation Directory: | jopt/HCL/WebSphere/PortalServer | | Browse.., |
Architecture Selection: | ' 32-bit (s} 64-bit
Details Disk Space Information
Shared Resources Directory: jopt/HCL/WebSphere/ Volume  Available Space
IMShared
/ 11.43 GB
Installed Packages
* |BM WebSphere Portal Server CF17 for v8.5 and
v9.0
e IBM WebSphere Portal Enable 8.5.0.0
@ . <Back . Next> Install Cancel

Click Next
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15. Enter your PortalAdminID and PortalAdminPswd for the Websphere Application Server
credentials. Scroll down. Enter your PortalAdminID and PortalAdminPswd for the Portal Server

credentials.

Install Packages
@ click 'validate Credentials' to test the values you entered for the administrator user

ID and password.

Install Licenses Location I Features > Summary

w [y HCL Portal Server 9.5.0.0 Configuration for HCL Portal Server 9.5.0.0

e Application Server and Portal Server Credentials

Enter the administrator user ID and password for the Web
The IBM Installation Manager uses these values to update

WebSphere Application Server
Administrator ID:

PortalAdminiD

Password:

AR

Confirm Password:

4 N R
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16. Click Validate Credentials

HCL Portal Server
Administrator ID:

PortalAdminID

Password:

A AR

Confirm Password:

tt*rmm*i

Validate Credentials

__| Check here to continue without validating credentials |

Wait a few minutes for validation to complete. Click Next.

17. Review Summary. Select Install.

e IBM Installation Manager @myprimaryportal.hcl.com — O X

Install Packages
Review the summary information.
Install Licenses Location Features [ Summary

Target Location

Package Group Name: 1BM WebSphere Portal Server V8.5
Installation Directory: Jopt/HCL/WebSphere/PortalServer
Shared Resources Directory: fopt/HCL/WebSphere/IMShared

Packages
Packages
[ HCL Portal Server 9.5.0.0
[ HCL Portal Enable 9.5.0.0

Environment Disk Space Information
English Total Available Space
! 11.43 GB

Total Download Size: 828.2 KB
Total Installation Size: 3.73 MB

» Repository Information

@ < Back | Next > Install Cancel
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18.  When the installation is finished, you should see:

@ IBM Installation Manager @myprimaryportal.hcl.com

Install Packages =

o The packages are installed. View Log File

The following packages were installed:

v %, IBM WebSphere Portal Server V8.5
[ HCL Portal Server 9.5.0.0
(%) HCL Portal Enable 9.5.0.0

Note: If the packages support rollback, the
temporary directory contains rollback files
for installed packages. You can delete the
files on the Files for rollback preference

page.

Finish

NOTE: On a successful upgrade, you will be presented with a link to fully integrate HCL ® Portal 9.5 with
Watson Content Hub. Watson Content Hub integration is not required to build a WebSphere Portal 9.5 cluster

19. Verify that you can access your Portal in an internet browser by navigating to:
http://myprimaryportal.hcl.com:10039/wps/portal
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Chapter 2 — Configuring the Primary Node for a
Remote Database

In this section, you will configure HCL ® Portal to use an external database. For this guide, IBM ®
DB2 is used as the external database with Type 4 drivers installed and run on a different host than
HCL ® Portal. More information about other databases that can be used with HCL ® Portal is
available by referencing the HCL ® Digital Experience v9.5 Product Documentation at the following
link:

https://help.hcltechsw.com/digital-experience/9.5/welcome/wp95 welcome.html?query=9.5

To complete the task of configuring the Primary node for a remote database, execute the
following steps:

1. On the Portal Server, create a directory called “dbdrivers” at the following location:
wp_profile/PortalServer/dbdrivers
for this guide:
/opt/IBM/WebSphere/wp_profile/PortalServer/dbdrivers

2. On the DB2 environment, navigate to DB2InstallationRoot/YourDBZ2Version/java, for example:
/opt/ibm/db2/V11.1/java
and locate these two files:

db2jcc4.jar
db2jcc license cu.jar

[root@myprimaryportal javal# pwd
opt/ibm/db2/V11.1/java
[root@myprimaryportal javal# 1s -la | grep -i 'db2jcc4.jar\|db2jcc_license _cu.jar'

=r--r--r-- 1 bin bin 3894263 Jun 9 2016 db2jcc4.jal
=r--r--r-- 1 bin bin 1534 Jun 9 2016 db2jcc license cu.jat
[root@myprimaryportal javal# |}

3. Copy the two files from the DB2 server to the Primary Portal server and save them in the newly
created /opt/HCL/WebSphere/wp_profile/PortalServer/dbdrivers folder.
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NOTE: The next several steps will use a web-based tool called the Configuration Wizard. The
Config Wizard helps you create custom scripts with instructions called workflows. Workflows are

used to configure different aspects of HCL ® Digital Experience. For more information see the

following page in the IBM ® Knowledge Center:

https://help.hcltechsw.com/digital-experience/9.5/welcome/wp95 welcome.html?query=9.5

4. On the Portal Server, navigate to the AppServerRoot/profiles/cw_profile/bin directory.
Execute the following command to start the Configuration Wizard:
JstartServer.sh serverl

5. Open a web browser and navigate to the Configuration Wizard:

http://myprimaryportal.hcl.com:10200/hcl/wizard

and log in with the ConfigWizardID and ConfigWizardPswd user credentials you created during
Portal installation.

CONFIG WIZARD CUMULATIVE FIX NOTE: The following screenshots are taken from a
Portal system with cumulative fix 17 installed from Chapter 1 of this guide. If your installation has
a different cumulative fix level, your Config Wizard options and screens could differ slightly from
those shown in this guide.

6. From the Configuration Wizard home screen, select Set Up a Cluster>Database Transfer.

5 @

Set up either a dynamic or static cluster to use for production sites. For guidance, see Roadmaps for clusters. Learn More

5§ Digital Experience Cont X | +

5 e a D & 1 yportal_hel.com: 1021

Configuration Wizard

Home [ Set Up a Cluster

Set Up a Cluster

—> DATABASE TRANSFER

Select this option to transfer data from Apache Derby to any of the database types
that are supported by Digital Experience Portal.

~» CREATE A DEPLOYMENT MANAGER
Create a deployment manager profile that is augmented with Digital Experience
Portal resources.

—> CREATE A CLUSTER
After you create the deployment manager, create a static or dynamic cluster that
contains the primary node.

~> ENABLE FEDERATED SECURITY
Add an LDAP user registry to the default federated repository to store user account

Information for authorization. =
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7. Choose your target operating system, name of your Portal profile, and Portal profile's location

NOTE: The profile name and profile location fields are pre-populated with the defaults.

At untbors Aol ying eoieorenal oo TR e Wi Caf Gelemine winch Sebms yi st Corsgiete This yi Can R D ComBguiebon S pour Gl of S e £ e atd Sosgl Blea 19 18 ket | you Saied poat Selngs B 4 S
530N, You on wioed he 10®ngs now Leam Mo

nnnnnn

Click the right arrow.

8. Provide answers for the following database setup items (examples shown; you can
customize these values according to your environment or preferences):

Database management software: DB2

Do you want to transfer one database or multiple databases: Multiple Databases

Is the database hosted on the same server as the portal: No

Do you want the wizard to create users and assign them permission: No, generate scripts
Do you need advanced database collation support: Yes

Do you want to enable workload balancing for DB2 pureScale: No

Connect to database server to validate settings: Yes
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@ Digital Experience C

Wizard - Mozilla hcl.com X
Digital Experience Confic X | 4
&« e D & hcl.com [+ I @ =
Upload Saved Selections
System Information Database Setup Database Users
P
Database management software: DB2 A
to transfer to one database or multiple databases or One database
Multiple databases or schemas
Is th me server as the portal Yes
No
Do you want the wizard to create schemas and assign permissions to hemas and assign appropriate
users:
pts that | can use to create sch ssign
Do you need advanced database collation support: . Yes, p vanual collation instructions
collation support is not needed
(For DB2 PureScale only): Do you want to enable workload balancing Yes ?
for DB2 pureScale:
No
Connect to database server to validate settings . Yes

Cancel

Click the right arrow.

HCL ® Portal leverages two different database users - a configuration user and a runtime
user. The configuration user is used during a limited number of database operations and
requires additional privileges on the database server. The runtime user is used to connect
the Portal to the database during normal, day-to-day operations and requires fewer
privileges.

Review the following link for more details on the required permissions for the
configuration and runtime user for each of the Portal databases:

https://help.hcltechsw.com/digital-
experience/9.5/config/unix_db2i_priv_dbusers _common.html?query=portal%20database
S

This guide will use db2inst1 for both the configuration user and runtime user for all
databases in subsequent steps. For this step you must manually setup database
configuration users and database runtime users on the database server to meet your
company’s enterprise database requirements. Record the IDs and passwords for each of
the database users you created as they will be needed in subsequent steps.
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10. Answer the database users questions (examples provided):

Do portal database domains use the same user ID and passwords: Yes

Do you need runtime database user ID for day-to-day operations: Yes

System Information Database Setup Database Users
r .
Do portal database domains use the same @ Yes

user ID and passwords
No

Do you need runtime database user ID for @ Yes
day-to-day operations:
No

Click the right arrow.
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11. Fill in the name for each Portal Domain as well as the Database server hostname and port

Database Transfer

Answer Questions Customize Values Configure
Q Complete In progress
Database Connection System Information Database Information
V'S

*Release database name:

*Community database name:

*Customization database name:

*JCR database name:

*Feedback database name:

*Likeminds database name:

*Host name:

*Port number:

Click the right arrow.

WPREL €
Example: WPREL

WPCOMM ?
Example: WPCOMM

WPCUST ?
Example: WPCUST

WPJCR @
Example: WPJCR

WPFDBK | 2
Example: WPFDBK

WPLM ?
Example: WPLM

mydbserver.ibm.com ?
Example: yourhost.yourco.com

50000 | @
Example: 50000
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12. Fill in the values for your PortalAdminID and PortalAdminPswd specified during

installation in Chapter 1.

@ Digital Experience Wizard - Mozilla Fi

Digital Experience Confic X | 4

@ & https://myprimaryportal.hcl.com:10202/ibm/wizard/Wizard/default/ver=2.0/rparam=currentstage=1/rparam=navigationFrom=c

Home / SetUp a Cluster / Database Transfer
Database Transfer

Answer Questions Customize Values 3 Configure
@ Complete In progress

Database Connection System Information Database Information
—_——

*WebSphere Application Server administrator ID: PortalAdminiD

*WebSphere Application Server administrator password: —

*Re-enter the password

*Digital Experience Portal installation directory: JopUHCLMebSphere/PortaiServer

Example: /opt/IBM/WebSphere/PortalServer
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13. Fill in your Configuration, Database administrator, and Runtime user ID's and
corresponding passwords. All are db2inst1 for this guide.

B D it Gt %

€ C @ OF helcom B o

@ Getung Started

dbe 202 dmsuBatEr S tom SDIOINPTOMM rehumahas =7

' h03
v - X e
k]
- DICOMPICS rater
v =
e
bs 2 Ay DICOINPEDEH retum Al =
ImaD

Step 13 is continued on the next page.
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B

® 1

Scroll down and fill in the following values for each database:
» Database Name: this guide uses the pre-populated defaults

» Data Source: this guide uses the pre-populated defaults

» Database URL: use the example provided below the text box and add your
database server hostname in place of mydbserver.ibm.com

NOTE: DO NOT put “@” symbols around the database urls. Be sure to end each
URL with a semicolon. Example:

jdbc:db2://mydbserver.ibm.com:50000/<databaseName>:returnAlias=0;

c o of helcom B o -9 +mmo =
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14. Scroll down and fill in the last two values:

« IBM® DB2 Library: the full paths to both type 4 DB2 drivers that you copied onto
the primary Portal server, separated by a colon. This guide used:

/opt/HCL/WebSphere/wp_profile/PortalServer/dbdrivers/db2jcc4.jar:
/opt/HCL/WebSphere/wp_profile/PortalServer/dbdrivers/db2jcc license cu.jar

NOTE: For Windows environments, use a semi-colon between the two paths rather than
a colon, which is used for Linux environments.

* Temporary directory to be used for collation: choose a name and location for
your temporary directory. This guide uses:
/tmp/tmpdb

JopUHCLS p_profile/Ps i 2jccd.jar/opyHCLAWebSphereiwp_pr

Example: fopt/ibm/db2/v10.5/java/db2jccd. jar:fopt/ibm/db2/V10.5 *Tempaorary directory te be used for collation
fjava/db2jcc_license cu.jar

#tmpAmpdb

Click the right arrow.

15. On the next screen, click Download Configuration Scripts and save the downloaded file.

@ Digital Experience C Wizard - Mozilla hel.com = X

BN Digital Experience Confic X | +

&« c @ ® & https://myprimaryportal.hcl.com:10202/ibm/wizard/Wizard/default/ver=2.0/rparam=currentstage=2/rparam=workflow=transfer-dat .9 w mn o

FAC L. Configuratic

Configuration Wizard

Home / SetUp a Cluster / Database Transfer

Database Transfer

Answer Questions Customize Values Configure

@ complete @ complete In progress
Optional
Download Wizard Selections Download your selections in case you need to run the configuration again. You can also use your selections as a starting point to set up another server. Learn More
Download Configuration Scripts If you plan to run scripts to set up the configuration instead of running the steps from the wizard, then download an archive of the scripts. The archive is named

WorkflowInstanceScriptsAll.zip. Learn More

Click Start Configuration to begin. When the wizard reaches a manual step, it pauses the process until you can complete the manual step. You cannot cancel a running configuration. If
you leave the page or lose your connection, the configuration continues to run. Log back in to return to a configuration that is in progress. Learn More

Start Configuration Reset Steps

Do not close this window. Minimize it during the next step as you will need it again.
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NOTE: Many of the following steps will be specific to DB2; see the instructions from the
Config Wizard for steps specific to your database.

16. Move the downloaded .zip file to a convenient location on your database server as the
database instance user. This guide uses /home/user/Desktop/CWScripts and db2instl.
Unzip the file by changing directories to the location of the scripts and running:

unzip WorkflowInstanceScriptsAll.zip

The CWScripts directory now contains the scripts you will run to create and setup
your databases.

17. Go up one directory:

cd ..

and run the following from /home/user/Desktop, or your equivalent location, to change
the permissions on the scripts.:

chmod -R 777 CWScripts

The resulting permissions in the Scripts/ folder should look like this:

18. Navigate to the scripts subdirectory.
Change the name of “CreateDB2Database” to “CreateDB2Database.sh”.

19. As the db2inst] user execute the CreateDB2Database.sh script
(ensure that DB2 is started before running this script):

su db2inst1

./CreateDB2Database.sh

20. After that command completes successfully, execute the following command:

db2 -tvf SetupDB2Database.sql
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21. Go back to the Config Wizard window. You should see a screen like the following:

Start Configuration ’ ‘ Reset Steps

Step
1

10

"

12

Task

Manual Step: Create the database users and groups.
Instructions for Step 1

Mark Step Complete

Back up the properties files that the wizard uses during the configuration.
View Step Command

Run Step | Skip Step

Manual Step: Download the script and run it on the database server to create your database.
Download Script Instructions for Step 3

Mark Step Complete

Manual Step: Download the script and run it on the database server to set up your database.
Download Script  Instructions for Step 4

Mark Step Complete

Manual Step: Set up JCR collation for correct language locale order.
Instructions for Step 5

Mark Step Complete

Stop the portal server.
View Step Command

Run Step | Skip Step

Manual Step: Restart the DB2 server.
Instructions for Step 7

Mark Step Complete

Validate the database connection and environment.
View Step Command

Run Step | Skip Step

Transfer the database.
View Step Command

Run Step | Skip Step

Manual Step: Download the script and run it on the database server to grant privileges to the
runtime user.
Download Script  Instructions for Step 10

Mark Step Complete

Configure the JCR domain to support large files.
View Step Command

Run Step | Skip Step

Start the portal server.
View Step Command

Run Step | Skip Step
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Not Started

Not Started

Not Started

Not Started

Not Started

Not Started

Not Started

Not Started

Not Started

Not Started

Not Started

Not Started



22. Click Mark Step Complete for Step 1
23. Click Run Step for Step 2,

24. Click Mark Step Complete for Step 3 and Step 4.

3 Manual Step: Download the script and run it on the database server to create your database. {5 Complete
Download Script  Instructions for Step 3

Mark Step Complete

4 Manual Step: Download the script and run it on the database server to set up your database. & Complete
Download Script  Instructions for Step 4

Mark Step Complete

25. Click Instructions for Step 5 and review the details provided.

5 Manual Step: Set up JCR collation for correct language locale order.

Instructions for Step 5

Mark Step Complete

26. Copy the following files from the WebSphere Portal server to /tmp/tmpdb directory (the
temporary folder you specified on the previous Config Wizard page) on the DB2 server:

/opt/HCL/WebSphere/PortalServer/jcr/wp.content.repository.install/lib/wp.content.repository.install.jar
/opt/HCL/WebSphere/wp_profile/PortalServer/jcr/config/registerCollationUDF Template.sql

27. Set up collation on the database where the JCR domain is located. Change to this directory:

db2 instance_owner home/sqllib/function

28. Execute the following command:

db2home/sqllib/java/jdk/bin/jar -xvt /tmp/tmpdb/ wp.content.repository.install jar icm/CollationUDF.class

[db2instl@myprimaryportal function]$ pwd

/home/db2inst1/sqllib/function

[db2instl@myprimaryportal functionl$ ../java/jdk64/bin/jar -xvf /tmp/tmpdb/wp.content.repository.install.jar icm/CollationUDF.class
inflated: icm/CollationUDF.class

[db2inst1@myprimaryportal functionl$ I

29. Change to the temporary directory where you copied the files in a previous step. For
example, you can use this temporary directory on the DB2 server:
/tmp/tmpdb

30. Open the file “registerCollationUDFTemplate.sql” and change all SCHEMA references to

the JCR schema; for example, JCR. For this guide, the default schema name, JCR, was used
and the final result looked like the following:
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[db2instl@myprimaryportal tmpdb]$% more registerCollationUDFTemplate.sql
CREATE FUNCTION JCR.SORTKEYJ
(

VALUE VARCHAR(32672),
LOCALEID VARCHAR(50)

)

RETURNS VARCHAR(5000) FOR BIT DATA

FENCED THREADSAFE

DETERMINISTIC

NO SQL

NO EXTERNAL ACTION

LANGUAGE JAVA

PARAMETER STYLE JAVA

EXTERNAL NAME 'icm.CollationUDF!generateKey'

ALLOW PARALLEL

RETURNS NULL ON NULL INPUT;

GRANT EXECUTE ON FUNCTION JCR.SORTKEYJ TO PUBLIC;

UPDATE DBM CFG USING JAVA HEAP S/ 4096;
[db2instl@myprimaryportal tmpdb]$ i

31. Connect to the JCR database:
db2 connect to WPJCR user DBUser using DBPasword

32. Enter this command to run the script:
db2 -tvf /tmp/tmpdb/registerCollationUDFTemplate.sql

[db2instl@myprimaryportal tmpdbl$ pwd

/tmp/tmpdb

[db2instl@myprimaryportal tmpdb]$ db2 connect to WPJCR user db2instl using passwOrd
Database Connection Information

Database server

= DB2/LINUXX8664 11.1.0
SOL authorization ID = DB2INST1
Local database alias = WPJCR

33. Disconnect from the JCR database:
db2 disconnect all

34. Restart the DB2 instance.
db2stop
db2start

35. Connect to the JCR database. Validate the UDF template was registered
db2 connect to WPJCR user DBUser using DBPasword values jcr.sortkey(‘abc’,’en’)

This guide observed the following message after running the final command:

1 record(s) selected.

db2 => |}
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36.

37.

38.

39.

40.

41.

Disconnect from the DB2 terminal window

quit
db2 disconnect all
db2 terminate

Switch back to the Portal server. Open a terminal window and navigate to <wp_profile>/bin.

Execute the following command:
J/startServer WebSphere Portal

Open a web browser and navigate to the following URL:
https://myprimarportal.ibm.com:10041/ibm/console

Login with your PortalAdminID and PortalAdminPswd specified during installation.

Navigate to to Resources > Resource Environment > Resource Environment
Providers > JCR ConfigService PortalContent > Custom properties.

Click New. Create a new property for each of the following. Click OK after specifying each
property and Save to save the Changes.

Name: jer.query.collation.db2.enabled
Value: true
Type: java.lang.String

Name: jcr.query.collation.en
Value: en
Type: java.lang.String

Name: jcr.query.collation.sv
Value: sv
Type: java.lang.String

Name: jcr.query.collation.zh
Value: zh
Type: java.lang.String

Name: jcr.query.collation.de
Value: de
Type: java.lang.String

Name: jcr.query.collation.da
Value: da
Type: java.lang.String

Name: jcr.query.collation.hu

Value: hu
Type: java.lang.String
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Name: jcr.query.collation.jp
Value: jp
Type: java.lang.String

You can administer the following resources:

[:| jcr.query.collation.en en
] jer.query.collation.da da
D jer.guery.collation.db2.enabled true
[] |lcr.guery.collation.zh zh
|:| jcr.query.collation.de de
D jer.query.collation.jp ip
] jer.guery.collation.sv sv
|:| jcr.query.collation.hu hu

42. Click Mark Step Complete for Step.5

43. Click Run Step for Step 6.

44. Restart the DB2 server. Run the following commands on the DB2 server:
db2stop
db2start

45. In the Config Wizard, click Mark Step Complete for Step 7.

46. In the Config Wizard, click, Run Step for Step 8 - Validate the database connection and
environment..

NOTE: If this step fails, click “View Result” and look for the first ERROR message in the log.
Issues with this step are often caused by small typing mistakes in the DB URL and DB2 Library
(driver paths) fields. You can click the left arrow to return to the page where those values are
defined and ensure that all information and formatting is correct, then click right again, mark
steps 1-6 as Complete or Skip Step, then run the validation again.

47. In the Config Wizard, click, Run Step for Step 9 - Transfer the database.

54



48. For Step 10 — switch back to your DB2 server as the db2instl user and open a terminal window.
Navigate to /home/db2inst1/Desktop/CW Scripts/scripts directory

49. Execute the following command:
db2 -tvf GrantDB2RuntimeUserPrivileges.sql
50. On the Config Wizard, click Mark Step Complete for Step 10.
51. Click Run Step for Step 11 — Configure the JCR domain to support large files.
52. Click Run Step for Step 12 — Start the portal server.
53. Click Finished.
54. Verify that you can access your Portal on the web after the database transfer by navigating to:

http://myprimaryportal.ibm.com:10039/wps/portal

in a browser.

At this point, you have successfully installed HCL ® Digital Experience and configured it
to use an external database.
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Chapter 3 — Installing and Configuring the
Deployment Manager

In this section, you will install the Deployment Manager (dmgr) on a separate server. The
installation of the dmgr will leverage the IBM ® Installation Manager (IIM) tool - like the

installation of the HCL ® Digital Experience v9.5 server on the primary node in Chapter 1. In this
guide, the installation was completed with a graphical user interface (GUI) using the root user
with installation images on a local hard drive.

Installing IBM ® Installation Manager

The IBM® Installation Manager, (IIM) is a tool that you can use to install and maintain your IBM ®
software packages. Wizards guide you through the steps that you must take to install, modify, update,
roll back, or uninstall your IBM ® products.

1. Open a terminal window and run:

ping mydmgr.ibm.com

where mydmgr.ibm.com is your fully qualified hostname.
2. In the same terminal window,

run: ping localhost

to verify that the localhost settings are properly configured on your server.

3. Linux/UNIX environments only: Ensure ulimit is set to 10240 or higher by running:
ulimit -n 10240

in the command line.
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4. The installation media for the Deployment Manager is the same as the installation media for the
Portal server. Unzip all .zip files provided with your Portal media into a single folder. This
folder will be referred to as the installationMediaRoot folder.

For this guide the following directory is used for the installationMediaRoot folder:
/opt/portalBinaries/SETUP/products

opt portalBinaries @ SETUP » Q || =

M launchpad products quickstart sample-
responsefiles

</ _ il,.,

setup.sh setupb4.exe setupb4.ini WP30.setup.id WPS0_Enable.
id

5. From the HCL® Portal v9.5 SETUP directory, navigate to:
SETUP/IIM/yourEnvironment
and run

J/install

where yourEnvironment is the folder that best describes the operating system of the environment in

which you are installing HCL ® Portal. For this guide the following is used:

installationMediaRoot/SETUP/IIM/linux_x86 64
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The following window will appear:

IBM Installation Manager =

o

Install Packages = = |
=g

Select packages to install: @

Installation Packa Stati Vendos License Key 1

£% i 1BM® Installation Manager

W, Version 1.8.5 Will be installed IBM No key requir

6. Click Next.

7. Accept the license agreement and click Next.

8. Choose a directory in which to install IIM. This guide uses:
/opt/IBM/InstallationManager/eclipse
for Windows this guide recommends:

c:\IBM\InstallationManager\eclpise

NOTE: In Windows environments, the default location will likely be
C:\Program Files\IBM\InstallationManager. Spaces in the file path can cause problems later in
the installation/configuration of Portal. It is good practice to create a folder called “IBM” at

C:\IBM or a similar location into which IIM and HCL ® Portal can be installed.
9. Click Next.
10. On the Summary screen, click Install to begin the installation.

11. When the installation is complete, click Restart Installation Manager.

12. In IIM, click File > Preferences > Repositories. Click Add Repository and add the following
repositories:

installationMediaRoot/W ASND90/repository.config
installationMediaRoot/JDK803/repository.config

where installationMediaRoot is set to /opt/portalvOBinaries/SETUP/products in this guide
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13. Click Apply>OK. Then, back on the home screen click Install.

14. Select the check box for IBM WebSphere Application Server Network Deployment
and click Next.

Install Packages
Select packages to install:

Installation Packages Status Vendor

B # 1BM WehSphere Application Server Network Deploymen

(»1lj, Version 9.0.0.2 Will be installed IBM
[+ IBM SDK, Java Tec hnology Edition, Version &
| (2 Version 8.0.3.20 Will be installed 1BM

15. Accept the license agreement and click Next.
16. Select the location of the Shared Resources directory and click Next.
This guide uses: /opt/IBM/IMShared
17. Select the Installation Location for your Deployment Manager and click Next.

This guide uses: /opt/IBM/WebSphere/AppServer

Install Packages

A package group is a location that contaings one or more packages. Some compatible packages can be installed into a common package grol
and will share a common user interface. Select an existing package group, or create a new one.

Irvstal LECErLEs | LOCATIN _:} Features LIy

ng [
% Create a new package group

Package Group Mamae Instatlation Directory Archite

- IBM WebSphere Application Server V9.0 loptNIBMMWebSphera/AppSeiver

Package Group Name: IBM WebSphere Application Servar ¥3.0

installation Directory; foptfIBMAWebSphere/AppSemnver |

Architecture Selection 32-bit (8 GA-bat

18. Select any additional languages you want to install and click Next. For this guide, no
additional languages were selected.
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19. Select any additional features you want to install and click Next.

This guide uses the defaults with SDK v8 selected

Install Packages

Select the features to install.

Install Licenses Location | Features Y ‘.-:u:11r21-}'?"

Features

& # I1BM WebSphere Application Server Network Deployment 9.0.0.2

(W% 1BM SDK. Java Technology Edition, Version 8 8.0.3.20

20. On the summary screen, click Install.

21. When the installation completes, select the radio button None for Which program do
you want to start? and click Finish.

22. In this next sequence of steps, you will use the Configuration Wizard to create and configure
a profile for the Deployment Manager. Open the Configuration Wizard (Config Wizard) in a
web browser by navigating to:

http://myprimaryportal.ibm.com:10200/hcl/wizard

Log in with your ConfigWizardID and ConfigWizardPswdConfig credentials.

23. On the Config Wizard Home Screen, click Set Up a Cluster>Create a Deployment Manager.

@ Digital Experience Wizard - Mozilla Fi hel.com = X
Digital Experience Confic X | 4
€)= C 0 @ & https://myprimaryportal.hcl.com:10202/ibm/wizard/Wizard/default/ver=2.0/rparam=currentPage=com.ibm.wplc.config.wizard.f B~ 9% m m =

Configuration Wizard

Home / Set Up a Cluster

Set Up a Cluster

Set up either a dynamic or static cluster to use for production sites. For guidance, see Roadmaps for clusters. Learn More

—> DATABASE TRANSFER

Select this option to transfer data from Apache Derby to any of the database types
that are supported by Digital Experience Portal.

—> CREATE A DEPLOYMENT MANAGER
Create a deployment manager profile that is augmented with Digital Experience
Portal resources.

—> CREATE A CLUSTER
After you create the deployment manager, create a static or dynamic cluster that

contains the primary node.

—> ENABLE FEDERATED SECURITY
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24. Choose your target operating system, name of your Portal profile, and the Portal profile
location The profile name and profile location pre-populated values are the defaults.

NOTE: wp_profile is the correct value for the Target portal profile name field.

Create a Deployment Manager
1 Anaveer Questions 2 Customire Values

Answer quastans sbout your environment so that the wizard can defermine whsch fiskds you must complete. Then, you can run fhe confguration, save your settings, or download the IRstuction and scnpt fles to run lates. if you saved your settings fom & pravious
SESSION, You Can upload the setings now. Loarn hMars

Sysmm miwimabn Depicymen ey s
_—

we_prtia

Click the right arrow.

25. Select On a remote server for the deployment manager location.

Create a Deployment Manager

1 Answer Questions : : Customine Values
W pegresa

3 Configers

Answer guestions about your envinenment sa thal the wirard can determane which fields you maust complete. Thar, you can fen the configuration, save your settings. or downlosd the
lnstruction and script files to run (ater. If you saved your sattings from a previous session, you can upload the settings now. Loearm Mors
Byulem B Vanage:

Click the right arrow.

26. Fill in the hostname of your primary Portal server.
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i Bl il L g

Create a Deployment Manager

1 -:.JI'\.\\:.‘."'"?:.II!'.-'EIOI""- 2 {'I-J?.ﬁ:l:'.lfe Walues 3 Configure
Click the right arrow.
27. Fill in the following values (examples given):

Deployment manager host name: mydmgr.ibm.com,
New deployment manager profile name: dmgro01

Deployment manager profile path:
/opt/HCL/WebSphere/AppServer/profiles/dmgr01

Deployment manager cell name: this guide uses the default, dmgrCell01, but you can
change it to anything EXCEPT the name of the previously created Portal cell.

Deployment manager node name: this guide uses the default, dmgrNode01, but you can
change it to anything EXCEPT the name of the previously created Portal node.

WebSphere Application Server installation directory:
/opt/HCL/WebSphere/AppServer

WebSphere Application Server administrator ID: dmgrAdminlD
WebSphere Application Server administrator password: dmgrAdminPswd

Re-enter the password: your dmgrAdminPswd again
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Hiome |

Create a Deployment Manager

ot | Craais A Depkoymant Managir

Answer Cusstions Customize Values 3 Contigars
1§ Canpite B
ot vt Coopbaytraal AEakages Bl Tmalen
—
} “Crantes masage okl nare hu_nam:l o L
Figa finplzemam managa prila name [rmﬂ *
it s i 1 [T e ——— ] L]
I T R TR ‘ﬁ)
"Cepiersl raeager ool naie Ib_lm‘;._ﬂu o ¥ 4
Famps degTai!
“Cipie Miskger fode hitte [mm__ gt ®
Luirepi degticded]
“WoesEpbary dpgacion Serar milatiben deedoes [nputcimersebmmiprsennc ¥
EAmot prB S aare
“WeeSgkey ggecyten v yimrete ) [fmiphereni ] !
aighn ot S i fssete
il i paTERnd e
Click the right arrow
28.  The following screen will appear:
@ Digital Experience Wizard - Mozilla hel.com = X

B4 Digital Experience Confic X | +
(; > C B @ & https://myprimaryportal.hel.com:10202/ibm/wizard/Wizard/default/ver=2.0/rparam=currentstage=2/rparam=workflow=Create D¢ - 9 ﬁ‘ L N @D =
Answer Questions Customize Values 3 Configure
@ complete @ complete In progress
Optional

Download Wizard Selections

Download your selections in case you need to run the configuration again. You can also use your selections as a starting point to set up another server. Learn More

If you plan to run scripts to set up the configuration instead of running the steps from the wizard, then download an archive of the scripts. The archive is named
WorkflowInstanceScriptsAll.zip. Learn More

Click Start Configuration to begin. When the wizard reaches a manual step, it pauses the process until you can complete the manual step. You cannot cancel a running configuration. If
you leave the page or lose your connection, the configuration continues to run. Log back in to return to a configuration that is in progress. Learn More

Start Configuration ‘ ‘ Reset Steps
step Task Status

1 Manual Step: Download the script and view instructions to create the deployment manager. Not Started
Download Script  Instructions for Step 1
Mark Step Complete

2 Manual Step: Add the required Digital Experience Portal files to the remote deployment manager. Not Started
Instructions for Step 2
Mark Step Complete

3 Manual Step: Download the script and view instructions to augment the deployment manager with Digital Experience Portal files. Not Started

Download Script  Instructions for Step 3

Mark Step Complete

Cancel ‘
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29.

30.

31.

32.

33.

34.

35.

Click Download Configuration Scripts, save WorkflowInstanceScriptsAll.zip in an
easily accessible location, then unzip it.

Copy the following files and save them in a temporary location on the dmgr server:
AugmentRemoteDeploymentManagerProfile CreateRemoteDeploymentManagerProfile

; |fant? | | !
|AugmentRemoteDep | CreateRemoteDeplo scripts.lst
YoymentManagerPrgf %ymentiManagerProfilf

file R e

For this guide, they were placed in the following location:

/tmp/Scripts

Change the permissions on this folder as follows:

chmod -R 777 /tmp/Scripts

Change the name of “CreateRemoteDeploymentManagerProfile” to
“CreateRemoteDeploymentManagerProfile.sh”

Run CreateRemoteDeploymentManagerProfile.sh:
./CreateRemoteDeploymentManagerProfile.sh

Click Mark Step Complete for Step 1 — Download the script and view instructions to
create the Deployment Manager.

Manual Step: Download the script and view instructions to create the deployment manager. c@- Complete
Download Script  Instructions for Step 1

Mark Step Complete

Ensure that the newly created dmgr is stopped:

cd /opt/HCL/WebSphere/ AppServer/profiles/dmgr01/bin

./stopManager.sh -user dmgrAdminlD -password dmgrAdminPswd
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36. Back on the Primary Portal Server, navigate to WebSpherelnstallationRoot/PortalServer:
[ WebSphere. : | PortalServerI = 100% & E-Icon Wiew 3

e -

base bin

U

E-
i
B

|
|

filesForDmgr help installer

)

ul
L
Lll

jer license Iwo

/opt/IBM/WebSphere/PortalServer

37. Copy the folder named “filesforDmgr” and save it in the /tmp directory on the
Deployment Manager Server.

38. Open the filesforDmgr folder on the dmgr Server. Move the filesforDmgr.zip file in this
directory to the AppServer directory and unzip it there. Example:

mv /tmp/filesForDmgr/filesForDmgr.zip /opt/HCL/WebSphere/AppServer
cd /opt/HCL/WebSphere/ AppServer
unzip filesforDmgr.zip

39. If the deployment manager profile was not created in the default
${WasHome}/profiles/Dmgr01 directory, then the metadata_ wkplc.xml file, which is in
the ${WasHome}/profiles/Dmgr01/config/.repository directory in the compressed file,
must be copied into the config/.repository subdirectory under the deployment manager
profile directory.

Please notice:

This guide used a non-default name of dmgrOland thus ran the following command:

cp /opt/HCL/WebSphere/ AppServer/profiles/Dmgr01/config/.repository/metadata_ wkplc.xml
/opt/HCL/WebSphere/AppServer/profiles/dmgr01/config/.repository/

40. Back on the Config Wizard, click Mark Step Complete for Step 2 — Add the
required WebSphere Portal files to the remote deployment manager.
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2 Manual Step: Add the required WebSphere Portal files to the remote deployment manager. ) Complete
Instructions for Step 2

Mark Step Complete

41. On the dmgr Server, change the name of the file

AugmentRemoteDeploymentManagerProfile
to
AugmentRemoteDeploymentManagerProfile.sh

42. Run the AugmentRemoteDeploymentManagerProfile.sh script
cd /tmp
./AugmentRemoteDeploymentManagerProfile.sh

When this is complete you should see the line “Profile augmentation succussed” about
one third of the way down in the command line output.

[root@myprimaryportal scripts]# ./AugmentRemoteDeploymentManagerProfile.sh
ADMUO116I: Tool information is being logged in file
/opt/HCL/WebSphere/AppServer/profiles/dmgrol/logs/dmgr/startServer. log
ADMU®128I: Starting tool with the dmgr@l profile
ADMU3100I: Reading configuration for server: dmgr
: Server launched. Waiting for initialization status.
server dmgr open for e-business; process id is 8878
ESS: Profile augmentation succeeded.
: Tool information is being logged in file
/opt/HCL/WebSphere/AppServer/profiles/dmgrol/logs/dmgr/stopServer.log
: Starting tool with the dmgr@l profile

: Reading configuration for server: dmgr
: Server stop request issued. Waiting for stop status.
: Server dmgr stop completed.

: Tool information is being logged in file
/opt/HCL/WebSphere/AppServer/profiles/dmgr@1l/logs/dmgr/startServer. log
: Starting tool with the dmgr@l profile
: Reading configuration for server: dmgr
: Server launched. Waiting for initialization status.
ADMU300OI: Server dmgr open for e-business; process id is 9401
[root@myprimaryportal scriptsl# ||

43. Click Mark Step Complete for Step 3 — Download the script and view instructions to
augment the deployment manager with HCL ® Portal files
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44. Click Finished

Task

Manual Step: Download the script and view instructions to create the deployment manager.
Download Script  Instructions for Step 1

Mark Step Complete

Manual Step: Add the required WebSphere Portal files to the remote deployment manager.
Instructions for Step 2

Mark Step Camplete

Manual Step: Download the script and view instructions to augment the deployment manager with WebSphere Portal files.

Download Script  Instructions for Step 3

Mark Step Complete

‘ Finished

Status

@ Complete

# Complete

# Complete

45. Verify that you can access your newly created Deployment Manager's console by opening a
web browser and navigation to:
https://mydmgr.ibm.com:9043/ibm/console

WehS__ph;r_e.ﬁ""’"" :

Welcome

View: | All tasks

Welcome
4 Guided Activities:
i+ Servers
4+ Applications
i+ Jobs
i+ Services
[+ Resources
i+ .Run;‘.\'ma -Gpera;*.iuns
[+ Security
i+ Operational policies
[+ Environment
i+ System administration
i+ Users and Groups
+ Monitoring and Tuning
i+ Troubleshooting
i+ Service .\.ntegmtiun

i UDDI

Integrated Solutions Console provides a common
administrative console for multiple products. The table
lists the product suites that can be administered
through this installation. Select a product suite to view
mare information.

Suite Name Version
WebSphere Application Server 9.0.0.2

Integrated Solutions Console, &
9.0.0.2

Build Number: cf021645.01

Build Date: 11/8/16

LICENSED MATERIALS PROPERTY =
OF IBM P

At this point, you have installed the Deployment Manager and created a dmgr profile.

Welcome =B About this Integrated Solutions Console = [

46. Add Portal admin user (PortalAdminID) in WAS Admin console then add to wasadmins group
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Chapter 4 — Federating and Clustering the Primary
Node

In this section you will create a cluster using the Configuration Wizard, add the Primary Portal Node
to this cluster, and federate the Primary Node.

1. Open the Configuration Wizard in a web browser:

http://myprimaryportal.hcl.com:10200/hcl/wizard

and sign in with your ConfigWizardID and ConfigWizardPswd.
2. On the Config Wizard Home screen, Click Set Up a Cluster>Create a Cluster.
3. Select your target operating system, Portal profile name, and Portal profile home directory.

@ Digital Experience Configuration Wizard - MillaFirefox@myprimaryportaLhcicom = x
i o yprimany

A Digital Experience Confi- X | +

PRI oF - el.com:10202ibmpwizardWizard/defaultver=2.Oparam=7 Page=com.ibm.wplc.config wizar GRS no =
Home / SetUp a Cluster / Create a Cluster

Create a Cluster

Answer Questions 2 Customize Values 3 Configure
in progress

Answer questions about your environment so that the wizard can determine which fields you must complete. Then, you can run the configuration, save your settings, or download the
instruction and script files to run later. If you saved your settings from a previous session, you can upload the settings now. Learn More
System Information Basic Cluster Settings

Target operating system: Linx 5

Target portal profile name:

wp_profile

Example: wp_profile

Target portal profile home directory: JoptHCLMebSphereiwp_profile

Click the right arrow.

4. Select the deployment manager’s location and the type of cluster you are creating. This guide
uses a static cluster with a remote Deployment Manager. For more information on static and
dynamic clustering, see the following documentation:

https://help.hcltechsw.com/digital-experience/9.5/plan/plan_clus_ovr.html
https://help.hcltechsw.com/digital-experience/9.5/plan/plan_xdclus.html

System Information Basic Cluster Settings
Where is the deployment manager: O Onthe same server as porial
@  Onaremote server
Whattype of cluster do you want to create [ Static cluster
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5. Fill in your Portal Administrator ID, Portal Administrator password, release database
configuration userID and release configuration user database password.

*WebSphere Portal administrator  |PortalAdminld ?
ID

*WebSphere Portal administrator — |essesses ?
password

*Re-enter the password ~ |eseceeee
*Release configuration user db2inst1 2
*Release configuration password: |essesese ?

*Re-enter the password == {

Click the right arrow.

6. Fill in your dmgrAdminID, dmgrAdminPswd, dmgrAdminPswd again, dmgr Cell name, dmgr
Node name, dmgr profile path dmgr host name, and dmgr soap port. All values were
specified previously during dmgr installation. The SOAP port default is 8879, which this
guide uses.

,  Parsl mlemasns Depiaymen| Manager Chustss Semngy

.......

........

Click the right arrow.
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7. Choose a cluster name. For this guide, the default, PortalCluster, is used.

Portal Information Deployment Manager Cluster Settings
—_—
*Cluster name: [PortaiCluster ] 2
Click the right arrow.

8. Check the system clocks on the Primary Portal Server and the Deployment Manager Server and
ensure that their times are within five minutes of each other. Mark Step 1 on the Config Wizard
Create a Cluster page complete.

9. For Step 2 — Federate the node, click Run Step.

10. For Step 3 — Prepare the node for clustering, click Run Step. This will run the post-
federation configuration engine task.

11. For Step 4 — Complete the cluster setup, click Run Step. This will run the cluster-
setup configuration engine task.

12. After all four steps have been successfully completed, click Finish.

step Task Status

1 Manual Step: Verify that the portal node and deployment manager system clocks are within 5 minutes of each other. @ Complete
Instructions for Step 1

2 Federate the node. This node then becomes a managed node in the deployment manager cell. @ Complete
View Step Command

Run Step | Skip Step View Resuit
3 Prepare the node for clustering. @ Complete
View Step Command
Run Step | Skip Step View Result
4 Complete the cluster setup. @ Complete
View Step Command
Run Step | Skip Step View Result
Finished

13. Verify that you can access your Portal in a web browser:
http://myprimaryportal.hcl.com:10039/wps/portal

14. Open the dmgr console in a web browser:
https://mydmgr.hcl.com:9043/ibm/console
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15. Login to the dmgr using your dmgrAdminID and dmgrAdminPswd.

16. On the left side, click Servers>Clusters>WebSphere application server clusters and ensure
that your newly created cluster PortalCluster is present. Click to the Portal Cluster name.

WebSphere. | |

View: All tasks

Welcome
+ Guided Activities
-] Servers

New

All s

+| Server Types
=] Clusters
WebSphere application server clu

Proxy server clusters

Gen

Clus

r topology
On Demand Router clusters
Dynamic clusters

4+ DataPower

+ Core Groups

WebSphere application server clusters ? -

WebSphere application server clusters

Use this page to change the configuration settings for a cluster. A server cluster consists of a group of
application servers. If one of the member servers fails, requests will be routed to other members of the cluster.
Learn more about this task in a guided activity. A guided activity provides a list of task steps and more general
information about the topic.

+ Preferences

New... \ Delete | Start [ Stop | Ripplestart ‘ ImmediateStop ]

g ¥
Szl
Select Name £ Status ¢

You can administer the following resources:

1 PortalCluster =

Total 1

In the following steps, you will enable Memory-to-Memory replication for the primary cluster
member.

Special note on Memory-to-Memory (M2M) replication: M2M replication takes session
data from one Portal sever and copies it to another Portal server. This is useful in situations
where one Portal server catastrophically fails. Failover to an additional Portal server in the
cluster can occur with no disruption for the end user. The user's session data will be retained.
M2M's disadvantage is the additional overhead needed to store and replicate the session data
across all cluster members.

Suppose you have a two server cluster without M2M enabled. Each server utilizes 1GB of
memory to store session data. With M2M enabled, each server would now consume 2GB of
session data. In a ten server cluster, assuming similar scaling, it would be 10GB of session data.
Similar scaling with CPU would be needed to ensure replication of data could occur, which is
necessary for successful failover.
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HCL ® has generally found that most Portal environments can safely enable M2M replication.
For larger scale Portal deployments M2M does not scale and alternatives are recommended.
Replication domains, session databases and WebSphere Extreme Scale caching are three
examples of many alternatives that may perform better for scaling purposes. Open a case with
HCL ® software support to discuss details of options available if you have a larger-scale Portal
environment.

17. While logged in to the dmgr, navigate to Servers — Server Types — WebSphere application
servers — WebSphere Portal — Session Management — Distributed Environment Settings.

Application servers > WebSphere_Portal

Use this page to configure an application server. An application server is a server that provides services required to run enterprise applications.

Runtime Configuration Reports Operations

General Properties

Container Settings
Session management

[# SIP Container Settings

Name

|1‘;‘9b5phere_?ortal |

Node name i . .

# Web Container Settings
[Nodeo1 | :

# Portlet Container Settings
I._.‘ Run in development mode @ EIB Container Settings
.__‘ﬂ parallel start # Container Services

i H Business Process Services
L] sStart components as needed

Access to internal server classes Applications

Allow :
Installed applications

Application servers > WebSphere Portal > i g

Use this page to configure session manager properties to control the behavior of Hypertext Transfer Protocol (HTTP) session support. These settings apply to
both the SIP container and the web container.

Configuration

General Properties

Additional Properties

Session tracking mechanism: Custom properties
Enable SSL ID tracking Distributed environment settings

v Enable cookies

Enable URL rewriting

18. Click the blue link for Memory-to-memory replication.

19. In the Replication Domain drop-down menu, select your cluster (e.g. PortalCluster).
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20. In the Replication Mode drop-down menu, select Both client and server.

Use this page to configure memory-to-memory replication for failure recovery.

Configuration .

General Properties

Replication domain
| PortalCluster El

Replication mode
| Both client and server El

| Apply | OK | Reset | Cancel |

21. Click OK and Save all changes.

22. Back on the Session management page (which you should see after saving the changes), click
Custom Properties.

Configuration

General Properties Additional Properties

Session tracking mechanism: Custom properties

al " .
"] Enable SSL ID tracking Distributed snvironment settings

Enable cookies

[ Enable urL rewriting

23. Create a new custom property by clicking New.

__ New... | Delete
b | [
(Slealc
Select Name = | Value 3 Description
None

Total 0
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24. For the Name, type in “Uselnvalidatedld” and for the Value, type in “false”

Configuration

General Properties

+ Name
|l_JseInvaHdatedId

#* Value
|false

Description

Apply| OK| Reset Cancel

25. Click OK and save the changes.
26. Restart the DMGR, NodeAgent, and WebSphere Portal server.
27. Verify Portal is functional by accessing it in your web browser:

http://myprimaryportal.hcl.com:10039/wps/portal

At this point you have successfully completed building a one-node cluster using the out of the box
security configuration. In the remaining sections, you will configure the Portal cluster with a
federated LDAP and add an additional horizontal node to the cluster.
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Chapter 5 — Configuring the Portal Cluster for
Federated LDAP Security

This section covers adding a federated LDAP Server to the cluster's security configuration. For
more details about LDAP/Security configuration, refer to the product documentation:

https://help.hcltechsw.com/digital-experience/9.5/config/cw_ldap.html?

NOTE:

The screenshots in this chapter are taken from a Portal system with cumulative fix 17 installed. If your
installation has a different cumulative fix level, your Config Wizard options and screens could differ
slightly from those shown in this guide.

If you have user ID's stored in your LDAP that are the same as your Portal or WAS administrator
ID's, or if you have a preexisting LDAP group named wpsadmins, either of these conditions will
cause a failure while executing the steps in this chapter. See Appendix D2 if this condition applies
to you and before executing the steps in this chapter.

This guide uses an IBM ® Directory Server LDAP server to configure security in the cluster. Your
LDAP server may be different. Review the following Portal and LDAP Integration guide, especially if
this is your first time configuring Portal with an LDAP server.

https://manualzz.com/doc/35945197/guide-to-integrating-websphere-portal-v8.5-with-ldap

The guide is applicable to both HCL ® Portal v8.5, v9.0 and v9.5. The guide will help you identify the
configuration values needed for this section.
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1. Open the Configuration Wizard (Config Wizard) in a web browser
http://myprimaryportal.hcl.com:10200/hcl/wizard

2. Click Set Up a Cluster>Enable Federated Security.

Hisme | Sl Up & Clusher

Set Up a Cluster

Saf up either & dynamic o stalic chuster to use for production sies. For guidance, See Roadmaps for chsters. Learn Mors

=3 DATABASE TRANSFER
Select this option (o transfer data from Apache Derby ta any of the database types
that are supparted by Dagital Exparience Portal

=3 CHMEATE A DESLOVIENT MARAGEN
Create a deployment manager profile that is sugmanted with Digital Experence
Portal resourcoes

= CHEATE A CLLISTER
After you create thie deployment manager, croalo a stalic ar dynamic chuster that
cantains the primary node

<3 CHABLE FEDERATED SECUMITY
Add an LDAP wser regatry to the default feterated repostory 1o store user account

infgrmation for authorization,
—~

3. Specify your target operating system, primary Portal profile name, and path to the primary
Portal profile.

Sysiem niwmatom Secury Semngs
Twron! cowratng Syt T
Tarpet portal profie nasne wp,_prtls
Taxmpin wp_piofie
Tatgel pectal piofite horma drecory el LA pne e s
Click the right arrow.
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4. Specify the following values:
» User registry software: Your LDAP software type; IBM Directory Server for this guide.
* Do you need SSL between the portal server and the user registry: No for this guide.

* Can portal update entries in your LDAP registry: Yes if Portal is used for user
registration or similar information creation/updates. No if Portal will use your LDAP
data as read only. Yes for this guide.

* Use Administrator ID's stored in your LDAP user registry: Yes if you want your Portal
administrator credentials to be stored in your LDAP system. If this is a production
system, you MUST select Yes. No if you want to continue to use the Portal administrator
credentials stored in the Portal file system AND this is a non-production system. Yes for
this guide.

» Validate LDAP user registry entries: Choosing Yes and the configuration wizard will do
real-time value checks against the Idap server.

System Information Security Safiings
s —

Click the right arrow.
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5. Specify your PortalAdminID, PortalAdminPswd and PortalAdminPswd again. These values will
match those that were specified during the Portal installation. Do not input values for userIDs or
passwords in LDAP - those will be entered in a later step.

Exitting mmiimu Infarmation st Rigiuiry Informatian U Ragistry Cracentials Ditalleed Ut Registry Infersmtion
y
¢ WehSphere Appbe alion Serget adrremestisee I ﬂn\r!,jlr.mfl
Gpfere e |
- thivsiniwd (LTI
Portaldmini()
! dorpeEset asassass
peswEt asasess
Click the right arrow.

6. Enter a repository ID value. This is a descriptive label used to identify this LDAP in your Portal
configuration. Also specify your LDAP host name and LDAP port number. The default LDAP
port for most LDAP servers is port 389.

Extsting Administrator infarmation Usar Regestry nformation Usar Ragisiry Credentials Detailod User Registry information

—_— &

"LOAP Repository 10 WyPariL DAP

E le: myld apid
Dart myidag hel.com
YOUrnast. yOurce.com
*LDAP port 348
Click the right arrow

7. Enter the Bind DN and Bind password.

Existing Administrator information User Registry information User Registry Credentials Detalled User Registry information
.

cn=tool

Example: uid=wpsatmin,cn=users,dc =yourco,de=corm

Click the right arrow
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8. Enter the Base DN, Administrator group/user DN, LDAP Administrator password, default
parent for new groups created by Portal, and the default parent for entry type PersonAccount.

This guide followed the LDAP Integration Guide link at the beginning of this chapter to
determine appropriate values to enter. Consult with your LDAP administrator if you are
uncertain which values to use for your LDAP:

Euisting Administrator Information User Registry Infarmation User Registry Cradentials Datailed Usar Registry information
&
Advanced
Base [N deehicl DE=COM
Exaimpé. de=yuees de=gom
‘Adminesirator grop CH from LDAP cn=prtalimns th=grougs di=hel DE=COM ?

Exampe: ciemyNewAaminGIoy

{oips De=youro.0ceC0om

"Aaminsraior DN from LDAP N WASADMININLOAR cneysers doehct DC=COM I
EsaThe. =Ty ERACTIn C={sers doyourca descom

‘Asminairator passwoed from LDAP T

Diefault paren! ko group =0 ¢ =hicl DC=COM
gl Cr=grous de=pourco, de=com

Defau parend ke Pestadce inetsers de=hel DC=COM | i

ERaME £N=lsars = our getom

Click the right arrow.
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9. You will see the following screen

n

C o]

Tank

Okt B Bl o) i Dl Evpaimttl Fne sl bR motlyd e sal Saiesty.

Wiem Evep Comeang
Aun ey | = Fmp

\rldate your LOAF iaivar mitgn.
View Sty Commans

Fen'm | e S

£ we LDAF o emgatry b e wsating dadarated poadsry
Vi Etap Cooemand

FunSap | Skig Stip

Eaguw e o Farvar gk
Vies Gien Comamand

Hun Sy | - S Suap
Eapace tra soying Dyl g Baree g Wk Ch

Yaw Slap Comears
RefiSaas | Sam Smp

Lipaame e L3 TRGADTy aPE PP LS 3 OOEE R e
Www Stwp Corrmmand

Feit Saip | She Sp

FHETY O THE WY S 1PRY B Ty DR
Wipm Svpp Coreemand

Byn Siap | Fag Dap

Updlits tha sadres Sdmesklites cuar
Wem Bl Comeand

B Stey | Sag Swp

Gorver unr 3 oy W re e G o e yo LDAR e

Al s SR (R RSy el [N Y S 10 B L) Radie S gl sarvar

Wigs STRp Coemempng
Flen B | - Saig Bup

‘Yuedy Faf ol defred sirduies ew avalslbe 0 e cooligored LOAP sawr mgainy

Warw Frtp Commgnd
Fen Fap | Saw Bap

el Sinp Ustsin B emincF aarticdui poperies e vt Be vakes S0 your LOAP saeny

Imptrarmars fos Shap H
Uas Sias Comewa

Fiyn the maoer fam tor
Virw Bl © avvempet
Ran Suy | ‘S Sus

Bextar the Dagid Experancs Corial seriw
Vew Bt Corremarad

Fon Stap | Ship Sap

Upant Sp. Klag anri O Dtwwin Thpap Exparanoe Ponal 3o v LIAR slivir

Irortresstar Too Samp 14

Uars Sz Cormmie

Click Run Step for Steps 1 - 10
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10. On the Primary portal server, locate the file named““MemberFixerModule.properties” in

11.

following directory:
/opt/HCL/WebSphere/wp_profile/PortalServer/wem/shared/app/config/wemservices

Open the MemberFixerModule.properties file with a text editor. Add the following line, using the
full Distinguished Name for the WASAdminInLDAP userID. This guide added the following line:

uid=Portal AdminID,o=default WIMFileBasedRealm -> uid=WASADMINInLDAP,cn=users,dc=hcl, DC=COM

and save the changes to the file.
For more information on this step, click Instructions for Step 10 in the Config Wizard.

D B L R R R T e
ﬁ Member Fixer Module Configuration Properties

ﬁ This file can be configured to provide custom distinguished name (DN)

# mapping for the member fixer module.
ﬁ##############################################################################

Configure full replacement of one distinguished name with another

Example: To replace any instance of cn=groupl,dc=lotus,o=ibm with cn=group2,dc=rational,o=1ibm, use:
cn=groupl,dc=lotus,o=ibm -> cn=group2,dc=rational,o=ibm

uid=userl, ou=websphere,c=au,o=ibm -> uid=user2,ou=tivoli,c=au,o=1ibm
cn=groupl,dc=lotus,o=ibm -> cn=group2,dc=rational,o=ibm

Configure part replacement of a distinguished names. This will
change all of the distinguished name except the ID

Example: To replace all DNs like cn=[ID],dc=websphere,o=ibm with cn=[ID],dc=tivoli,o=1ibm, use:
cn=[ID],dc=websphere,o=ibm -> cn=[ID],dc=tivoli,o=ibm

uid=[ID], ou=websphere,c=au,o=ibm -> uid=user2,ou=tivoli,c=au,o=ibm
cn=[ID],dc=websphere,o=ibm -> cn=[ID],dc=tivoli,o=ibm
id=PortalAdminID, o=defaultWIMFileBasedRealm -> uid=WASADMINInLDAP,cn=users,dc=hcl,DC=COM

Click Run Step for Step 12. Click Run Step for Step 13.

& Run the mamber fiaes b
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12. NOTE: The final step ,Step 14, was skipped for this guide as no additional attribute mapping
was required. If you need to complete this step, Click “Instructions for Step 14" and follow the
provided steps. Otherwise Click Mark Step Complete.

I| Instructions for Step 14

1. Use a text editor to open the wkplc.properties file.
2. Enter a value for the following set of parameters in the wkplc.properties file to correct any issues that are found in the configuration trace file:

The following parameters are found in the LDAP attribute configuration validation heading:
« federated.ldap.attributes.nonSupported
« federated.ldap.attributes.nonSupported.delete
« federated.ldap.attributes.mapping.ldapName
« federated.ldap.attributes.mapping.portalName
« federated.ldap.attributes.mapping.entityTypes

The following values flag certificate and members as unsupported attributes and maps ibm-primaryEmail to mail and ibm-jobTitle to title for the PersonAccount
entityTypes:
ated.ldap.attributes.

ated.ldap. ibutes.

d.ldap.

FhoHh R by
L '
2.

m m m
oK KKK
w

ated.ldap.attributes.m
ted.ldap.attributes.mapping.entityTypes
If you want to map attributes for your groups instead of users, set the entityTypes to Group

federated.ldap.attributes.mapping.entityTypes=Group

w

Save your changes to the wkplc.properties file.

Run the following task to update the LDAP user registry configuration with the following items:
« Alist of unsupported attributes
« The correct mapping between WebSphere Portal and the LDAP user registry

=

ConfigEngine.sh wp-update-federated-ldap-attribute-config -DWlasPassword=password
Stop and restart the appropriate servers to propagate the changes. For specific instructions, go to Starting and stopping servers, deployment managers, and node agents.
Complete the following steps to flag an attribute as either unsupported or required for the entire WebSphere Portal environment instead of just for the specified LDAP:

1. Enter a value for the following required parameters in the wkplc.properties file:

@ o

« user.attributes.required
« user.attributes.nonsupported
Go to the properties file for specific information about the parameters.

2. Save your changes to the wkplc.properties file.
3. Run the following task

ConfigEngine.sh wp-update-attribute-config -DWasPassword=password
4. Stop and restart all necessary servers to propagate your changes.

13. On the Config Wizard, click Finish.

14. Verify that you can login to your dmgr with the WASAdminInLDAP and WASPswdInLDAP
https://mydmer.hcl.com:9043/ibm/console

15. Verify that you can log into the primary the WASAdminInLDAP and WASPswdInLDAP
http://myprimaryportal.hcl.com:10039/wps/portal

At this point, you have successfully built a single node cluster using a remote database and a
federated LDAP server.
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Chapter 6 — Installing HCL® Digital Experience v9.5
on an additional horizontal Node

Chapter Overview

This chapter will demonstrate how to install HCL® Digital Experience v9.5 on an additional
horizontal node. In this guide, the installation was completed with a graphical user interface
(GUI) using the root user with installation images on a local hard drive.

This chapter contains multiple sections each performing a specific action within the IBM ® Installation
Manager (IIM) tool. Ensure you complete each section as outlined before proceeding to the section.

Section 1 — Installing IBM ® Installation Manager

Section 2 — Installing HCL ® Portal (WebSphere Portal) v8.5 Binaries only

Section 3 — Upgrading HCL ® Portal (WebSphere Portal) v8.5 to Cumulative Fix (CF) 17 or a later
CF

Section 4 — Upgrading HCL ® Portal (WebSphere Portal) v8.5 CF17 or a later CF to HCL ® Portal
v9.5

Before installing HCL ® Portal v9.5, ensure you review the planning documentation:

https://help.hcltechsw.com/digital-experience/9.5/config/cw_add node.html?

NOTE: Many of the steps in this chapter will repeat steps executed in Chapter 1 - Installing HCL ®
Portal v8.5 on the Primary Node. There are critical steps which are applicable only to the additional
horizontal node. Hence a separate chapter was created for this guide.
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Section 1 - Installing IBM ® Installation Manager

1. Open a terminal window on your additional horizontal Portal node and run:
ping mysecondaryportal.ibm.com
where mysecondaryportal.ibm.com is your fully qualified hostname.

2. In the same terminal window,run:
ping localhost
to verify that the localhost settings are properly configured on your server.

3. Linux/UNIX environments only: Ensure ulimit is set to 10240 or higher by
running: ulimit -n 10240
in the command line.

4. Unzip all .zip files provided with your Portal media into a single folder. This folder will be
referred to as the installationMediaRoot folder.

For this guide the following directory is used for the installationMediaRoot folder:
/opt/portalBinaries/SETUP/products

opt portalBinaries = SETUP ) Q | i=

1M launchpad products quickstart sample-
responsefiles

¢ @

setup.sh setupb4.exe setup6d.ini WPS0.setup.id WPS0_Enable.
id
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5. From the HCL ® Portal v95 SETUP directory, navigate to:
SETUP/IIM/yourEnvironment
and run

J/install

where yourEnvironment is the folder that best describes the operating system of the environment

in which you are installing HCL ® Portal. For this guide the following is used:

installationMediaRoot/SETUP/IIM/linux_x86 64

The following window will appear:

IBM Installation Manager

Install Packages

Select packages to install: ::;

Installation Packages

Status Vendor License Key 1
E% # IBM® installation Manager

(w6, Version 1.8.5 Will be installed IBM No key requir

6. Click Next.

7. Accept the license agreement and click Next.

The IPLA will automatically apply if Licensee elects to retain the Program after the Evaluation (or obtain additional copies of the P

for use after the Evaluation) by entering into a procurement agreement (e.g., the IBM International Passport Advantage or the IBI
Passport Advantage Express agreements).

®) | accept the terms in the license agreement

_) | do not accept the terms in the license agreement

< Back Next > Install
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8. Choose a directory in which to install IIM. This guide uses:
/opt/IBM/InstallationManager/eclipse
for Windows this guide recommends:
c:\IBM\InstallationManager\eclipse
NOTE: In Windows environments, the default location will likely be

C:\Program Files\IBM\InstallationManager. Spaces in the file path can cause problems later
in the installation/Configuration of Portal. It is good practice to create a folder called “IBM”

at C:\IBM or a similar location into which [IM and HCL ® Portal can be installed.
9. Click Next.

10. On the Summary screen, click Install to begin the installation.

11. When the installation is complete, click Restart Installation Manager.

12. The following screen will appear:

IBM Installation Manager 2 o x

File Help

IBM Installation Manager

. j Install

== Install software packages.

Update

7 Discover and install updates 44— Manage Licenses
g and fixes to installed
software packages.

Modify

=
P"_{Zi) Change installed software
N packages by adding or <& Uninstall
&= removing features and =

Roll Back

functions.

At the end of this section, you have successfully installed IBM ® Installation Manager1.8.5.
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Section 2 - Installing HCL ® Portal (WebSphere Portal) v8.5 Binaries only

This section will cover the installation of HCL ® Portal v8.5. HCL ® Portal v8.5 must be installed

and thereafter upgraded to HCL ® Portal v9.5. It is not possible to install HCL Portal ® v9.5
directly.

1. InIIM, click File > Preferences > Repositories
2. Click Add Repository, navigate to
installationMediaRoot/WP85_Enable/repository.config

and click OK.

3. Repeat step 2 for the following repositories:

installationMediaRoot/WP85 _Server/repository.config
installationMediaRoot/W ASND90/repository.config
installationMediaRoot/JDK803/repository.config
installationMediaRoot/TFP159896/8.5.0.0-WP-Server-P159896.zip

Repositories b v D v w

Repositories:

Location Connecti
|¥ Jopt/portalBinaries/SETUP/products/WP85_Enable/repository.config
[+ /opt/portalBinaries/SETUP/products/WP85_Server/repository.config
|# Jopt/portalBinaries/SETUP/products/WASNDS0/repository.config
|¥ /opt/portalBinaries/SETUP/products/JDK803/repository.config

Add Repository...
Edit Repository...

Remove Repository
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L% /opt/portalBinaries/SETUP/products/IFPI59896/8.5.0.0-WP-Server-IFPIS9896.zip e Move Up

Test Connections

Service repositories are remote locations where updates or extensions to packages (including the Installation Manager itself) are
stored.

+ Search service repositories during installation and updates.
Restore Defaults Apply

Cancel OK
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Ensure that all the repositories you just added are selected (i.e. there is a check mark in the
box next to them) and click Apply then OK.

Back on the IIM Home Screen, click Install.

IBM Installation Manager - & x

File Help

IBM Installation Manager

f@ﬁ] ) Install
N &8 J  |nstall software packages.

Update

Discover and install updates ul—.J Manage Licenses
and fixes to installed
software packages.

Modify
Change installed software

packages by adding or (i | Uninstall
removing features and —
functions.

Check the boxes to install IBM WebSphere Application Server Network Deployment, IBM
WebSphere Portal Server, and IBM WebSphere Portal Enable (or the offering you are
installing, e.g. Extend, Express, etc.). IBM SDK, Java Technology Edition, Version 8 package
should not be elected as it is will be automatically installed with the IBM WebSphere
Application Server Network Deployment package.

(@ 18M Installation Manager (Skip Install, Recording..) @webserverhcl.com = X
Install Packages =
Select packages to install:

Q type filter text 2 4 packages are selected. B
Installation Packages Status Venc lor License Key Type
~ (¥ 1) 1BM WebSphere Application Server Network Deployment
V[, Version 9.0.5.0 will be installed 18M
v [¥([%18M SDK, Java Technology Edition, Version 8
¥ [¥Version 8.0.5.35 Will be installed 18M
w |¥ [ 1BM WebSphere Portal Server
W[, Version 8.5.0.0 Will be installed 1BM
~ @ % 1BM SDK, Java Technology Edition, Version 8
[ version 8.0.5.35 1BM
v (W1%18M Websphere Portal Enable
X} Version 8.5.0.0 Will be installed 1BM
[ show all versions Check for Other Versions, Fixes, and Extensions
Details

IBM SDK, Java Technology Edition, Version 8 8.0.5.35

IBM SDK, Java Technology Edition, Version 8 provides a full-function Java software development kit (SDK) that is compliant with Oracle Java Platform, Standard Edition (Java SE) 8 application programming interfaces (APIs).
With I1BM SDK, Java Technology Edition you can develop, test, and deploy applications at the Java 8 API level. The SDK contains the runtime environment, which allows users to run Java applications, as well as additional
developer tools for creating Java applications. More info...

P v: I rtal9.5/SETUP/products/)DK80S

0] 8 Next > Cancel

Click Next.
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8.  Select the iFix IFP159896 and click Next

3 1BM Installation Manager (Skip Install, Recording..) @webserverhcl.com

Install Packages

Select the fixes to install. ‘:ﬂ

Q type filter text b4 k34
Fixes Recommended Vendor Status
~ (% 1 1BM WebSphere Portal Server 8. 1BM

¥8:s.0

-Server-IFPI59896 8.5.0.20161201_1732

Check for Other Fixes
Details

IBM WebSphere Portal Server 8.5.0.0

BM® WebSphere® Portal Server provides a single access pomt to web content and while delivering dif d, lized for each user. here Portal supports workflows, content
d usability and tools and Web 2.0, open dards, security, and scalability. These bilities provide an | web to help you become a social
business. More info.
 Repository: /SETU _Server
@ < Back Next > stal Cancel

9. Accept license agreement and click Next

@ 1BM Installation Manager (Skip Install, Recording..) @webserverhcl.com

Install Packages

Read the following license agreements carefully. ﬂ
install [ Licenses ) Location Features Summary

~ IBM WebSphere Application Server Network Deployment IMPORTANT: READ CAREFULLY

Software License Agreement

 1BM WebSphere Portal Enable

1BM WebSphere Portal Enable 1.18M ional License for Evaluation of Programs
2.1BM International Program License Agreement
w IBM WebSphere Portal Server

IBM WebSphere Portal Server

Two license agreements are presented below.

If Licensee is obtaining the Program for purposes of productive use (other than evaluation, testing, trial "try or buy," or demonstration): By clicking on the
“"Accept” button below, Licensee accepts the IBM International Program License Agreement, without modification.

If Licensee is obtaining the Program for the purpose of evaluation, testing, trial “try or buy, ord ion (collectively, an ion"): By clicking on the
"Accept* button below, Licensee accepts both (i) the 1BM License of Programs (the "Evaluation License®), without
modification; and (ii) the IBM International Program License Agreement (the "IPLA"), w:rhnut moduﬁcanon

The Evaluation License will apply during the term of Licensee's Evaluation.

The IPLA will automatically apply if Licensee elects to retain the Program after the Evaluation (or obtain additional copies of the Program for use after the
Evaluation) by entering into a procurement agreement (e.g.. the IBM Intenational Passport Advantage or the IBM Passport Advantage Express agreements).

The Evaluation License and the IPLA are not in effect concurrently; neither modifies the other; and each is independent of the other.

The complete text of each of these two license agreements follow.

LICENSE INFORMATION

The Programs listed below are licensed under the following License Information terms and conditions in addition to the Program license terms previously
agreed to by Client and IBM. If Client does not have previously agreed to license terms in effect for the Program, the International License Agreement for
of Programs (2125-5543-05) applies.

Proaram Name (Proaram Number):
®) | accept the terms in the license agreements

print All...
1 do not accept the terms in the license agreements

< Back Next > 1stal Cancel

10. Select a location for the IIM Shared Resources Directory. This guide uses:
/opt/HCL/WebSphere/IMShared

for Windows this guide recommends:
c¢:\HCL\WebSphere\IMShared
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Install Packages
Select a location for the shared resources directory.

inestall Lcenses | | LocaBionl Features Summary

When you install packages, files are stored in two locations:

1) The shared resources directory - resources that can be shared by multiple packages.
jf 2| The installation directory - any resources that are unique to the package that you are installing.

important: You can only select the shared resources directory the first time you install a package with the IBM

Installation Manager. For best results select the drive with the most available space because it must have adequate
space for the shared resources of future packages,

Shared Resources Directory: [ joptHCUwebSphereiMshared I  Browse...
Disk Space Information
volume  Available Space
I 23.06 GB
® looshade, | Mest> instal Cancel
Click Next.
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11. Click IBM WebSphere Application Server to set the WAS installation location.
This guide uses:

/opt/IBM/WebSphere/AppServer
for Windows this guide recommends:

C:\IBM\WebSphere\AppServer

Install Packages
The packages will be installed into the indicated package groups. Select the package group to change the instaliation directory.

Instail Licenses :mﬁ Features Summarny
Package Group Name Installation Directory Architectur:
- 1BM Web5Sphere Application Server V9.0 JopHCEWebSphere/AppServer
([} IBM WebSphere Application Server Network Deployment
(& IBM SDK, Java Technology Edition, Version 8 8.0.5.35 .
= %, IBM WebSphere Portal Server V8.5 foptfBMMAWebS phere/PortalSenver 64-bit

= [l IBM WebSphere Portal Server 8.5.0.0
% 8.5.0.0-WP-Senver-IFPIS9E06 8.5.0.20161201 1732

Package Group Name: [BM WebSphere Application Server V9.0

Instaliation Directory:  fopt/HCLWebSphere/AppServer Brc

Architecture Selection: (' 32-bit (=) 64-bit

Details Disk Space Information

Shared Resources Directory: fopt/HCUWebSphere/iMShared L Space

i gy i 23.08 GB /
Click Next.
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12. Click IBM WebSphere Portal Server V8.5 to set the Portal Server installation directory:

/opt/HCL/WebSphere/PortalServer
for Windows this guide recommends:

C:\HCL\WebSphere\PortalServer

(2 18M Installation Manager (Skip Install, Recording..) @webserverhcl.com
Install Packages
The packages will be installed into the indicated package groups. Select the package group to change the installation directory.

Instal Licenses [ tocation ) Features Summary

Package Group Name installation Directory Architecture
w %, 1BM WebSphere Application Server v9.0 Jopt/HCL/WebSphere/AppServer 64-bit
0 18M h server Network Deploy 9.0.5.0

[41BM SDK, Java Technology Edition, Version 8 8.0.5.35
-.1BM WebSphere Portal Server V8.5

Jopt/HCL/WebSphere/PortalServer 64-bit
w [[J 1BM WebSphere Portal Server 8.5.0.0

[18.5.0.0-WP-Server-IFPIS9896 8.5.0.20161201_1732
(%y18M Websphere Portal Enable 8.5.0.0

Package Group Name: IBM WebSphere Portal Server v8.5

Installation Directory: | /opt/HCL/WebSphere/PortalServerf

Browse...
Architecture Selection: 2-bit (o) 64-bit
Details Disk Space Information
Shared Resources Directory: fopt/HCL/IMShared Volume  Available Space
/ 20.14G8
@ < Back Next > Cancel

Click Next.
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13. Select any additional language translations your environment requires.
Only English was selected for this guide. Click Next.

Install Packages

Select the translations to install.

Install Licenses Location | Features Summary

Select the translations for the packages that will be installed to package group IBM WebSphere Portal Server V8.5, IBM WebSphere Application
Server V9.0.

mn

Translations Supported by All Packages

# English

. Transl.atlonsSu I edby OnlySomaPackages

_| Brazilian Portuguese |_| Czech | French | German || Hungarian
|| Italian |_| Japanese | Korean __| Polish [ Romanian
[} Russian || Simplified Chinese |_| Spanish | Traditional Chinese

Select All  Clear

@

< Back Next > install . can
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14. Review the features to install for both WebSphere Application Server and WebSphere Portal.
UNCHECK the box for WebSphere Portal profile.

NOTE: Do not de-select any WebSphere Application Server features. Ensure you do not install a
WebSphere Portal profile. You will copy over profile information from the primary Portal server

and create a profile for this server in a later step.

@ 1M Installation Manager (Skip Install, Recording..) @webserver.hcl.com

Install Packages CE

Select the features to install.

License: Location Features )

[ 1BM Websphere Application Server Network Deployment 9.0.5.0
¥ E)BDeploy tool for pre-EJB 3.0 modules
» (¥ Stand-alone thin clients, resource adapters and embeddable containers

| sample applications
(V& 18M SDK, Java Technology Edition, Version ).5

| Portal Server Profile
(@@ 18M webSphere Portal Enable 8.5.0.0

_] show dependencies Expand All | Collapse All | | Restore Default

- Selected by Installation Manager because of dependencies

Details

IBM WebSphere Portal Server 8.5.0.0

1BM® WebSphere® Portal Server provides a single access point to web content and applications, while 9 . p lized experiences for each user. WebSphere Portal supports workflows, content
usability and tools and Web 2.0, open standards, security, and scalability. These capabilities provide an exceptional web experience to help you become a social business.

Disk Space Information

Disk space information is not available.

< Back Next > ! Cancel

Click Next
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15. Set the Configuration Wizard (Config Wizard) username and password. You can set these
to any values you want to use for the Config Wizard credentials. “ConfigWizardID” is used for

this guide.

(@ 18M Installation Manager (Skip Install, Recording..) @webserverhcl.com - o X
Install Packages 1
.
@ click Next to continue.
Features )
v [0 1BM WebSphere Portal sen C: ion for IBM Portal Server 8.5.0.0
YT Enter the Administrator user ID and password for the Configuration Wizard.
Configuration Wizard Credentials
This ID is used only to log in to the Configuration Wizard and can be different from the Portal administrative ID.
Administrator user ID
ConfigAdminiD
sword
r pas: i
Cancel

< Back Next >

Click Next.
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16. Review your installation selections and click Install.

@ 1BM Installation Manager (Skip Install, Recording..) @webserverhcl.com

Install Packages ﬂ

Review the summary information.

Instal Licenses Location Features Summary )

Target Location

Shared Resources Directory: /opt/HCL/IMShared

Packages
Packages installation Directory
%, 1BM WebSphere Application Server v9.0 Jopt/HCL/WebSphere/AppServer

w ([ 18BM WebSphere Application Server Network Deployn

- EJBDeploy tool for pre-EJB 3.0 modules
» [, Stand-alone thin clients, resource adapters and er
[%1BM SDK, Java Technology Edition, Version 8 8.0.5.35
IBM WebSphere Portal Server V8.5 Jopt/HCL/WebSphere/PortalServer
w () 1BM WebSphere Portal Server 8.5.0.0

([18.5.0.0-WP-Server-IFPI59896 8.5.0.20161201_1732
[%18M Websphere Portal Enable 8.5.0.0

Environment Disk Space Information
Total Available Space

English
! 20.15GB

l Total Download Size: | 0.0 KB

Total Installation Size: | 0.0 KB

» Repository Information

< Back Next > Install Cancel

NOTE: The installation will take 30-60 minutes; don't be concerned if the Installation Manager
seems to be stuck on one task for several minutes
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17. When the installation is finished, select None for Which program do you want to start?
and click Finish.

@ 1BM Installation Manager (Skip Install, Recording..) @webserver.hcl.com - o X

e

Install Packages

u The packages are installed. View Log File

The following packages were installed:

v %,1BM WebSphere Application Server v9.0
1BM WebSphere Application Server Network Deployment 9.0.5.0
%51BM SDK, Java Technology Edition, Version 8 8.0.5.35
w %, IBM WebSphere Portal Server v8.5
~ [ 1BM Websphere Portal Server 8.5.0.0
18.5.0.0-WP-Server-IFPIS9896 8.5.0.20161201_1732
[1BM WebSphere Portal Enable 8.5.0.0

Note: If the packages support rollback, the temporary directory contains rollback files for installed packages. You can delete the files on the Files for rollback preference page.

2 Finish

NOTE: There is not yet a profile on this system. Therefore, you cannot access this Portal in a
web browser at this time. You can access the Config Wizard on the additional horizontal node.
You will use the Config Wizard in the next chapter to create a profile on the additional horizontal
node. Complete all sections of this chapter first before proceeding to the next chapter.

At this point, you have successfully installed HCL® Portal (IBM® WebSphere Portal) v8.5 with
IBM® WebSphere Application Server v9.0.5.0 binaries on an additional horizontal node.
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Section 3 — Upgrading HCL® Portal (WebSphere Portal) v8.5 to Cumulative Fix
(CF)

HCL® Portal v8.5 now needs to be upgraded to Cumulative Fix 17 or a later CF to support the
installation of HCL® Portal v9.5. You will need to stop the Configuration Wizard to proceed with the
upgrade.

1. Navigate to the location you installed WebSphere Application Server. Continue in the
directory structure to the /profiles/cw_profile/bin subdirectory. This guide uses the following
directory for the full path:

/opt/IBM/WebSphere/AppServer/cw_profile/bin

2. Execute the following command:
JstopServer.sh serverl -user ConfigWizardID -password ConfigWizardPswd

3. You will be prompted for a userID and password.
Enter your ConfigWizardID for the userID and ConfigWizardPswd for the password.

[root@ /1# cd /fopt/IBM/WebSphere/AppServer/profiles/cw profile/bin/

[root@ bin]# ./stopServer.sh serverl

ADMUB116I: Tool information is being logged in file
/opt/IBM/WebSphere/AppServer/profiles/cw profile/logs/serverl/stopSer

ver.log

ADMUB128I: Starting tool with the cw profile profile

ADMU3160I: Reading configuration for server: serverl

! Login at the Target Server X

Enter login information for =default>

Realm/Cell Name

User Identity |ConfigwizardD |

User Password iwwwwwwww !

| oK || Cancel

4.  Return to IBM® Installation Manager. Click File > Preferences > Repositories.
5. Select each of the existing Repositories and Click Remove Repository.
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6. Click Add Repository, navigate to:
installationMediaRoot/SETUP/products/WP8500CF 17 _Server/repository.config

Click OK twice.

7.  In IBM® Installation Manager, click the Update icon:

IBM Installation Manager

File Help

IBM Installation Manager

S ) Install

= /' Install software packages.

Update

Discover and install updates Ll—|_.,u( Manage Licenses
and fixes to installed
software packages.

Modify

Change installed software
packages by adding or \E ! Uninstall

removing features and
functions.

[} Roll Back
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8.  Select the IBM WebSphere Portal Server 8.5 package.

Update Packages

Select a package group to find updates for

/ 7
[ -

's, IBM WebSphere Application Server V3.0 fopt/IBM\WebSphere/AppServer

. IBM WebSphere Portal Server VB.S foptIBMMWebSphere PortalServer

Update 3ll packages with recommended updates and recommended fixes

9.  Click Next to proceed with the Version 8.5.0.0 CF17 package.

10. Click Next to proceed beyond the Validation Results.

NOTE: HCL highly recommends that you backup of your entire Portal architecture when installing a
cumulative fix on an established Portal system. Backups will be covered in more detail in Appendix
As the system in this guide represents a brand new system, a backup is not required at this time.

11. Click the radio icon for “I accept the terms in the license agreement”. Click Next.

12. Click Next to Accept the terms of the licensing agreement.

13. Click Next to Install the IBM WebSphere Portal CF17 feature.

14. Click Update. This step will take approximately 20-30 minutes to execute.

15. Click Finish.

NOTE: The applyCF.sh command to update the <wp_profile> cannot be run at this time as a profile

does not exist on the additional horizontal node at this time. The next chapter will guide you through
creating a profile on the additional horizontal node.

At the end of this section, you have successfully installed Cumulative Fix 17 for HCL® Portal 8.5 on
IBM® WebSphere Application Server v9.0.0.2.
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Section 4 — Upgrading HCL® Portal (WebSphere Portal) v8.5 CF17 to HCL®
Portal v9.5

In this final section HCL® Portal v8.5 CF17 will be upgraded to HCL® Portal v9.5. You will need
to stop the Configuration Wizard to proceed with the upgrade.

1. Navigate to the location you installed IBM® WebSphere Application Server. Continue in
the directory structure to the /profiles/cw_profile/bin subdirectory. This guide uses the
following directory for the full path:

/opt/HCL/WebSphere/AppServer/cw_profile/bin

2. Execute the following command:
JstopServer.sh serverl

3. You will be prompted for a userID and password. Enter your ConfigWizardID for the userID
and ConfigWizardPswd for the password.

[root@myprimaryportal /l# cd /opt/HCL/WebSphere/AppServer/profiles/cw profile/bin

[root@myprimaryportal bin]# ./stopServer.sh serverl

ADMUB116I: Tool information is being logged in file
/opt/HCL/WebSphere/AppServer/profiles/cw profile/logs/serverl/stopServer.log

ADMUO128I: Starting tool with the cw profile profile

ADMU3100I: Reading configuration for server: serverl

| Login at the Target Server@myprimaryportalhcl... X
Enter login information for <default=
Realm/Cell Name

User Identity ConfigWizardID

User Password  |+xoccay

0K Cancel

4.  Return to IBM ® Installation Manager. Click File > Preferences > Repositories.

5. Select each of the existing Repositories and Click Remove Repository.

6. Click Add Repository, navigate to:
installationMediaRoot/SETUP/products/WP95_Portal/repository.config

Click OK.

7. Click Add Repository, navigate to:
installationMediaRoot/SETUP/products/WP95 Enable/repository.config
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@ Preferences @mysecondaryportal.hcl.com e
type filter text @ | Repositories G v D v w
T —
—
Appearance
Location Connection | i |
Files for Rollback — . 2 | Add Repository... |
b Help '+ Jopt/portalfiles/Portal9.5/SETUP/products/WP95_Enable/re; . - =
opt/portalfiles/Portal9.5/SETUP/products/WP95 Serverjre| 1. i itory... |
b et — e .
Passport Advantage Remove Repository |
Secure Storage
Updates Move Up I
Move Down
Clear Credentials
Test Connections |
Service repositories are remote locations where updates or extensions to packages (including the
Installation Manager itself) are stored.
[# Search service repositories during installation and updates.
Restore Defaults Apply
@ cancel oK
Click OK twice.
8. In IBM® Installation Manager, click the Install icon:
IBM Installation Manager - o X

File Help

1BM Installation Manager

Install
Install software packages.

Update

Discover and install updates
and fixes to installed
software packages.

Modify

Change installed software
packages by adding or
removing features and
functions.

“1;; J Manage Licenses

@l Roll Back

ﬂ Uninstall
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9.  Check the boxes to install the HCL Portal Server and HCL Portal Enable (or the offering you
are installing, e.g. Extend, Express, etc.) packages.

@ IBM Installation Manager @mysecondaryportal.hcl.com — | et
Install Packages
Select packages to install:
Installation Packages Status Vendor
v | HCL Portal Server
(W [%) Version 9.5.0.0 will be installed  HCL
€% B HCL Portal Enable
W2 Version 9.5.0.0 will be installed  HCL
[ | show all versions Check for Other Versions, Fi;
Details
HCL Portal Enable 9.5.0.0
HCL Portal Enable helps increase efficiency and accuracy of website deployments. It places cor
the hands of content experts to create, maintain, and deliver online content while IT retains co
Enable delivers the right information to the right audience It includes rich text editing tools, we
templates, and personalization services to build rich websites. These websites can deliver high
dynamic content te customers, business partners, and employees in more relevant ways. More
¢ Repository: jopt/portalfiles/Portal9.5/SETUP/products/WP95_Enable
_—
@ Back Next > Insta Cancel

Click Next
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10.  Accept terms of licensing agreement. Click Next.

@ IBM Installation Manager @mysecondaryportal.hcl.com — | et

Install Packages

Read the following license agreements carefully.

Install | Licenses > Location Features Summary
v HCL Portal Enable vos Program Name: HCL Portal Enable v9.5
r : -
HCL Portal Enable v95 Program Number: S724-E78
¥ HCL Portal Server v95 As described in the HCL Master License Agreement, and

HCL Portal Server vos  this License Information, HCL grants Licensee a limited
right to use the Program. This right is limited to the level
of Authorized Use, such as a Processor Value Unit ("PVU"),
a Resource Value Unit (*RvU*), a Value Unit (*vU*), or
other specified level of use, paid for by Licensee as
evidenced in the Proof of Entitlement. Licensee's use
may also be limited to a specified machine, or only as a
Supporting Program, or subject to other restrictions. As
Licensee has not paid for all of the economic value of the
Program, no other use is permitted without the payment
of additional fees. In addition, Licensee is not authorized
to use the Program to provide commercial IT services to
any third party, to provide commercial hosting or
timesharing, or to sublicense, rent, or lease the Program
unless expressly provided for in the applicable
agreements under which Licensee obtains authorizations
to use the Program. Additional rights may be available to
Licensee subject to the payment of additional fees or
under different or supplementary terms. HCL reserves the
right to determine whether to make such additional rights
available to Licensee.

Program's specifications can be found in the collective
Description and Technical Information sections of the

[ . W P J U W T ¥ S—

(¢ | accept the terms in the license agreements print All...

I do not accept the terms in the license agreements

@ < Back Next > Insta Cancel
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11.

Select the option Use the existing package group and click on IBM WebSphere Portal v8.5.

@ IBM Installation Manager @mysecondaryportal.hcl.com i | et

Install Packages
A package group is a location that contains one or more packages. Extensions can be

installed into a. common package group only and will share a common user interface.
Select an existing package group for the extensions.

Install Licenses | Location ) Features summary

®) Use the existing package group

Creale a new pack age group
Package Group Name Installation Directory Architectu
-, IBM WebSphere Portal Server V8.5 fopt/HCL/WebSphere/PortalServer 64-bit
% IBM Security Directory Server fopt/ibm/ldap/v6.4 64-bit
%, IBM WebSphere Application Serve jopt/HCL/WebSphere/AppServer 64-bit

Package Group Name: IBM WebSphere Portal Server v8.5

Installation Directory: jopt/HCL/WebSphere/PortalServer Browse..
Architecture Selection: 32-bit (@) 64-bit
Details Disk Space Information

Shared Resources Directory: /opt/IBM/IBMIMShared volime Mwailable Space

Installed Packages

/ 5.94 GB
* |BM WebSphere Portal Server CF17 for v8.5 and
v9.0
e IBM WebSphere Portal Enable 8.5.0.0
@ < Back Next > Install Cancel

Click Next
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12.  Enter your PortalAdminID and PortalAdminPswd for the Websphere Application Server
credentials. Scroll down. Enter your PortalAdminID and PortalAdminPswd for the Portal
Server credentials.

@ 1BM Installation Manager @mysecondaryportal.hcl.com == X
Install Packages
@ credentials verified. Click Next to continue.

nstal Licenses Location | Features 7> Summary
~ [ HCL Portal Server 9.5.0.0 Configuration for HCL Portal Server 9.5.0.0
E LY Application Server and Portal Server Credentials
Enter the administrator user ID and password for the WebSphere Application Server and the HCL Portal Server.

The IBM Installation Manager uses these values to update the profile.

WebSphere Application Server
Administrator ID:
PortalAdminiD|

Password:

........

........

HCL Portal Server
Administrator ID:
PortalAdminiD
Password:

...... -
Confirm Password:

xxxxxxxx

Validate Credentials

@ < Back Next > stal Cancel

13. Click Validate Credentials

HCL Portal Server
Administrator ID:

PortalAdminID

Password:

R AR

Confirm Password:

mt**mt*ﬂ

Validate Credentials

__| Check here to continue without validating credentials

Wait a few minutes for validation to complete. Click Next.
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14. Review Summary. Select Install.

@) 1BM Installation Manager @mysecondaryportal.hcl.com

Install Packages
Review the summary information.
License: Location ature:

[ summary
Target Location

Package Group Name: IBM WebSphere Portal Server v8.5

Installation Directory: Jopt/HCL/WebSphere/PortalServer

Shared Resources Directory: /opt/IBM/IBMIMShared
Packages
Packages
[ HCL Portal Server 9.5.0.0
[ HCL Portal Enable 9.5.0.0

Environment
English

Disk Space Information
I

Total Download Size:  828.2 KB

Total Installation Size: 3.73 MB
» Repository Information

When the installation is finished, you should see:

0 IBM Installation Manager @mysecondaryportal.hcl.com

Install Packages

o The packages are installed. View Log File

The following packages were installed:

« %, IBM WebSphere Portal Server V8.5
[l HCL Portal Server 9.5.0.0
(& HCL Portal Enable 9.5.0.0

Note: If the packages support rollback, the
temporary directory contains rollback files
for installed packages. You can delete the

files on the Files for rollback preference
page.

Einish

Verify that you can access your Portal in an internet browser by navigating to:

http://mysecondaryserver.hcl.com:10039/wps/portal
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Chapter 7 — Federating and Clustering an
Additional Horizontal Node

This section covers adding the additional node to the Deployment Manager cell and adding a
new HCL ® Portal server as a horizontal cluster member to the previously created cluster. Once

this section is completed, you will have a functional two-node horizontal cluster using
federated LDAP security.

IMPORTANT: If you have applied a Cumulative Fix (CF) to the primary Portal node, you
need to apply the same CF to the additional horizontal Portal node before adding it to the
cluster. All Portal binaries and profiles must be on the same CF level before being added to a
cluster.

This guide installed Cumulative Fix 17 to the primary node in Chapter 1, and Cumulative Fix 17 to
the additional horizontal node in Chapter 6. Thus, the additional horizontal node may be safely
added to the existing Portal cluster.

1. Open the Config Wizard for the additional horizontal node in a web browser:

http://mysecondaryportal.hcl.com:10200/hcl/wizard

Sign in with your ConfigWizardID and ConfigWizardPswd Config Wizard credentials.

2. On the Config Wizard home screen, click Set Up a Cluster>Create an Additional
Cluster Node.

Create an Additional Cluster Node

After you create a static or dynamic cluster, create an additional horizontal
cluster node to handle failover requests. When you create an additional
horizontal cluster node on a different server, run the wizard from that server.
For guidance on using the wizard for this configuration option, or detailed
instructions on manually creating an additional vertical cluster node, see
Roadmap: Production and delivery environment.
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3. Select your target operating system, Portal profile name, and Portal profile home directory.
NOTE: A Portal profile does not exist yet on the additional horizontal node. Fill in the
values that would correspond to the profile if it did exist.

System Information Basic Cluster Seftings
[

Linux

wp_profile

Example. wp_profie

lopHCLWebSpherefwp_profilel

Click the right arrow.

4. Select the location of the Deployment Manager for your environment and the type of
cluster you created.

System nformation Basie Cluster Settings

Click the right arrow.

5. Specify the following:

* Cell name: a new cell name for the new profile. Cell02 for this guide.
* Node name: a new node name for the new profile. Node02 for this guide.

NOTE: Choose a node name and cell name different from the Deployment Manager node
name and cell name.

*  WAS installation directory: /opt/HCL/WebSphere/AppServer, set to default

* Portal host name: mysecondaryportal.ibm.com

* Portal installation directory: /opt/HCL/WebSphere/PortalServer, set to default

*  First port number: This value will be pre-populated to 10012 but can be set to any available
port number. If set to the default you will access your additional horizontal portal server in
a web browser via port 10039 at the end of this chapter.
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New Profile Information Deployment Manager Cluster Settings
a0

*Cell name: Cell02 ¥
“Node name Node0?

*Server name |webSphere_Portal 2

*WebSphere Application Server installation directory: foptHCLAVenSphereiAppServer

Exampie: foptIBMWebSphere/AppServer

*Digital Experience Portal host name mysecondaryportal bl com 3

Example: my_host_name mydamain com

*Digital Expenence Portal mstallation directory JfoptHCL/WebSphere/PortalServer
Example- /oplIBM/WebSphere/PartalServer

*First port number 10012

Click the right arrow.

Specify your WAS administrator ID from your LDAP, WAS administrator password from

your LDAP, dmgr cell name, dmgr node name, dmgr profile path, dmgr host name, and
Portal installation directory.

New Profile Information Deployment Manager Cluster Settings
R

“WebSphere Appiication Server adminisirator 1D WASADMINILDAP
“WebSphere Application Server administrator password: sesssen -
Reenterfiepassword  ssesess .
*Deployment manager cell name amarCelin1

Example dmgrCeliot

*Deployment manager node name amgriiode0t

Example dmgrhloded!

*Deployment manager profile path lopUHCLWebSphere/AppServeriprofiies/dmgrot ¥
Example: [opUBMWebSphereiAppServeriprofiesimar]

“Deployment manager host name mydmgrhel.com
“Deployment manager SOAP port 8879
Digtal Experience Portal instalfation directory lopuHCLWes Sphere/PortalServer|

Example: /opt#BMWebSphese/PortalServer

Click the right arrow.

Specify your cluster name.

Cluster Semtings

)

Chistor e Ptk

Click the right arrow.
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8. You will see the following screen:

Start Configuration Reset Steps

Step
2

9. Click Mark Step Complete for Step 1, since you have already installed the Portal

Task

Manual Step: Install portal binary files on the server where you plan
to add a node to your cluster,
Instructions for Step 1

Mark Step Complate
Manual Step: Install profile templates.

Instructions for Step 2
Mark Step Complate

Manual Step: Copy the database drivers from tha primary node to
the additonal noda.
Instructions for Stap 3

Mark Step Complete

Manual Step: Varify that the portal node and deployment manager
system clocks ara within 5 minutes of each other,
Instructions for Step 4

Mark Step Complate

Create the profile for the secondary portal noda.
View Stop Comimand

Run Step | Skip Step

Fedarata the node. This node then becomes a managed noda in tha
deployment manager cedl
View Step Command

Run Slep | Skip Step

Add a sacondary node to the cluster,
View Step Command

Run Step | Skip Step

Start the portal server.
View Step Command

Run Step | Skip Step

binaries on this server.
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10. On the primary Portal server, copy the following file to the additional horizontal node.

/opt/HCL/WebSphere/PortalServer/profileTemplates/profileTemplates.zip

Save the .zip file in the /opt/HCL/WebSphere/PortalServer/profileTemplates folder on the
additional horizontal Portal node. If the profileTemplates folder does not exist on the
additional horizontal Portal node, create it.

Step Task Status

1 Manual Step: Install portal binary files on the server where you plan to add a node to your cluster. & Complete
Instructions for Step 1

Mark Step Complete

11. Run the following to unzip the file:

cd /opt/HCL/WebSphere/PortalServer/profileTemplates
unzip profileTemplates.zip
12. Run the following to install the profile templates copied from the primary server:
JinstallPortalTemplates.sh /opt/HCL/WebSphere/ AppServer
Adjust the path to the AppServer directory to match your environment if necessary.

13. Click Mark Step Complete for Step 2.

2 Manual Step: Install profile templates. & Complete
Instructions for Step 2

Mark Step Complete

14. Click Mark Step Complete for Step 3.

3 IManual Step: Copy the database drivers from the primary node to the additional node. & Complete
Instructions for Step 3

Mark Step Complete

NOTE: This guide specified in Chapter 2 to place the database drivers in the
<wp_profile>/PortalServer/dbdrivers directory. They will be automatically copied over as a part of the
profileTemplates.zip file. Therefore, this guide required no additional actions to complete this step. If
the database drivers are outside of the wp profile directory in your environment, then they will not get
packaged up in the profileTemplates.zip file. You will need to do the manual copy the drivers to the
additional horizontal node in the same directory location as primary node.
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15. Ensure that the system clocks on the Primary Portal server, additional horizontal Portal

node Portal, and the dmgr server are all within five minutes of one another.

16. Click Mark Step Complete for Step 4

Manual Step: Verify that the portal node and deployment manager system clocks are within & minutes of each other.

Instructions for Step 4

Mark Step Complete

17. Click Run Step for Step 5 — Create the profile for the second portal node.

Create the profile for the secondary portal node.
View Step Command

Run Step | Skip Step

18. Click Run Step for Step 6 — Federate the node.

Federate the node. This node then becomes a managed node in the deployment manager cell.

View Step Command

Run Step | Skip Step

19. Click Run Step for Step 7 — Add a secondary node to the cluster.

Add a secondary node to the cluster.
View Step Command

Run Step | Skip Step

20. Click Run Step for Step 8 — Start the portal server.

Start the portal server.
View Step Command

Run Step | Skip Step
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21. After each step is successfully completed, the Config Wizard page will match the following:

Step

1

Task

Manual Step: Install portal binary files on the server where you plan to add a node to your cluster.
Instructions for Step 1

Mark Step Complete

Manual Step: Install profile templates.
Instructions for Step 2

Mark Step Complete

Manual Step: Copy the database drivers from the primary node to the additional node,
Instructions for Step 3

Mark Step Complete

Manual Step: Verify that the portal node and deployment manager system clocks are within & minutes of
each other.
Instructions for Step 4

Mark Step Complete

Create the profile for the secondary portal node.
View Step Command

Run Step | Skip Step

Federate the node. This node then becomes a managed node in the deployment manager cell.
View Step Command

Run Step | Skip Step

Add a secondary node to the cluster,
View Step Command

Run Step | Skip Step

Start the portal server.
View Step Command

Run Step | Skip Step

Click Finished.

22. Verify that you can access both your Primary Portal:

http://myprimaryportal.hcl.com:10039/wps/portal

and your additional horizontal Portal node:

http://mysecondaryportal.hcl.com:10039/wps/portal

Status

& Complete

& Complete

& Complete

& Complete

& Complete

View Result

&) Complete

Wiew Result

@ Complete

View Result

& Complete

View Result

In the following steps, you will enable memory to memory replication for the additional
horizontal node you created.
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23. While logged in to the dmgr, navigate to Servers — Server Types — WebSphere application
servers — WebSphere Portal (additional horizontal Node(02) — Session Management —

Distributed Environment Settings.

Application servers

Use this page to view a kst of the application servers in your envirenment and the status of each of these servers, You can also use this page to change the
atatus of @ specific apphcation sanver,
& Preferences
_Mow... || Detots || Tamplates... || Start || Stop | mestart | immedatestop | Termmate |
L= wli e
| Select Mama 2 |Note Host Nama 2 Varsion Chuster Nama 2 Status € |
| ¥ou can administer the following resources: |
| WabSghers Portal Node01 mypemaryportal bmcom | ND 8.0.0,2 PortalChuster kS
I e ot wpsae:  cewoww %
Tatal 2
Apglication servers > WebSphere_Portal

Usa this page to configure an application server, An appbcabon sérver i a server that piovides senviced required to run enterphse applcatons,

Runtena | | Configuration | | Rmports | | Operations

B Cantainer Satiings

Nama

| wWebSphers_Portal | - :

e W SIP Contsner Sethings
Noda nsme

T & Web Contaner Sattngs
Node(2
i Peoetat Container Settings

o lopment @ EJ8 Conianer Setbngs

J' Paraliel start i Contarar Sarvices

& Bumnéss Process Senaces
| Start componants a5 needed

ACCAEE to intemnad sarver Classas Applications

" Instadod agohcationg

Application servers > WebSphere Portal > Session managemment
Usa this page to configurs session manager proparties. to controd the behawvicr of Hypertext Transfer Protocol (HTTP) session support. These setbngs apply to
bath tha 519 contamer and the wob container.

Configuration
Grneral Properiies Additional Propertias
Session tracking mechanism: B Cystom properies
Enable SSL 1D tracking [(_istributed sovecnment sattings ]
¥|  Enable copkies
Enatde URL rewnting
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24. Click the blue link for Memory-to-memory replication.

25. In the Replication Domain drop-down menu, select your cluster (e.g. PortalCluster).
26. In the Replication Mode drop-down menu, select Both client and server.

Use this page to configure memory-to-memory replication for failure recovery.

Configuration

General Properties

Replication domain
‘ PortalCluster El

Replication mode
‘ Both client and server El

| Apply | OK | Reset | Cancel |

28. Click OK and Save all changes.

29. Back on the Session management page (which you should see after saving the changes),
click Custom Properties.

Configuration

General Properties

Additional Properties
Session tracking mechanism: l:

Custom properties _]

Distributed environment settings

[ Enable SSL ID tracking

|
’7" Enable cookies
'-__.-i Enable URL rewriting

30. Create a new custom property by clicking New.

New. .. Delete
| 4y
L] i
Select Mame o Value Description
None
Total 0
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31. For the Name, type in “Uselnvalidatedld” and for the Value, type in “false”

Configuration

General Properties

+ Name
|l_JseInvaHdatedId

+ Value
|false

Description

Apply| OK| Reset Cancel

32. Click OK and save the changes.

33. Restart the DMGR, NodeAgent, and WebSphere Portal server on the additional horizontal
node.

34. Verify Portal is functional by accessing it in your web browser:

http://mysecondaryportal.hcl.com:10039/wps/portal

At this point, you have successfully built a two-node WebSphere Portal cluster using a remote
database and federated LDAP security.
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Chapter 8 — Configuring the Cluster with an
External Web Server

This chapter describes how to configure the Portal cluster with an external web server. In this guide,
you will configure the Portal cluster with IBM ® HTTP Server (IHS) v9.0.5.0. In previous chapters,

the IBM® WebSphere Application Server and HCL ® Portal code levels were required to be those
shipped with the Portal installation media. In this chapter, no such requirement exists, and you will

install IBM ® HTTP Server with the latest code levels available

NOTE: Appendix B1 describes how to enable SSL on your web server after completing the steps in
this chapter. The authors of this guide strongly recommend SSL be enabled on your Portal cluster.

However, SSL is not required for a HCL ® Portal cluster to function correctly.

1. IBM® HTTP Server version v9.0 is not included with HCL ® Portal installation media. You will

need to download the IBM® HTTP Server media separately from HCL ® FlexNet:
https://www.ibm.com/software/passportadvantage/

This guide uses the following part numbers:

- IBM® WebSphere Application Server v9.0.5 Supplements - IBM ® HTTP Server

- IBM® WebSphere Application Server v9.0.5 - Web Server Plugins

- IBM® WebSphere Application Server v9.0.5 Supplements WebSphere Customization Toolkit

2. Download the latest fixpack of IBM® HTTP Server v9 and WebServer Plugin v9 from IBM ® Fix
Central. Both items are available in a single download.

This guide uses version v9.0.0.7, available at the following link:
http://www.ibm.com/support/docview.wss?uid=swg24044620#Supple

3. Copy the downloaded files to your IHS server environment. Extract each of the downloads.
This guide the following directory structure:
- /opt/ihsBinaries/IHS
- /opt/ihsBinaries/Plugin
- /opt/ihsBinaries/WCT
- /opt/ihsBinaries/FP7

4. Copy the following two directories from your primary Portal server to your IHS server:
-1IM
- JDKS805
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5. You will see the following directory structure

[ root@webserver ihsBinaries]# ls -la
otal O

IrwXr-xr-x root root

Irwxr-xr-x. 6 root root

Irwxr-xr-x 9 root root

Irwxr-xr-x 9 root root
IrWXrwxr-x root root
Irwxr-xr-x 9 root root
Irwxr-xr-x 9 root root

6. Navigate to:
/opt/ihsBinaries/IIM/yourEnvironment
and run
Jinstall

where yourEnvironment is the folder that best describes the operating system of the environment in
which you are installing HCL ® Portal. For this guide the following is used:

/opt/ihsBinaries/IIM/linux_x86 64

The following window will appear:

6 IBM Installation Manager @webserver.hcl.com s O X
Install Packages j
Select packages to install: !
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7.

Click Next.

e IBM Installation Manager @webserver.hcl.com = m]
Install Packages
Read the following license agreements carefully.

Install | Licenses > Location Summary

IMPORTANT: READ CAREFULLY
Two license agreements are presented below.

1. IBM International License Agreement for Evaluation of Programs
2. IBM International Program License Agreement

If Licensee is obtaining the Program for purposes of productive use (other than evaluation, testing, trial "try or buy,” or
demonstration): By clicking on the "Accept” button below, Licensee accepts the IBM International Program License Agreement,
without modification.

If Licensee is obtaining the Program for the purpose of evaluation, testing, trial "try or buy,” or demonstration (collectively, an
"Evaluation”): By clicking on the "Accept” button below, Licensee accepts both (i) the IBM International License Agreement for
Evaluation of Programs (the "Evaluation License"), without modification; and (ii) the IBM International Program License
Agreement (the "IPLA"), without modification.

The Evaluation License will apply during the term of Licensee's Evaluation.

The IPLA will automatically apply if Licensee elects to retain the Program after the Evaluation (or obtain additional copies of
the Program for use after the Evaluation) by entering into a procurement agreement (e.g., the IBM International Passport

Advantage or the IBM Passport Advantage Express agreements).

The Evaluation License and the IPLA are not in effect concurrently; neither modifies the other; and each is independent of the
ather.

The complete text of each of these two license agreements follow.

LICENSE INFORMATION

(®) | accept the terms in the license agreement print All...

() 1 do not accept the terms in the license agreement

@ | < Back | Next > Instal Cancel

8. Accept the license agreement and click Next.
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e IBM Installation Manager @webserver.ncl.com i O >

Install Packages
Select a location for Installation Manager.
Install Licenses @ Summary

Once installed, IBM Installation Manager will be used to install, update, modify, manage and uninstall your packages.
&

Installation Manager Directory: | fopt/HCL/InstallationManager/eclipse Browse...

Disk Space Information

Volume Available Space
/ 17.97 GB

@ < Back Next > nstal Cancel

9. Update the Installation Manager Directory and Click Next
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e IBM Installation Manager @webserver.hcl.com = m]

Install Packages
Review the summary information.
install Licenses Location | Summary >

Target Location
Package Group Name: IBM Installation Manager
Installation Directory: jopt/HCL/InstallationManager/eclipse

Packages

Packages
[J IBM® Installation Manager 1.8.5

Environment Disk Space Information
Arabic, Brazilian Portuguese, Croatian, Czech, Danish, Dutch, Total Available Space
English, Finnish, French, German, Greek, Hebrew, Hungarian, / i9.67 G

Italian, Japanese, Korean, Norwegian, Polish, Russian,
simplified Chinese, Slovak, Slovenian, Spanish, Swedish, )
Thai, Traditional Chinese, Turkish Total Download Size:  171.44 MB

Total Installation Size: 328.61 MB

} Repository Information

@ < Back | Next > Install Cancel

10. Click on Install
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@ IBM Installation Manager @webserver.ncl.com i O >

Install Packages ﬂ

o The packages are installed. View Log File

The following package was installed:

* % IBM Installation Manager
[} IBM® Installation Manager 1.8.5

Click on "Restart Installation Manager* to launch the new Installation
Manager and to start installation of other packagel(s).

@ Restart Installation Manager

11. Click on Restart Installation Manager
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12. Add the repositories for the IBM® HTTP Server, WebServer Plugin and WebSphere
Customization Toolbox, and Java805. Your end result should look like:

@ Preferences @webserver.hcl.com X
type filter text a Repositories S v D v
|
Repositories:
Appearance - -
Locat Connect
Files for Rollback _”( ’ i?“ — 3 i ool Add Repository...
b Hel [+ /optfihsBinaries/IHS/repository.config ih-8 v
e - I
b i P i [+ Jopt/ihsBinaries/|DK805/repository.config 1% Edit Repository...
nterne
(¥ JoptfihsBinaries/Plugins/repository.confi %
Passport Advantage X 0P e = = - 4 " Panova Repasita
€% /optfihsBinaries/WCT/repository.config 6 REpOEEBLY
Secure Storage -
Updates Move Up
Move Down
Clear Credentials
Test Connections
Service repositories are remote locations where updates or extensions to packages (including the
Installation Manager itself) are stored.
[ Search service repositories during installation and updates.
Restore Defaults Apply
@ cancel oK

13. Click OK to save the changes.
14. On the Installation Manager screen, click Install.

15. Check the box for IBM HTTP Server for WebSphere Application Server, Web Server Plug-ins, and
WebSphere Customization Toolbox. Click Next:

@ 1BM Installation Manager @webserverhcl.com = X
Install Packages
Select packages to install: ﬂ
Installation Packages Status Vendor License Key Type
~ (¥ 1BM HTTP Server for WebSphere Application Server
(W Tj, Version 9.0.5.0 will be installed 1BM
~ (% 1BM SDK, Java Technology Edition, Version 8
(% Version 8.0.5.35 Will be installed 1BM
~ |¥ [0 Web Server Plug-ins for IBM WebSphere Application Server
([, Version 9.0.5.0 will be installed 1BM
~ [ 1BM SDK, Java Technology Edition, Version 8
(% version 8.0.5.35 will be installed 1BM
[w[j, Version 9.0.5.0 Wil be installed 1BM
v ¥ 1BM SDK, Java Technology Edition, Version 8
(% Version 8.0.5.35 Will be installed 1BM
_| show all versions Check for Other Versions, Fixes, and Extensions
Details

WebSphere Customization Toolbox 9.0.5.0
Websphere Customization Toolbox provides tools to simply and rapidly a server More info...

* Repository: /soft/wct

@ Back Next > nstal Cancel
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16. Accept the license agreement and click Next.

@ 1BM Installation Manager @webserverhcl.com = o %
Install Packages
Read the following license agreements carefully.
[ | [ Ucenses > Location Summary

~ IBM HTTP Server for WebSphere Application Server LICENSE INFORMATION I
Software License Agreement . The Programs listed below are licensed under the following License Information terms and conditions in addition to the Program license terms previously

~ Web Server Plug-ins for IBM WebSphere Application Server agreed to by Client and IBM. If Client does not have previously agreed to license terms in effect for the Program, the International License Agreement for
Software License Agreement Non-Warranted Programs (2125-5589-05) applies.

~ WebSphere Customization Toolbox Program Name: IBM HTTP Server for WebSphere Application Server Vo
Software License Agreement Program Number: Tool

Program Name: Client for 1BM i Server V9

Program Number: Tool

Program Name: IBM Thin Admin Client for WebSphere Application Server V9
Program Number: Tool

Program Name: IBM Thin Client for EJ8 with WebSphere Application Server Vo
Program Number: Tool

Program Name: IBM Thin Client for JAX-RPC with WebSphere Application Server v9
Program Number: Tool

Program Name: IBM Thin Client for JAX-WS with WebSphere Application Server Vo
Program Number: Tool

Program Name: IBM Thin Client for JMS with WebSphere Application Server vo
Program Number: Tool

Program Name: IBM Thin Client for JPA with WebSphere Application Server Vo
Program Number: Tool

) | accept the terms in the license agreements print All...

_) 1 do not accept the terms in the license agreements

® <Back Next> nsta Cancel

17. You will see a screen to select the Installation directory for shared objects used by IIM. Choose a
directory and click Next.

@ 1BM Installation Manager @webserver.ncl.com ==

Install Packages
Select a location for the shared resources directory.
Install Licenses Location ) Features Summary

When you install packages, files are stored in two locations:

1) The shared resources directory - resources that can be shared by multiple packages.
2) The installation directory - any resources that are unique to the package that you are installing.

Important: You can only select the shared resources directory the first time you install a package with the IBM Installation Manager. For best results select the drive with the most available space because it must
have adequate space for the shared resources of future packages.

Shared Resources Directory: = fopt/HCL/IMShared Browse...

Disk Space Information

Volume  Available Space

/ 17.72GB

® <Back Next > 1sta Cancel
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18. Click the Package Group Name for each component and select an Installation Directory. This
guide uses the prepopulated defaults. Click Next.

@ 1BM Installation Manager @webserverhcl.com

Install Packages
The packages will be installed into the indicated package groups. Select the package group to change the installation directory.

Install Licenses [ Location ) Feal

ackage Group Name

Summary

Installation Directory Architecture
BM HTTP Server V9.0 JOpt/HCL/HTTPServer 64-bit

[0 1BM HTTP Server for WebSphere Application Server 9.0.5.0
[ 1BM SDK, Java Technology Edition, Version 8 8.0.5.35

~ %, Web Server Plug-ins for IBM WebSphere Application Server v9.0
1) Web Server Plug-ins for IBM WebSphere Application Server 9.0.5.0
[ 18M SDK, Java Technology Edition, Version 8 8.0.5.35

~ %, WebSphere Customization Toolbox V9.0 Jopt/HCL/WebSphere/Toolbox 64-bit
[0 WebSphere Customization Toolbox 9.0.5.0

Jopt/HCL/WebSphere/Plugins 64-bit

Package Group Name: IBM HTTP Server V9.0

Installation Directory: | /opt/HCL/HTTPServer Browse...
Architecture Selection: () 32-bit (s) 64-bit

Details

Disk Space Information
Shared Resources Directory: /opt/HCL/IMShared

Volume ~ Available Space
/ 17.73GB

< Back Next > Instal Cancel

19. Select additional translations to install. This guide chose no additional translations. Click Next:
@ 1BM Installation Manager @webserverhcl.com o %

Install Packages

Select the translations to install. :ﬂ

Install Licenses Location [ Features 7> Summary

select the translations for the packages that will be installed to package group IBM HTTP Server V9.0, Web Server Plug-ins for IBM WebSphere Application Server V9.0, WebSphere Customization Toolbox V9.0.
Translations Supported by All Packages

English
» Translations Supported by Only Some Packages

SelectAll  Clear All

< Back Next > Instal Cancel

126



20. Select any additional features you'd like for the WebSphere Customization Toolbox. For this guide,
the defaults were used. Click Next:

@ 1BM Installation Manager @webserverhcl.com

Install Packages ’/'—d

select the features to install.

B 18M SDK, Ja: ogy E Ve
[) Websphere Customization Toolbox 9.0.5.0

__| Show dependencies Expand All | Collapse All  Restore Default

“%- Selected by Installation Manager because of dependencies

Details

Disk Space Information
Volume Required  Temporary Total Available

< Back Next > 3 Cancel

21. Select the non-SSL HTTP Port for the web server. This guide recommends the prepopulated
default port 80. Click Next:

NOTE: You can modify your IHS configuration post-installation to remove the HTTP port and
configure SSL for your web server.

@ 1BM Installation Manager @webserverhcl.com = o %
Install Packages L
b
Fill in the configurations for the packages.
e )
atures
~ [ Common C: Common C i

EA T TGr My Web Server Configuration

Specify a port number for IBM HTTP Server to communicate. The default port is 80. If the default port is already in use, then change to another port that is available. Running IBM HTTP
Server without root or Administrative privileges might restrict use of ports below 1024.

HTTP port: [ o

< Back Next > Cancel

127



22. On the summary screen, ensure everything is correct and click Install to begin the installation.

@ 1BM Installation Manager @webserverhcl.com

Install Packages

Review the summary information.

Install Licenses Location Features

Target Location
shared Resources Directory: /opt/HCL/IMShared
Packages

Packages Installation

(__summary >

Directory

1BM HTTP Server V9.0 Jopt/HCL/HTTPServer
() IBM HTTP Server for WebSphere Application Server

[ 1BM SDK, Java Technology Edition, Version 8 8.0.5.3:

~ %, Web Server Plug-ins for IBM Se

Jopt/HCL/
[0l Web Server Plug-ins for IBM WebSphere Application

[ 1BM SDK, Java Technology Edition, Version 8 8.0.5.3!
~ %, WebSphere Customization Toolbox V9.0
~ [0} webSphere Customization Toolbox 9.0.5.0
i Web Server Plug-ins Configuration Tool
[F% 1BM SDK, Java Technology Edition, Version 8 8.0.5.3!

Environment

English

» Repository Information

23. Once the installation finishes,
click Next:

@ 1BM Installation Manager @webserverhcl.com

Install Packages

The following packages were installed:
v % IBM HTTP Server V9.0
() 1BM HTTP Server for WebSphere Application Server 9.0.5.0
[ 1BM SDK, Java Technology Edition, Version 8 8.0.5.35
~ %, Web Server Plug-ins for IBM WebSphere Application Server v9.0
1) Web Server Plug-ins for IBM WebSphere Application Server 9.0.5.0
[ 1BM SDK, Java Technology Edition, Version 8 8.0.5.35
~ %, WebSphere Customization Toolbox V9.0
1l WebSphere Customization Toolbox 9.0.5.0
[ 18M SDK, Java Technology Edition, Version 8 8.0.5.35

Jopt/HCL/WebSphere/Toolbox

Disk Space Information

Total Available Space
17.72GB
Total Download Size:  668.85 MB

Total Installation Size: 1.51 GB

< Back Install Cancel

select the radio button for WebSphere Customization Toolbox and

o The packages are installed. View Log file

Which program do you want to start?

*) WebSphere Customization Toolbox

) None

Note: If the packages support rollback, the temporary directory contains rollback files for installed packages. You can delete the files on the Files for rollback preference page.

Finish
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24. When WebSphere Customization Toolbox loads, select 'Web Server Plug-ins Configuration
Tool' and click 'Launch Selected Tool:

| Eile Window Help

51 Welcome

€3 Welcome 3 = =

Welcome to the WebSphere Customization Toolbox

Select a tool in the following list to display the welcome information for that tool. To launch a tool, select a

tool in the list, and click Launch Selected Tool. Alternatively, select Window > Open Perspective and select
a tool in the list.

List of provided tools:

Profile Management Tool (z/OS only)
' z/0S Migration Management Tool

Web Server Plug-ins Configuration Tool

Launch Selected Tool
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25. In the “Web Server Plugin Runtime Location’ window, click ‘Add...".

€5 WebSphere Customization Toolbox 9.0 @webserverhcl.com B | X
File Window Help

s ¢ welcome | © web Server Plug-ins Configuration Tool

1

© web Server Plug-in Runtime Locations =N

Name Location Add...
AR —

Remove

Roadmap...

© web Server Plug-in Configurations | &) Web Server Plug-in Response file. = O

Web Server Defin Web Server Ty Plug-in Configuration File I Create... ‘

:‘ Delete ‘
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26. Provide a Web Server name and the location of the WebSphere Plug-ins directory. This guide recommends
webserverl1 for the name and uses the default directory location specified during installation
/opt/HCL/WebSphere/Plugins

Web Server Plug-ins Configuration Tool 9.0 @webserver.hcl.com n

Add Web Server Plug-in Location

Add a previously installed web server plug-in location to your working set.

Web server plug-in location

Name: webserverl

Location: | Jopt/HCL/WebSphere/Plugins| | Browse...

Cancel Finish

27. Click Finish.
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28. You will now see the webserverl name defined in the top window titled Web Server Plug-in Runtime
Locations. In the bottom window titled Web Server Plugin Configurations click Create.

@ WebSphere Customization Toolbox 9.0 @webserver.hcl.com B | X

File Window Help

1= &) welcome | ) web Server Plug-ins Configuration Tool

© web Server Plug-in Runtime Locations =
Name Location I :
‘ l Aﬁd-qa |

webserverl | Jopt/HCL/WebSphere/Plugins
|| Remove
|

Roadmap...

© web server Plug-in Configurations | €) Web Server Plug-in Response Filel = O
Web Server Defin Web Server Ty Plug-in Configuration File | Create...
|
‘ Delete |
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29. Select your Web Server type and click Next. This guide uses IBM HTTP Server.

| Web Server Plug-ins Configuration Tool 9.0 @webserver.hcl.com

Web Server Selection

Select a web server to configure. Before you continue, verify that the selected web server is
installed.

(®) IBM HTTP Server

) Apache Web Server v2.4
) Apache Web Server v2.2
) IBM Domino Web Server

m
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30. Select the architecture of the installed target web server. This guide uses 64 bit. Click Next.

| Web Server Plug-ins Configuration Tool 9.0 @webserver.hcl.com n

s

Web Server Selection

Lieg

Select a web server to configure. Before you continue, verify that the selected web server is
installed.

* IBM HTTP Server

) Apache Web Server v2.4
| Apache Web Serverv2.2
) IBM Domino Web Server

m

Next > Cancel Fir
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31. Specify the location of the httpd.conf file and the port you chose during installation. This guide

uses the prepopulated defaults of /opt/HCL/HTTPServer/conf/httpd.conf for the directory and 80
for the port. Click Next.

| Web Server Plug-ins Configuration Tool 9.0 @webserver.hcl.com

Select the web server configuration file and identify the web server port to configure the web server
definition.

Web Server Configuration File Selection

Select the existing IBM HTTP Server httpd.conf file:

Jopt/HCL/HTTPServer/conf/httpd.conf Browse...

Specify the web server port:
80

< Back Next > Cancel
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32. Select to Setup IBM HTTP Server Administration Server.

Create userid/ group and password as per the orgnization policy-

Web Server Plug-ins Configuration Tool 9.0 @webserver.ncl.com

Setup IBM HTTP Server Administration Server

3

Optionally configure an administrative server to administer the web server. You can manage the web server from a WebSphere Application Server administrative
console by using the IBM HTTP Server administrative server to control the communication between them.

[ Setup IBM HTTP Server Administration Server

Specify a port number for IBM HTTP Server administation server to communicate. The default port is 8008. If the default port is already in use, then change to
another port that is available. Running IBM HTTP Server administation server without root or Administrative privileges might restrict use of ports below 1024,
HTTP Administration Port:

8008

Optionally create a user ID and password to authenticate to the IBM HTTP Server Administation Server from the WebSphere Application Server administrative

console. The user ID and password is encrypted and stored in the conf/admin.passwd file. You can create additional user IDs after the configuration by using the
htpasswd utility.

[# Create a user ID for IBM HTTP Server Administration Server authentication

User ID: ihsusr
Password: 200000
Confim passwrd: T —

< Back Next > Cancel Finish
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33. Specify the name of your webserver you created previously. This guide uses webserverl. Click
Next.

| Web Server Plug-ins Configuration Tool 9.0 @webserver.ncl.com

Web Server Definition Name

4

Use a web server definition to manage a web server through the WebSphere Application Server administrative console or the wsadmin tool. The definition name must
be unique because this name is used to identify this web server in the administrative console.

Specify a unique web server definition name:
webserverl

The web server definition name must not be empty and it must not contain the following special characters or space:

IN* .=+ |<>&%'"[I>#s~{}
Note: a period(.) is not valid if it is the first character.

< Back Next > Cancel A
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34. On this next screen enter the hostname of your Deployment Manager and click Next.

| Web Server Plug-ins Configuration Tool 9.0 @webserver.hcl.com

Configuration Scenario Selection

Configure the web server plug-ins to the computer where the web server exists. When the
web server and application server are not on the same computer, choose the remote
configuration scenario. When both web server and application server are on the same
computer, choose the local configuration scenario. In the local scenario, the web server
definition you create in this wizard is defined automatically in the application server.

Configuration scenario

() (Remote) Host name or IP address of the application server

| mydmagr.hcl.com| |

(_) (Local) Installation location of WebSphere Application Server

For the remote configuration scenario, the host name must be accessible on the network
through one of the following address formats:

fFully qualified domain name system (DNS) host name

The default short DNS host name
Numeric IP address

< Back Next > Cancel
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35. Click Configure to configure the plug-in.

Web Server Plug-ins Configuration Tool 9.0 @webserver.ncl.com

Plug-in Configuration Summary
Manual configuration steps are required before starting the web server. Follow the configuration procedure in the Web Server Plug-in Cenfiguration Roadmap.
Afterwards, you may start up your web server and application server to test your configuration.

Web server to configure:
IBM HTTP Server

Web server definition:
webserverl

Plug-in configuration file:
Jopt/HCL/WebSphere/Plugins/config/webserverl/plugin-cfg.xml

< Back Configure > Cancel Finish
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36. When the process completes, deselect Launch the plug-in configuration roadmap. Click Finish.

Web Server Plug-ins Configuration Tool 9.0 @webserver.ncl.com n

Plug-in Configuration Summary : Q
|
Manual configuration steps are required before starting the web server. Follow the configuration procedure in the Web Server Plug-in Cenfiguration Roadmap.

Afterwards, you may start up your web server and application server to test your configuration.

Web server to configure:
IBM HTTP Server

Web server definition:

webserverl

Plug-in configuration file:

Jopt/HCL/WebSphere/Plugins/config/webserverl/plugin-cfg.xml

< Back Configure > Cancel
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37. Once Configured you will see the result

€5 WebSphere Customization Toolbox 9.0 @webserverhcl.com B | X

File Window Help

s ¢ welcome | © web Server Plug-ins Configuration Tool
© web Server Plug-in Runtime Locations =N
Name Location Add...

Jopt/HCL/WebSphere/Plugins

© web Server Plug-in Configurations | &) Web Server Plug-in Response file. = O

‘ Web Server Defin Web Server Ty Plug-in Configuration File Create...

IBM HTTP Ser| jopt/HCL/WebSphere/Plugins/confi
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38. Copy the following file from your IHS web server:
/opt/HCL/WebSphere/Plugins/bin/configurewebserverl.sh

To your Deployment Manager server in the following location:

/opt/HCL/WebSphere/AppServer/bin

39

Switch to the Deployment Manager server. Run the following :

chmod 777 /opt/HCL/WebSphere/ AppServer/bin/configurewebserverl.sh

40

Run the following command from the /opt/HCL/WebSphere/AppServer/bin directory
Jconfigurewebserverl.sh -profileName dmgr01

NOTE: Please ensure Deployment Manager services are running (dmgr) before running the above
command

Output of the command

[root@mydmgrbinl# ./configurewebserverl.sh -profileName dmgrol

Using the profile dmgrol

Realm/Cell Name: <defaults>

Username: WASAdminInLDAP

Password: WASPswdInLDAP

ASX72091: Connected to process "dmgr" on node dmgrNode0l using SOAP connector; The type of process is: DeploymentManager

ASX73031: The following options are passed to the scripting environment and are available as arguments that are stored in the argv variable: "[webse
rverl, IHS, /opt/HCL/HTTPServer, /fopt/HCL/HTTPServer/conf/httpd.conf, 80, MAP_ALL, /opt/HCL/WebSphere/Plugins, unmanaged, webserver.hcl.com-node, web
erver.hcl.com, linux, 8008, ihsusr, ihsusr]"

[nput parameters:

Web server name - webserverl

Web server type - IHS

Web server install location - /opt/HCL/HTTPServer

Web server config location - /opt/HCL/HTTPServer/conf/httpd.conf

Web server port - 80

Map Applications - MAP_ALL

Plugin install location - /opt/HCL/WebSphere/Plugins
Web server node type - unmanaged

Web server node name - webserver.hcl.com-node
Web server host name - webserver.hcl.com

Web server operating system - linux

IHS Admin port - 8008

IHS Admin user ID - ihsusr

IHS Admin password - ihsusr

IHS service name 2y

Creating the unmanaged node webserver.hcl.com-node .
Unmanged node webserver.hcl.com-node is created.

Creating the web server definition for webserverl on node webserver.hcl.com-node.

Successful message output

Processing the application wps_schedule
Get the current target mapping for the lication wps_scheduler.
Computed the current target mapping for the application wps_scheduler.
Start updating the tar ppings for the application wps_scheduler.
: Editing of application wps_scheduler started.
: Application and module versions are validated with versions of deployment targets.
plication wps_scheduler is configured in the Server repository.
i ion wps_scheduler is configured in the WebSphere i Server repository.
wps_scheduler is configured in the bSpher i i Server repository.
_scheduler is configured the WebSphere Application Server repository.
3I: Activation plan created successfully.
: The cleanup of the temp directory for application wps_scheduler is complete.
: Application wps_scheduler edited successfully. The application or its web modules may require a restart when a save is performed.
Target mapping is updated for the application wps_scheduler.

Start saving the configuration.

Configuration save is complete.

NOTE: This activity will take time as this will configure webserver for each portal Application.
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41. After the script completes, login into your Deployment Manager via a web browser and navigate to

42.

the Servers > Server Types > Web Servers

Select check box of ‘webserverl’

eli0 1, Profile=dmgri 1

=

‘ ] Cel=

‘welcome
I#) Guided Activities
(=l Servers
New server
Al servers
= Server Types
+ WebSphere

vers

Custom HTTF servers

ere Application Server Community Edition servers

(Web se:

ers

Web servers
Use this page to view a list of the installed web servers.

& Preferences

Generate Plug-in | Propagate Plug-in || New... || Delete | Templates... | Start || Stop | Terminate

&0

l Select Name 3 ‘Web server Typa £ _ | Node o Host Name & _

Version &_ | Status &

LYeu «can administer the following resources:

webserverl 18M HTTP Server webserver.hcl.com-node webserverhcl.com

Total 1

Not
applicable

Click the box next to your web server name and click ‘Generate Plug-in’

welcame

[+ Guided Activities

WebSphere application servers
Liberty prof ors
J WebSphere proxy servers

Web servers

Use this page to view a list of the installed web servers,
4 Preferences

| Ganerate Plug-n | Propagate Plug-in || New... | Delete |

.« || Start || Stop || Terminate
L5
| Select| Name 5 Web server Typs 2 _ Node & Host Name Version ‘Slah.s &

| You can administer the following resources:

webseryerl IBM HTTP Server webserverhcl.com-node webserverhcl.com

Total 1

Not
applicable

You will see a message like the following:

=] Messages

[} pLGcooosT: Plug-in configuration file = Jopt/HCL/WebSphere/AppServer/profiles/dmgr01/config/cells/dmgrCell01

/nodes/webserver.hcl.com-node/servers/webserverl/plugin-cfg.xml

[ pLGroosar: Plug-in configuration file generation is complete for the Web server. dmgrCell01.webserver.hcl.com-

node.webserverl.
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43. Now we need to Propagate the same Plug-in

Select check box of “webserverl”

view: |All tasks |
# Web servers 7=

| & Guided Activities Web servers

Use this page to view a list of the installed web servers.
= Servers
# Preferences

Generate Plug-in | Propagate Plug-in | New.. | Delete | Templates... | Start || Stoj
= Server Types
= | |
Select Name 2 Wieb server Type £ _ Node & _ Host Name & _ Version & _ | Status |

‘You can administer the following resources:

= wabsarverl I8M HTTP Sarver waebserver.hcl.com-node wabserver.hcl.com Not

= applicable
Total 1

bin]# ps -ef | grep admin

4801 1.8 114472 00:00:00 /opt/HCL/HTTPServer/bin/httpd -d /opt/HCL/HTTPServer -f conf/a n.conf -k start
4802 4801 © 11:44 ? 00:00:00 /opt/HCL/HTTPServer/bin/httpd -d /opt/HCL/HTTPServer -f conf/admin.conf -k start
4803 4801 0 11:44 ? 00:00:00 /opt/HCL/HTTPServer/bin/httpd -d /opt/HCL/HTTPServer -f conf/admin.conf -k start
4812 4190 0 11:44 pts/1 00:00:00 grep --color=auto admin

44. Click the box next to your web server name and click ‘Propagate Plug-in’

=| Messages

[} pLGCOO621: The plug-in configuration file is propagated from fopt/HCL/WebSphere/AppServer/profiles/dmgro1
/config/cells/dmgrCell01/nodes/webserver.hcl.com-node/servers/webserver1/plugin-cfg.xml to /opt/HCL/WebSphere
/Plugins/config/webserver1/plugin-cfg.xml on the Web server computer.

[} pLGCOO48I: The propagation of the plug-in configuration file is complete for the Web server.
dmgrCell01.webserver.hcl.com-node.webserverl.

Web servers
4 Use this page to view a list of the installed web servers.

[+ Preferences

Generate Plug-in || Propagate Plug-in || New... || Delete | Templates... || Start || Stop | Terminate
el +

¥
Select | Name & Web server Type Node £ _ Host Name O _ Version  _ | Status ()
You can administer the following resources:
webserverl IBM HTTP Server webserver.hcl.com-node webserver.hcl.com Mot ®

applicable

Total 1

45. Now we need to update the following file as well

plugin-key.kdb
plugin-key.sth
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Click on the webserverl

Web servers

Use this page to view a list of the installed web servers.

i+ Preferences

| | Generate Plug-in || Propagate Plug-in || New... || Delete || Templates... || Start || Stop | Terminate

ek Hhsp)

v

Select| Name £ Web server Type § _

You can administer the following resources:

Node £ _ Host Name £ _

‘Version S |5tatusg

webserverl IBM HTTP Server

| webserver.hcl.com-node webserver.hcl.com

Not
applicable

Total 1

46. Click on Plug-in properties

ervers

Web servers > webserverl

Use this page to configure a web server that provides HTTP and HTTPS support to application servers.

Configuration |

General Properties

Configuration settings

Web server name

|webser\;er1 |

Type

‘ IBM HTTP Server D

+ Port
S

+ Web server installation location

|,v’o pt/HCL/HT TPServer

+ Configuration file name
|/spt/HCL/F—FI’FPServer,’conf/httpd.cunf

| [CEdit |

|“apply | ok || Reset || Cancel |

Web Server Virtual Hosts

Global Directives

Additional Properties

Log_file
Intelligent Management

+ Configuration File
Plug-in properties

- Remote Web server management

Custom properties

Ports
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47. Click on “Copy to Web server key store directory”

Web servers > webserverl > Plug-in properties

Use this page to configure a web server plug-in. The plug-in passes HTTP requests from a web server to WebSphere(R) application servers.

Runtime | | Configuration |

Plug-in properties

Additional Properties

Request and Response

il Ignore DNS failures during Web server startup Caching
+ Refresh configuration interval Bequest Routing
60 seconds Custom Properties

Repository copy of Web server plug-in files:

4+ Plug-in configuration file name
[ptugin-cfg xmi

: View
Automatically generate the plug-in configuration file
Automatically propagate plug-in configuration file

# Plug-in key store file name
|p|ugm-key.kdb

:_Ménage keys and certifi ftes_|
| Copy to Web server key store directory |

Web server copy of Web server plug-in files:

4 Web server copy of Web server plug-in files:

Jopt/HCL/WebSphere/Plugins/config
{webserverl/plugin-cfg.xml

#+ Plug-in key store directory and file name

Jopt/HCL/WebSphere/Plugins/config
Jwebserverl/plugin-key.kdb

You will see a message similar to the following:

Web servers ? -

[= Messages

[} PLGCO0B4T: The plug-in keyring file is propagated from /opt/HCL/WebSphere/AppServer/profiles/dmgro1/config
/cells/dmgrCell01/nodes/webserver.hcl.com-node/servers/webserver1/plugin-key.kdb to /opt/HCL/WebSphere/Plugins
Jconfig/webserverl/plugin-key.kdb on the Web server computer.

[} pLGCODEOT: The propagation of the plug-in keyring is complete for the web server.
dmgrCello1l.webserver.hcl.com-node.webserverl.

[ pLGCO0B6I: The plug-in stash file is propagated from /opt/HCL/WebSphere/AppServer/profiles/dmgro1/config/cells
JfdmgrCell01/nodes/webserver.hcl.com-node/servers/webserverl/plugin-key.sth to fopt/HCL/WebSphere/Plugins
Jconfig/webserverl/plugin-key.sth on the Web server computer.

[ PLGCOO71I: The propagation of the plug-in stash file is complete for the Web server.
dmgrCell01.webserver.hcl.com-node.webserverl.

Check on webserver; the following file must be updated in the following directory
/opt/HCL/WebSphere/Plugins/config/webserverl

plugin-key.kdb
plugin-key.sth
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48. select the webserverl and click on Start

ieb servers PE

Web servers
Use this page to view a list of the installed web servers.

+ Preferences

Generate Plug-in || Propagate Plug-in || New... || Delete | Templates... || Start | stop || Terminate
e D

) |5 &
Select Name & Web server Type O _ Node & _ Host Name £ _ Version 23 _ | Status (l)
¥ou can administer the following resources:
webserverl IBM HT TP Server webserver.hcl.com-node webserver.hcl.com Mot ®

applicable
Total 1
Web servers wE
= Messages
[ server webserver.hcl.com-node/webserverl started successfully. The collection may need to be refreshed to show
the current server status.

Web servers

Use this page to view a list of the installed web servers.
4+ Preferences

C Plug-in || Propagate Plug-in || New... || Delete || Templates... || Start | Terminate
ab | (4

BD P

Select| Name Web server Type 0 _ Node b Host Name Version {3 _ | Status ()

‘You can administer the following resources:

D webserverl IBM HTTP Server webserver.hcl.com-node webserver.hcl.com Mot =

applicable

Total 1

Check the http services on Webserver machine

[root@webserver webserverl]# -ef | grep http
1 011 )0 /opt/HCL/HTTPServer/bin/h p /HTTPServer conf/admin.conf -k start
@ )0 /opt/HCL/HTTPServer/bin/h p /HTTPServer conf/admin.conf -k start
4 )@ /opt/HCL/HTTPServer/bin/ht D JHTTPServer conf/admin.conf -k s
4801 € 7 )0 /opt/HCL/HTTP! ver/bin/h D L/HTTPServer conf/admin.conf -k s

1 )@ /opt/HCL/HTTP! i t p /HTTP
5112 0 /opt/HCL/HTTP!
5112 : ® /opt/HCL/HTTP!
5112 ? /opt/HCL/HTTPSe
4190 € 0 s 0 g --colo rto http

49. Now Switch to web server. Navigate to the <htfpRoot>/conf directory. Open the httpd.conf file in

a text editor

50. Locate the following line in the httpd.conf file.
#LoadModule rewrite_module modules/mod_rewrite.so

51. Uncomment the line by removing the pound symbol at the beginning of the line.
LoadModule rewrite_ module modules/mod rewrite.so

52. Locate the following line in the httpd.conf file.
# Diagnostic log files, uncomment to enable.
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53. Insert the following two lines above this line.

RewriteEngine on
RedirectMatch */$ /wps/portal/

Example end result:

RewriteEngine on
RedirectMatch ~/$ /wps/portal/

# Diagnostic log files, uncomment to enable.

NOTE: By default accessing your Portal site via http://mywebserver.hcl.com/ will result in an

IBM® HTTP Server page being shown instead of your Portal site. This configuration change will
ensure accessing http://mywebserver.hcl.com/ will show your Portal site.

54. Save the httpd.conf file.
55. Restart the deployment manager, nodeagents, portal servers, and webserver.

56. Verify that you can access the Portal cluster from the web server address:

http://mywebserver.hcl.com/

€ c @ © & websen er.hcl.com/wps/portal/Home/Welcome/!ut/p/z1/04_Sj9CPykssyOxPLMnMzOvMAfljo8ziDVCA04FTkIGTsYGBe7CBfighBVEYOs: B e bxd

@ Getting Started

Log i 10 use anthoring capabilities

SignUp  Logln

Welcome to Your

Digital Experience
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Conclusion

In this guide, you built a two-horizontal node HCL ® Portal v9.5 CF17 cluster using an external
database and federated LDAP security.

At this point, this guide recommends you upgrade to the latest fixpack of Java, latest fixpack of
IBM® WebSphere Application Server, and latest Cumulative Fix (CF) available for HCL ®
Portal.

At this link you will find the latest Java and WebSphere Application Server fixpacks:

http://www.ibm.com/support/docview.wss?uid=swe27004980

At this link you will find the latest HCL ® Portal cumulative fix:

https://support.hcltechsw.com/csm/en?id=kb_article&sysparm_article=KB0013939

Recommended Additional Reading

This guide was intended as a starting point for HCL ® Portal administrators building their Portal
environments. Additional resources are available to guide you through additional configuration and
usage of your Portal environment. Links provided may note different versions of Portal, however, all
links are applicable to HCL ® Digital Experience (HCL ® Portal) v9.0 and v9.5. This guide
recommends the following for additional reading:

Building a Proof of Concept Website with Portal:
http://www.redbooks.ibm.com/abstracts/sg248313.html?Open

Portal Administration Guide:
https://www.scribd.com/document/337564239/Portal-85-Admin-Workshop

Portal Performance Tuning Guide:
https://support.hcltechsw.com/csm?id=kb_article&sysparm_article=KB0074411

Portal Security Hardening Guide:
https://support.hcltechsw.com/csm?id=kb_article&sysparm_article=KB0074054

Developing Themes for HCL ® Portal:
https://help.hcltechsw.com/digital-experience/9.5/dev-theme/themeopt themes.html
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Creating Pages and Adding Content with Managed Pages:
https://help.hcltechsw.com/digital-experience/8.5/panel_help/h_mp_create pages.html

HCL ® Digital Experience - YouTube videos:

https://www.youtube.com/results?search_query=HCIL+Digtial+Experience

HCL ® Digital Experience Product Documentation:
https://help.hcltechsw.com/digital-experience/index.html
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Appendix Al - Enabling SSL on the Web Server

Introduction

This appendix will guide you through enabling SSL on your IBM ® HTTP Server. This appendix also
provides instructions for how to configure IBM ® HTTP Server with logic that will ensure any visitors
to your Portal site will always browse over a secure https:// link and never over an unsecure http:// link.
This appendix also provides details on how to enable SSL communications between your Portal servers
and web server. Finally, this appendix will provide an example of how to allow visitors to your Portal
site to automatically be redirected to the /wps/portal portion of your Portal server.

NOTE: The authors of this guide STRONLGY recommend SSL be enabled on your web server for all
Portal sites. However, there are valid arguments to be made where SSL should not be enabled. Hence,
the instructions for enabling SSL on the web server are in an appendix of this guide rather than being
contained within Chapter 8 of the guide.

1. Navigate to the <HTTPServer>/bin/ikeyman directory of your web server.
2. Launch the IBM® Key Management tool via executing the ikeyman command

[root@ bin]# cd fopt/IBM/HTTPServer/bin/
[root@ bin]# ./ikeyman

3. You will see the following screen:

IBM Key Management = o x

Key Database File Create Xiew Help

NEEEY

Key database information
DB-Type:

File Name:

Token Label:

Key database content

Personal Certificates

i Validate
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4. Click Key Database File > New

5. Select CMS for Key Database type. Provide a File Name and Location. Click OK.

MNew »
Key database type |CMS -
File Name: lihsserverkey. kdb | | Browse...
Location: \opt/IBMMHTTPServerjconf/ |
[8] 4 Cancel

6. Provide a password for the key file. Retype the same password in the Confirm Password field.
Click the checkbox to Stash password to a file. Click OK.

Password Prompt X

Password:

Confirm Password: | -------- |

[| Expiration time Days

lv|Stash password to a file

oK Reset || Cancel

NOTE: This guide uses a self-signed SSL certificate for demonstration purposes. If you are installing
a self-signed SSL certificate, proceed with executing steps #7 - #9 of this Appendix.

However, many Portal sites will use an SSL certificate issued by their company’s Certificate Authority,
or, an SSL certificate issued by a trusted third-party Certificate Authority such as Comodo, Symantec,
GoDaddy, etc. If you require a certificate issued by your company or by a trusted third-party, see the
following document:

https://www.ibm.com/support/docview.wss?uid=swg21006430

Execute the steps in the sections titled:

How do I create a new "Certificate Request" to send to a CA (for example, Verisign)?

How do I receive the Certificate into the Key Database File (kdb) file after getting it back from the
CA?

And skip steps #7 - #9 of this Appendix. Resume on step #10.
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7. Click on New Self-Signed... in the lower right of the window.

IBM Koy Management - [fopt/IBM/HTTP Server/confiihssarverkey. kdb] - O =
Key Database File Create View Help

Ds By

kKey database information

DE-Type:' TMS

File Mame; JoptAEMMTTR Senvenconfitesenverkey. kdb

Token Label:

Kay database contant

e rrr—
Eu Polote ]
| WlewiEelit, . |
L tmeort.. |
| Recsate Raquest... |
! Hename ]
l Valldate ]

| Exgract Certificate... |
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8. Fill in the Key Label, Key Size, Signature Algorithm, Common Name, and Organization
fields. For the Common Name field, use the hostname of the IBM ® HTTP Server,
mywebserver.ibm.com for this guide. Click OK.

Create New Self-Signed Certificate b4

Please provide the following info:

Key Label 'selfsignedCert

Yersion pTLVRTIERE

Key Size 20438 | w

Signature Algorithm SHA256WithRSA |+
Common Mame {optional) |mywebserver.ibm.com

Organizational Unit {optional} |

|
Organization {optional} |[EM |
|
|

Locality {optional} |
State/Province {optional} | |
Zipcode {optional} | |

Country or region ({optional) |US |-

Validity Period 365 Days

Subject Alternative Names

Email Address {optional) | |

IP Address {optional} | |

DNS Name {optional} | |
oK Beset Cancel
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9. You will see the following screen.

— S

IBM Key Management - [/opt/IBM/HTTPServer/conf/ihsserverkey.kdb] A o x

Key Database File Create View Help

""" LF

Key database information

DB-Type: CMS
File Name: fopt/IBM/HTTPServer/conifihsserverkey. kdb
Token Label:
Key database content
Personal Certificates |V| Receive...
* SelfSignedCert Delete
View/Edit...

Recreate Request...

Rename

| |
| |
| |
| Export/import... |
| |
| |
| Yalidate |

| New Self-Signed... |

| Extract Certificate... |

10. Click Key Database File > Exit to close the IBM ® Key Management tool.

11. Navigate to the <HTTPServer root>/conf directory. For this guide: /opt/IBM/HTTPServer/conf.
12. Open the httpd.conf file in a text editor.

13. Locate the line in the httpd.conf file which begins with Example SSL section

l# Example SS5L configuration

# To enable this support:

# 1) Create a key database with ikeyman or bin/gskcapicmd

# 2) Update the KeyFile directive below teo peint to that key database
# 3) Uncomment the directives up through the end of the example

#
#LoadModule ibm ss1 module modules/mod ibm ssl.so
#lListen 443

#SSLCheckCertificateExpiration 30

#<VirtualHost *:443>

#S55LEnable

#Header always set Strict-Transport-Security “"max-age=31536000; includeSubDomains; preload”
#</VirtualHost>

#KeyFile /opt/IBM/HTTPServer/conf/ihsserverkey.kdb

#55LDisable

# End of example SSL configuration
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14. Update this section with the following text

LoadModule ibm_ssl_module modules/mod_ibm_ssl.so
Listen 443
SSLCheckCertificateExpiration 30
<VirtualHost *:443>
SSLEnable
SSLClientAuth None
Header always set Strict-Transport-Security "max-age=31536000; includeSubDomains; preload"
</VirtualHost>
KeyFile /opt/IBM/HTTPServer/cont/ihsserverkey.kdb
SSLDisable

Example end result for this guide:

|# Example SSL configuration

\# To enable this support:

# 1) Create a key database with ikeyman or bin/gskcapicmd

# 2) Update the KeyFile directive below to point to that key database
i# 3) Uncomment the directives up through the end of the example

H=

\LoadModule ibm ssl module modules/mod ibm ssl.so

[Listen 443

iSSLCheckCertificateExpiratiun 30

|[<VirtualHost *:443>

SSLEnable

SSLClientAuth None

Header always set Strict-Transport-Security "max-age=31536000; includeSubDomains; preload”

|</VirtualHost>
|KeyFile /opt/IBM/HTTPServer/conf/ihsserverkey.kdb
'SSLDisable|

i# End of example 5S5L configuration

15. In the httpd.conf file - locate the following two lines rule you implemented in Chapter 8.
RewriteEngine on
RedirectMatch ~/$ /wps/portal/

16. Update the lines to match the following text:
RewriteEngine on
RewriteCond % {SERVER PORT} =80
RewriteRule ~(.*) https://%{SERVER _NAME}%{REQUEST URI} [R,L]
RedirectMatch */$ /wps/portal/

NOTE: For this guide, the end result of the changes in the httpd.conf file looking like the
following.
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LoadModule ibm ss1 module modules/mod ibm ssl.so
Listen 443

SSLCheckCertificateExpiration 30

<VirtualHost *:443>

SSLEnable

SSLClientAuth None

Header always set Strict-Transport-Security "max-age=31536000; includeSubDomains; preload”
</VirtualHost>

KeyFile /opt/IBM/HTTPServer/conf/ihsserverkey.kdb
SSLDisable
# End of example SSL configuration

RewriteEngine on

RewriteCond %{SERVER_PORT} =80

RewriteRule ~(.*) https://%{SERVER NAME}%{REQUEST URI} [R,L]
RedirectMatch ~/$ /wps/portal/

# Diagnostic log files, uncomment to enable.
17. Save and close the httpd.conf file.
18. Login to the Deployment Manager via a web browser.

19. Navigate to Security > SSL certificate and key management > Manage endpoint security
configurations. You will see a screen similar to the following:

SSL certificate and key management

551 certificate and key management > Manage endpoint security configurations

Displays Secure Sockets Layer (SSL) configurations for selected scopes, such as a cell, node, server, or cluster

1 ocal Topology

B Inbound
B dmgrCelldl{CaliDefaultSS| Settings}
E 7 nodes
@ dmgriode01
@ Mode(ModeDefaultSSLSettings)

@ com-node
@ Node(HodsDefaultSSLSettings}
B B clusters

% PortaiCluster
El £ nocegroups
‘3@ DefaultModeGroup
B Sutbound
El £ noces
@ dmigridod=01
@ Hode(NodeDefaultSS| Settings)

@ :node
ﬁa Mode(ModeDefaultSSLSettings)
B (7 clusters

@@ PortalCluster

B 7] nodegroups
ﬁ@ DefaultNodeSroup

20. Under the heading Inbound, you will have four total entries representing your Deployment
Manager node, primary portal node, additional horizontal portal node, and web server node. Click
on NodeDefaultSSLSettings for your primary Portal node.
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21. You will see the following screen:

SEL certificate and management

S5L certificate and key t = g int security configurations > PortalNode

Displays Secure Sockets Layer (S5L) configurations for selected scopes, such as a cell, node, server or clusten,

General Properties Related Items
Mame SSL configurations
||;'l?||"15||"‘0‘:‘e | + Dynamic outbound endpoint SSL configurations
Direction Key stores and certificates
|]n:|aund | Begnei=
Key set groups
Inherited SSL configuration Key managers

Inheritad SSL configuration name Trust managers

[celiDefaultssLsettings |

Certificate Authority [CA) client configurations

Inheritad certificate alias

|nu|i |

Specific SSL configuration for this endpoint

Override inheritad values

S5L configuration
NodeDefaultSSLSattings ¥ | Update cartificats alias list | Manage certificates

Certificate alizs in key store

| Apply || OK || Reset || Cancel |

22. Click on Key stores and certificates on the right side. You will see the following screen:

551 certificate and key t > Manage dpoint security i ations > PortalNode > Key stores and certificates

Defines keystore typas, including cryptogrzphy, RACF{R), CMS, Java(TM], and all truststere types.

Keystore uzages
S5L keystores

[# Praeferences

i.i\.ﬂew.., | [_E-J-e-l.é;e_‘ i-Change passwiord... || Exchange signers... |
=
i\ il
Selecl'| Hams 2 | Description Path

You can administer the following resources:

i CeliDefaulikaySiors Default key store for dmarCellol 5{CONFIG_ROOT} cells/dmarCellol/key.pi2

] | celiDefaultTrustStore Default trust store for dmgrCellol £{CONFIG_ROOT}/cells/dmgrCellD1/trust.p12
|| | NodeDefaultKeyStore Default key store for Portalflode 5{CONFIG_ROOT}/ cells/dmgrCelldl/ nodes/PortalMode/key. p12

NodeDefaultTrustStore Default trust store for Portallode ${CONFIG_ROOT}/cells/dmgrCellD1/ nodes/PartalNode/trust.p12
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23. Click on NodeDefaultKeyStore. You will see the following screen.

123, 1rifealm arml by ey ge——

ik castificats end bty mansosmant > Haneseanidroind seceity cenlbaurations » Hasde > Hev stores ansd cartificates = SedeDelaulliKeyStors

Oubiess kiyrtors trea, Inchiding crapbograpty. RACKIR), CUE. Java{TH), sre sll Enatwtons e

Rl Wt vy Addftiomsl Propartiss
iz R
(PP - - ;
L Bacapoal sebfoptay
Dscripren R ) Baryicnsl it focate spdyaity
[t by atsem ha Yisda Cadne e grting
Mansgemmot 1oiae
| A el i e Riide |
Bash
S { CORFIG_RDOT L calti/drmpCall L poda. sde ey ELE

* Pusmced

T
PCEYD v]

Bamgiely ansged
Hert hak

LET
Travglfe 8T FTdTed

Enatin SrYPTEORERE GpeTlnE 08 Rifdulte Savie

gty | [0 | [ Reamt | Cameal |

24. Click on Personal certificates on the right-hand side. You will see the following screen.

58 i Erd by 2> Mamggs d ety 4 » Hods = - & J »

RManagan sersanal cactdeatan.
4 Erefarances

Craatm |_b-_-o-_;— Racaive i o teftfcabe Buthotn. |21.-r-a-... 1

sace.., || Butnct.. || dmpect, || Brpert |1 Revotan || Bamen |
Salmst whan Tawasd fo 1apand By T MaThe Eapraton
W 8 deferesirtar Bhe Rl debturian:

dalmas | rcom. G Cedl. Cree (=L Loy iy gaa? wekd froem

(o1 Hada, Q=iBM, D=F Carticabe, DU=dmgiei)] Sy TE
OUmdmgrizdsll, DB, Celis ZOLN o May
3. 3k
a o oo, QUe=Soa | Chie oo, DUmRscs | LERIMO4RI 0T | Wald from
Carthoate, DUmdmgrtalidl Caddcste. Olindrmgraldl. May L
Drrsgmmgiteet ], Qelisd, el e degrhsdaly, Gl (el SUEH W by
2, 3

25. The first entry on this screen is a personal certificate. The second entry on this screen is a signer
certificate. Record the serial number of the signer certificate - 1189393461368024 for this guide.
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26. At the top of the page click on Key stores and certificates. You will screen the following screen.

SN pwriduass gl ey ewgEem—

L cardilicabe prad Rew mespgaeant * Plansss sed U}

- Pigda T ey sbowmn mrd cartific st
Dufean kaywiza typan. moudieg crapbagrazi BACPEL CTME. fewn(TH, gmd ol bronbrbor Bppan

[ —
B baymigres ¥

@ Srederencan
P | Eratete || Chasgn panrveed || Brcharge s |
BLTT
) Sesergnen 2
T g TRl e Sttt hmy whure e drrgrCeis ] SLEENFI_REET ] el g Sl e d
i wa Trulingy [ — H{CORFIT _AOOT] cadle/ dmgreil i ru. pL
BodeCwlpu e iiory Dafwul ey 1w for mercficde #0003 _RO0 T} cadtty'drmgriCeiid ]’ redios’ maotiode e 013
| T =T T ] | Difine P i E T P Pl il | B[E0OTIRA _ADDTE ¢ et il ALaDR L bl P e 1 T
Teind 4

27. Click on NodeDefaultTrustStore. You will see the following screen.

i cmticnin oo boy Pviigporiwrnt 7 I
S5l covriifeyin aml by mansgement > Henpge

] Bpde  Kay storey ged cariifegiey > ModeDel sl TrevStors
Deadrmn byutoo Bypm. ncheding crrstogragty, RACR RS M Jeva T, aed ol rotabees. oy

Cenktdl Panjisties

A alibrgn sl e

(3

wiands Lacis ceiisite

—- ! Syrica eronie

Pesripmes - ymposet set fonly reguaty

Darladt trawt mase for L Cuptorn prepasting
Flamagm—iet brapa

[iea S o] mom e

Pk
[4]EErmia_ROGT) teiu/ fmgetatal neden Fadn e Ll

28. Click on Signer certificates on the right side. You will see the following screen.

551 cariiliaty ard fov ssanppattiesd > Hit e sndaaird petarily, oenliguttises »
Einsngad Bgea parnTaaned @ bny KM
T T

Mode > Fre stures and ceeiilivales > NisbaBeliuRTntitses > Signas arifaates

_sad | pabse || Waireer || Bamwss e part |

Tﬁ; | i

Bl ddma 2 T -2 Fangergrant [Sid Digtt] = Dupircon 2
sataut Claalngr S0 D T D s T (A 2 O TR T BTS00 TG | il e By 11 200 oo My 37, 2000;
Carsficrin. OUmdmgrCaliil. Giisdmgrinodel].
Gelpia, Syl
| mat CamBser P AT N B DS ET, 1302 (78458 44 DT R | Wikl o Mgy L1 2508 o Shey B 2600,
Cartficytn. 0= Call = Vidu,
Eelpa ol
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29. Click on the alias named default. You will see the following screen.

SSL certificate and key management

? =

SSL certificate and key management > Manage endpoint security configurations >

Mode > Key stores and certificates > NodeDefaultTrustStore >
Signer certificates > default

Manages signer certificates in key stores.

General Properties

Alias
|def-3u|t |

Version
2 |
Key size
2048 |

Serial number

|1189393461368024 |

Validity period

|valid from May 31, 2018 to May 27, 2033. |

30. Validate the serial number that appears on this screen matches the serial number you previously
recorded. If it does not, go back to the NodeDefaultTrustStore and choose a different certificate
alias name. Inspect each certificate alias until you identify the correct one with the matching serial
number. For this guide the alias default contained a matching serial number.

31. Click on the NodeDefaultTrustStore at the top of the page. Click the checkbox next to the alias
you identified with the matching serial number. default alias for this guide. Click Extract.

SSL certificate and key management > Manage endpoint security configurations >

Node > Key stores and certificates > NodeDefaultTrustStore >
Signer certificates

Manages signer certificates in key stores.

# Preferences

Add || Delete | Extract || Retrieve from port |

]

Select| Alias & Issued to ) Fingerprint (SHA Digest) Expiration

| You can administer the following resources:
default ibm.com, 09:EE:AE:B2:F1:D6:4A: 7E:EF:EA: 1E:26:0E: 7E: 7F:BE:F7:0D:F2:EC | Valid from May 31, 2018
OU=Root Certificate, to May 27, 2033.

OU=dmgrCell01, OU=dmgrNodeD1,
O=IBM, C=US

32. Enter a temporary path and filename. Click OK. This will create a file on the Deployment
Manager. Copy this file to a temporary location on your IHS server.

SSL certificate and key management > Manage endpoint security configurations > Node > Key stores and certificates > NodeDefaultTrustStore >
Signer certificates > Extract signer certificate

Extracts a signer certificate from a personal certificate to a file.

General Properties

# File name
‘ftmpfnodeRootS\gnenarm\

Data type
| Base64-encoded ASCII data | v ‘

Apply | oK Reset Cancel |
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33. Navigate to the <AttpRoot>/bin/ directory of your web server. Launch the IBM® Key
Management tool via executing the ikeyman command.

34. Click on Key Database File > Open...

IBM Key Management

Key Database File | Create View Help

D Mew. .. Tl

[:—'? Open... Ctrl-o
Key database information
* Mew Provider Ctrl-E
Cloga
' Save As... Ctrl-s
Change Password... Key database content

Stash Password
Display Password Expiry
Exit

35. Click Browse... Navigate to the <pluginRoot>/Plugins/config/webserverl directory and select
the plugin-key.kdb file.

Open x
Key database type |CHMS -
File Name: Iplugin-key. kdb | |_Browse...
Location: \opt/BMAvebSphere/Pluginsiconfigiwebserverl |
oK Cancel

36. Click OK. You will be prompted for the password of the plugin-key.kdb file. The default
password is WebAS. Enter the password and click OK.

Password Prompt X

Password: | ----- | |

| oK || Reset H Cancel ‘
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37. Click the drop down box to change from Personal Certificates and select Signer Certificates.

IBM Key Management - [/opt/IBM/WebSphere/Plugins/config/webserverl/plugin-key.kdb] i o

Key Database File Create View Help

BIEICKE I

Key database information
DB-Type: CMS
File Name: fopt/BMAebSphere/Plugins/configivebserverl /plugin-key. kdb
Token Label:

Key database content

Signer Certificates =] | Add...
Entrust.net Certification Authority {2048) | Delete
Entrust.net Client Certification Authority =
Entrust.net Global Client Certification Authority | View/Edit...
Entrust.net Global Secure Server Certification Authority
Entrust.net Secure Server Certification Authority | Extpaibies
Thawte Personal Basic CA —
Thawte Personal Freemail CA | Populate
Thawte Personal Premium CA =
Thawte Premium Server CA | Heinaiaes
Thawte Server CA —
VeriSign Class 1 Public Primary Certification Authority
nwriCimm Clace T Mubkhlic Neim aros Caskificatinn Aoabhasibo fale]

38. Click Add... Fill in the File Name and location where you copied the extracted certificate file
nodeRootSigner.arm on the websever. Click OK.

Open X

File Name: |nodeRoot5igner.arm || Browse... |

Location: |;"trﬂp |

0K Cancel

39. Enter a value to label the certificate. This guide recommends PortalSignerCert. Click OK.

Enter a Label b4

Enter a label for the certificate:
\PortalSignercert |

-4

oK Cancel
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40. You will now see your PortalSignerCert in the list of Signed Certificates.

IBM Key Management - [/opt/IBM/WebSphere/Plugins/config/webserverl/plugin-key.kdb] o o x

Key Database File Create View Help
; - = —
IaIIE =

DB-Type: CMS

Key database information

File Name: Jopt/EMMebSphere/Pluginsiconfigiwebserverl /plugin-key.kdb
Token Label:

Key database content

Signer Certificates |V| Add...

Entrust.net Certification Authority {2048)
Entrust.net Client Certification Authority

I

| Delete
Entrust.net Global Client Certification Authority |

|

Entrust.net Global Secure Server Certification Authority
Entrust.net Secure Server Certification Authority
PortalSignerCert

Thawte Personal Basic CA

Thawte Personal Freemail CA

Thawte Personal Premium CA

Thawte Premium Server CA

Extract...

Populate...

|
|
View/Edit... |
|
|
|

Rename

41. Close the ikeyman tool. You will be in the <AtfpRoot>/bin directory.

42. Restart the web server by executing the following two commands:
Japachectl stop
.Japachectl start

root@ J/opt/IBM/HTTPServer/bin
File Edit View Search Terminal Help
[root@ bin]# ./apachectl stop
[root@ binl# ./apachectl start

43. Validate you are able to access your webserver over https in a web browser:
https://mywebserver.ibm.com/

44. Validate you are able to access your webserver over http in a web browser.
http://mywebserver.ibm.com/

NOTE: The end result in the web browser should be a secure https:// url.

45. SSL is now successfully enabled on your web server. Any visitors to your Portal site who attempt
to access over http will automatically be redirected to a secure https:// link.
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Appendix A2- Remote Search Installation and
Configuration.

HCL ® Digital Experience : https://hclsw.co/dx-page This video demonstrates how to set up a remote
search server with an HCL ® Portal 9.5 CF18 cluster.

Please check below mentioned YouTube video for this topic.

https://www.youtube.com/watch?v=WIdILSgwvBI
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Appendix A3- Resolving Duplicate Users and
Groups

Introduction

If you have been directed to this Appendix by a chapter in the guide, you are in a configuration where
you have one or more administration users or groups in your Portal configuration that have the same
names as one or more administration users or groups in your LDAP configuration. If you attempt to
add your LDAP to the Portal configuration duplicate user names and/or duplicate group names will
occur and prevent the Portal server from starting or functioning properly.

In this appendix, you will update the Deployment Manager administration user name, Portal
administration user name, and Portal administration group to be different values from those in your
LDAP. This change will ensure duplicate user names and/or duplicate group names are not present
when you add your LDAP server to the Portal cluster configuration. No changes to your LDAP will
be required - all changes will occur on the Deployment Manager.

NOTE: This appendix assumes you have not yet configured an LDAP and you are able to login to
your Deployment Manager successfully prior to executing the steps. If you have already added an
LDAP and you are unable to login to your Deployment Manager, do not execute the steps in this
Appendix. Instead, see the following link for correcting that scenario:
https://www.ibm.com/developerworks/community/blogs/PortalL2Thoughts/entry/Fixing_a_common__
issue_Duplicate_adminuser admingroup_names_in_Portal?lang=en

Technical Background

When Portal is installed, you are asked to specify an administration username. This username, and a
group named “wpsadmins” are used to initially configure the Deployment Manager and Portal server
prior to an LDAP being added.

The full distinguished name of the user and group is as follows:
uid=Portal AdminID,o=defaultWIMFileBasedRealm
cn=wpsadmins,o=defaultWIMFileBasedRealm

The LDAP contains a user and group with similar names, e.g.:
uid=Portal AdminID,cn=users,dc=ibm,dc=com

cn=wpsadmins,cn=groups,dc=ibm,dc=com

When an LDAP is added to the configuration, we now have two users named "wpadmin" when we try

to login. HCL® Portal / WebSphere Application Server does not - by design - support and does not
attempt to resolve duplicate user names on login with a federated repositories configuration.
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Removing the Duplicates
1. Login to the Deployment Manager with the dmgrAdminID.
https://mydmegr.ibm.com:9043/ibm/console

2. On the left-hand side of the screen, Click Users and Groups > Manage Users

[=] Users and Groups

Administrative user roles
Administrative group roles
Manage Users

Manage Groups

3. Click Create...

Manage Users

Search for Users

Search by ~ * Search for * Maximum results
| User ID L\ §* 5100

‘ | Create...l | Delete | Select Select an action... v
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4. Fill in the values on this screen and click Create.

Create a User

*User ID

|PortalAdminIDLOCAL | Group Membership
;First name * Last name
]POﬁalAdminIDLDCAL ]E}rtalhdminIDLDCAL
E-mail

+ Password + Confirm password
il...'l'l.ll.l.l'll ]..llll..lll.l'l.l'

| Create | | Cancel |

NOTE: The userID you specify will be temporary and will be replaced by your WASAdmininLDAP
once LDAP configuration is completed. This guide recommends appending the word LOCAL to the
end of the userID to distinguish the userID as local to the Portal server. This guide’s authors have
found most enterprise LDAPs do not contain userIDs with the word LOCAL appended at the end of the
userID. Ensure the final result does not conflict with an existing userID in your LDAP.

5. On the left-hand side of the screen, Click Users and Groups > Manage Groups

[=] Users and Groups

Administrative user roles
Administrative group roles
Manage Users

Manage Groups
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6. Click Create...

Manage Groups

Search for Groups

Search by ~ *Search for * Maximum results
' Group name v | [* 1100

‘ | Ereate...l | Delete | Select:: Select an action... Y |

7. Fill in the value on this screen and click Create.

Manage Groups

Create a Group

* Group name
Ew psadminsLOCAL|

Description

| Create | | Cancel |

NOTE: Similar to the userID, the group you specify will be temporary and will be replaced once
LDAP configuration is completed. This guide recommends appending the word LOCAL to the end of
the group name to distinguish the group as local to the Portal server. This guide’s authors have found
most enterprise LDAPs do not contain groups with the word LOCAL appended at the end of the group
name. Ensure the final result does not conflict with an existing group name in your LDAP.
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8. Click the Blue Link that appears for your group name.

Manage Groups

The group was created successfully.

wpsadminsL OCAL

‘ Create Like ‘ ‘ Close |

9. Click the blue link for Members

Manage Groups
Group Properties

rGeneraITMembersTGroupsﬂ

+ Group name
|wpsadminsLDCAL

Description

10. Click Add Users...

Manage Groups

Group Properties

General Members '! Groups ||

Group name
[wpsadminsLOCAL |

The group has 0 members.

‘ | Add Users... | | Add Groups... | | Remove
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11. Update the Search text to your newly created userID. This guide uses PortalAdminIDLOCAL.
Click Search.

Manage Groups

Add Users to a Group

Group name
[wpsadminsLOCAL |

Search for users that will be members of this group.

Search by * Search for * Maximum results
\UserID ¥ | |portalAdminIDLC 100

12. A single result should be returned. Click the result so it is highlighted. Click Add.

Add Users to a Group
Group name
[wpsadminsLOCAL |

Search for users that will be members of this group.

Search by - * Search for +* Maximum results
\UserID v | |PortalAdminIDLC [100

1 users matched the search criteria.
PortalAdminIDLOCAL B8

Add | Close |
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13. You will see:

Manage Groups

Add Users to a Group

|i§‘ﬁﬂ The users were added to the group successfully.

Group name
[wpsadminsLOCAL |

14. Logout of the Deployment Manager.

15. Open a terminal session / command prompt to the primary node of your Portal server.
Navigate to the <wp_profile>/ConfigEngine directory.

16. Execute the following command:

./ConfigEngine.sh wp-change-was-admin-user

-DWasPassword= dmgrAdminPswd

-DnewAdminld=uid=Portal AdminIDLOCAL,o=default WIMFileBasedRealm
-DnewAdminPw=newpassword

Substitute the values provided with the new userID and password you created in previous steps.

NOTE: HCL Portal stores the WebSphere Application Server administration ID in multiple areas of
the configuration. Changing the ID in the Deployment Manager Console via Security > Global

Security will not update the configuration in all locations HCL ® Portal stores the ID. Ensure you use
the configuration task to update the ID.

17.  Open a terminal session / command prompt to the primary node of your Deployment Manager.
Navigate to the <dmgr profile>/bin directory.

18. Stop the Deployment Manager via the stopManager.sh command.

NOTE: The values currently are still those of the original administration ID and new password. The
next command to start the Deployment Manager will pick up the new administration ID and begin
using it. All subsequent commands will use the new administration ID and new password.
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19. Start the Deployment Manager via the startManager.sh command.

20. Login to the Deployment Manager with your new user ID you created.

https://mydmegr.ibm.com:9043/ibm/console

21. On the left-hand side of the screen, Click Users and Groups > Manage Users

22. Enter the value dmgrAdminID and Click Search.

Search for Users
Search by + Search for * Maximum results

F S et

UserID v ||dmgrAdminID |[100

"

23. Click the checkbox next to the dmgrAdminID and Click Delete. Click Delete on the subsequent
screen to confirm the action.

Search for Users

Search by ¥ Searc
User ID ¥ | ldmgric

1 users matched the see

| Create...l | Delete |

Select User ID

¥  dmgrAdminID

24. On the left-hand side of the screen, Click Users and Groups > Manage Groups.
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25. Enter the value wpsadmins and Click Search.

26.

27.

28.

Manage Groups

Search for Groups

Search by *Search for __ *Maximum results
Group name ¥ I*._f_vpsadmind 100

Click the checkbox next to the wpsadmins group and Click Delete. Click Delete on the
subsequent screen to confirm the action.

Manage Groups

Search for Groups

Search by * Search for
Group name ¥ | jwpsadmins

1 groups matched the search criteri

| Create...l | Delete | Select Sel

Select | Group name Descripti

v wpsadmins

Switch back to the open terminal session / command prompt of the primary node of your
Deployment Manager. You should be in the <wp_profile>/ConfigEngine directory.

Run the following Portal configuration task:

./ConfigEngine.sh wp-change-portal-admin-user
-DWasPassword=newpassword

-DnewAdminld=uid=Portal AdminIDLOCAL,o=default WIMFileBasedRealm
-DnewAdminPw=newpassword
-DnewAdminGroupld=cn=wpsadminsLOCAL,o=default WIMFileBasedRealm
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29. Navigate to the <wp profile>/bin directory on the primary Portal node. Stop the nodeAgent by
executing the stopNode.sh command.

~ PortalhdminIDLOCAL -pa

NOTE: This guide assumes if you are reading this appendix only the primary node of the Portal server
has been configured in the Portal cluster. If you have multiple nodes in your Portal cluster, repeat steps
#29-#31 for each node in your cluster to ensure they receive the configuration updates.

32. Execute the stopServer.sh command from the <wp profile>/bin directory for the Portal server.

AdminIDLOCAL -pas

NOTE: This guide assumes if you are reading this appendix only a single Portal server has been
configured in the Portal cluster. If you have multiple servers in your Portal cluster, repeat steps #31-
#33 for each server in your cluster.

34. Verify that you can login to your Primary Portal with the new Portal AdminIDLOCAL userID.

http://myprimaryportal.ibm.com:10039/wps/myportal

At this time, you may proceed with adding the LDAP server to your Portal cluster. The duplicate
usernames and duplicate group names have been removed from the configuration and will no longer
conflict when the LDAP server is added to the configuration.
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Encountering Issues and Receiving Help

If you encounter any failures following the steps in this guide, you may open a case with HCL ®
Portal Level 2 support.

To best assist you with any issues you encounter, the L2 Support engineer may request that you run
the wpcollector tool.

wpcollector is a command line tool that automates the collection of portal logs and configuration

files and optionally assists the customer with sending those files to HCL ® Support, saving valuable
time. Using automated log collection early in the PMR life cycle can greatly reduce the number of
doc requests that are made by Support.

For more information on wpcollector and how to use it, see the following documentation:

https://support.hcltechsw.com/csm

For questions, error message explanations, and more, try searching or posting a question

on Forum. This is an HCL ® run forum to ask and answer technical questions:

https://support.hcltechsw.com/community?id=community forumé&sys _id=02¢5dcf01b32f70cc1f9759d1e4bcb43

Questions About This Guide

If you have any questions specifically regarding the contents of this guide, the primary
editor — Rahul Srivastava - can be reached at: rahulsr@hcl.com
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